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Disclaimer of Warranties and Liability 

The information contained in this manual is believed to be accurate and reliable. However, GE Intelligent Platforms, Inc. 
assumes no responsibilities for any errors, omissions or inaccuracies whatsoever. Without limiting the foregoing, GE 
Intelligent Platforms, Inc. disclaims any and all warranties, expressed or implied, including the warranty of 
merchantability and fitness for a particular purpose, with respect to the information contained in this manual and the 
equipment or software described herein. The entire risk as to the quality and performance of such information, 
equipment and software, is upon the buyer or user. GE Intelligent Platforms, Inc. shall not be liable for any damages, 
including special or consequential damages, arising out of the use of such information, equipment and software, even 
if GE Intelligent Platforms, Inc. has been advised in advance of the possibility of such damages. The use of the 
information contained in the manual and the software described herein is subject to GE Intelligent Platforms, Inc. 
standard license agreement, which must be accepted by the buyer or user before the use of such information, 
equipment or software. 

 

Trademark Notices 

© 2015, General Electric Company. All rights reserved. 

Proficy is a trademark of GE Intelligent Platforms, Inc., a wholly-owned subsidiary of General Electric Company. 

* Indicates a trademark of General Electric Company and/or its subsidiaries. 

All other product names and marks identified throughout this book are trademarks or registered trademarks of their 
respective companies. They are used throughout this book in editorial fashion only. No such use, or the use of any 
trade name, is intended to convey endorsement or affiliation. 

No part of this publication may be reproduced in any form, or stored in a database or retrieval system, or transmitted 
or distributed in any form by any means, electronic, mechanical photocopying, recording or otherwise, without the 
prior written permission of GE Intelligent Platforms. Information contained herein is subject to change without notice. 

  

We want to hear from you. If you have any comments, questions, or suggestions about our documentation, send them 
to the following email address: 

doc@ge.com 
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About this Guide 
The Proficy* WebSpace product is an add-on option for the iFIX, CIMPLICITY, and Plant Applications 
products. The Proficy WebSpace product allows you to open pictures in run mode from a web session. The 
Proficy WebSpace product is a server-based, thin-client solution that eliminates the need for Citrix 
MetaFrame or Windows Terminal Services. 

The following sections provide general information on the Proficy WebSpace product, and how to 
configure, administer, and use it with either iFIX, CIMPLICITY, or Plant Applications: 

• Language Support 

• Proficy WebSpace Features 

• Proficy WebSpace Server Components 

• Unsupported Features for the Proficy WebSpace 

• Configuration Overview - Proficy WebSpace 

• Administering the Proficy WebSpace Server 

• Configuring Optional Web Session Properties 

• Deploying and Running Proficy WebSpace Sessions 

• Advanced Topics 

• Reference Information 

• Glossary 
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System Requirements 

Software Requirements 
IMPORTANT: Be sure also to read the Unsupported Items and Recommendations section on the Release 
Notes tab. 

GE Intelligent Platforms recommends using the latest service packs for Windows operating systems. The 
minimum Proficy WebSpace software requirements include: 

• One of the following operating systems: 
IMPORTANT: Since operating systems have continuous updates, be sure to run the Windows 
update feature to get the latest software. 

• Microsoft® Windows® Server 2012 R2. 

• Microsoft® Windows® Server 2012. 

• Microsoft® Windows® Server 2008 R2, Service Pack 1, Standard or Enterprise Edition. 

• Microsoft® Windows® Server 2008 (32-bit), Service Pack 2, Standard or Enterprise Edition.  

NOTE: Be aware that the maximum, supported RAM on the Standard Edition for Windows 
Server 2008 (32-bit) is 4GB, and this may limit the performance. For better performance, it 
is recommended that you use a 64-bit operating system, or an operating system that 
supports Physical Address Extension (PAE). PAE is available on the Enterprise version of 
Windows Server 2008 (32-bit).  

• Microsoft® Windows® 8.1 (64-bit), Professional or Enterprise Edition.  

• Microsoft® Windows® 8 (64-bit), Professional or Enterprise Edition.  
NOTE: The Proficy WebSpace Server is not supported on Microsoft® Windows® 8 (32-bit). 

• Microsoft® Windows® 7 (64-bit), Service Pack 1, Professional, Enterprise, or Ultimate Edition.  
NOTE: The WebSpace Server is not supported on Microsoft® Windows® 7 (32-bit).  

IMPORTANT: Make sure you have the latest Windows updates and certificates installed (and that 
your certificate paths are correct). Proficy WebSpace has been validated using the latest updates 
as of September 2015. 

• Network interface software for network communication and certain I/O drivers for your Proficy 
applications. TCP/IP must be enabled as a network protocol on your computers in your setup. 
Configure any external firewall and any software firewall on the server to allow TCP port 491. (By 
default, Proficy WebSpace listens on registered port 491 for TCP packets.) 

• Administrators must have administrative rights on the server to perform the installation.  
• The ASP .NET feature must be enabled on your Web Server. Additionally, if you are using Vision with 

Proficy WebSpace and Windows 8.x, you must enable the HTTP Activation feature.  
• Proper Proficy licensing software must exist on all computers in your setup.  
• If you are using third-party software along with Proficy WebSpace, make sure that the third party 

software is also supported for the operating system you are running Proficy WebSpace on. For 
instance, if you are running Proficy WebSpace on Microsoft Windows 7, your third party software must 
also be supported on Microsoft Windows 7. 

• An I/O driver for SCADA servers. GE Intelligent Platforms supplies I/O drivers for many programmable 
controllers or you may purchase a driver separately.  
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IMPORTANT: Be certain that the I/O driver you purchase is compatible with your hardware and 
operating system. For example, if the driver is not supported on a 64-bit system, then you cannot use 
this driver with Proficy WebSpace on 64-bit. For more information and for future updates to this list, 
check our support web site at: http://support.ge-ip.com.  

• Web browsers: For Proficy WebSpace sessions, the following browsers are supported: 

• Microsoft® Windows® Internet Explorer 10 and 11 

• Mozilla® Firefox® Extended Support Release (ESR) version 24 or higher 

• Google® Chrome™ version 29 or higher in Loose Mode only 

NOTES:  

• Proficy WebSpace does not support running the WebSpace client sessions on 64-bit 
browsers; only 32-bit browsers are supported. 

• The following operating systems are not supported for WebSpace client sessions: 
Windows Pocket PC, Windows CE, Mac OS X and Linux (with the exception of the Dell® 
Wyse® T50 ARM Thin client). 

• Proficy WebSpace does not support Google Chrome when running with Proficy Vision. 
• Microsoft® .NET Framework 4.5 installed on your Web Server. 

• For web servers, one of the following programs:  

• Microsoft Internet Information Server (IIS) 7.x, or 8.x. 

• Apache HTTP Server 2.x 

NOTES: 
• Be aware that you cannot use Apache if you are using Plant Application with Proficy 

Vision.  
• Apache and IIS Web servers and their sub-components (such as, OpenSSL) must be 

maintained and patched as per the latest security guidelines provided by their 
respective software vendors. The security of Proficy WebSpace sessions depends on the 
security that the web servers provide. 

Support for Office 2013  

Applications, such as Office 2013, that use DirectX will not run in Proficy WebSpace sessions on Windows 
Server 2008 R2 or Windows 7 when Windows Update KB 2670838 is installed. To work around this issue, 
uninstall KB 2670838. 

Background: Windows Update KB 2670838 replaces the user-mode DirectX runtime with a version that 
requires display drivers to support DirectX. The Proficy WebSpace display driver does not support DirectX in 
versions 4.71 and earlier. Beginning in version 4.8, the WebSpace display driver supports DirectX, but only 
on Windows 8, Windows 8.1, Windows Server 2012 and Windows Server 2012 R2. The WebSpace driver 
only supports DirectX on these versions of Windows because it relies on a Windows component that is not 
available in earlier versions of Windows. 

http://support.ge-ip.com./
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Hardware Requirements 

IMPORTANT: While running the Proficy WebSpace Server and the SCADA Server on the same machine is 
supported, it is strongly recommended that production SCADA Server reside on a different machine than 
the Proficy WebSpace Server. Also, SpeedStep® technology is not supported and must not be enabled on 
either server.  

Proficy WebSpace Server - Fewer than 5 Clients 
The following minimum hardware recommendations apply when using the Proficy WebSpace Server on a 
low-end machine supporting fewer than five Proficy WebSpace sessions, and WebSpace projects with 
pictures that have a small number of animation, shapes, and graphics: 

• For iFIX: A 3.0 GHz Intel® Core™ 2 Duo Processor or better computer. For better performance, please 
consider using higher. Be aware that the computer must be at least Dual-Core; a single core is not 
supported (with or without hyper-threading). 

• For Plant Applications or CIMPLICITY: In general, a Proficy WebSpace Server with CIMPLICITY or Plant 
Applications can support a 500 MHz CPU. 

• Proficy WebSpace supports a maximum round-trip latency of 500 milliseconds. 

• SpeedStep® technology is not supported and must not be enabled. 

• For time synchronization, the Windows Net Time and W32tm commands are both supported. 
However, if using the W32tm command, be sure to use the /nowait instruction when resynchronizing 
the clock. For example: W32tm /resync /nowait. The /nowait parameter instructs the operating system 
to make a stepping adjustment against the time server. 

NOTE: With VMware ESXi Server, the host and guest operating system need to synchronize against 
an external physical Network Time Protocol (NTP) Server. 

• The power save settings on your computer must be disabled. Do not use any power setting features 
that affect CPU clock speed. 

• A minimum of 8 GB RAM. For better performance, please consider using more. 

NOTE: To use more than 4 GB of memory on a 32-bit platform, you need to use Microsoft Windows 
2008 Enterprise Server. 

• A minimum of 10 GB of free hard drive space. It is strongly recommended that many GBs of additional 
free space exist on the hard drive to avoid performance issues. 

Be aware that SCADA alarm and historical data files can grow dynamically. If you plan to perform 
extensive alarm or data collection on a node, you may need more disk space on that particular 
node.  

• Other Proficy products, such as Proficy CIMPLICITY, iFIX, and Plant Applications, impose additional 
requirements. Refer to the Important Product Information (IPI) topic in the product's electronic books 
for specific system requirements. Click the System Req. tab in that product's IPI for details. 

• A DVD drive. 

• 100 MBit or faster Full Duplex TCP/IP-compatible network interface adapter for network 
communication between SCADA and Client nodes. Since the server bandwidth scales linearly with the 
number of clients connected, the speed of the network card on the server should be able to 
accommodate these connections. 

NOTE: Proficy WebSpace does not support IPv6. If you disable IPv6 to use WebSpace, make sure 
that your local HOSTS file does not contain any IPv6 references. For example, remove the "::1 
localhost" lines from the HOSTS file, and replace them with a line that references the IP address 
and the local host name (if necessary). 
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• One free direct-connect USB port. Some touch screens, pointing devices, and I/O drivers require a 
serial port. Additional ports for I/O hardware should be ordered with the computer. 

• SVGA or better color monitor with a 24-bit (16,777,216 colors) graphics card capable of at least 
1024x768 resolution.  

• Two-button mouse or compatible pointing device (such as a touch screen) that is capable of opening a 
context menu.  

Proficy WebSpace Server - Up to 60 Clients 

The following minimum hardware recommendations apply when using the Proficy WebSpace Server on a 
high-end machine that can support up to 60 clients: 

• For iFIX: Intel® Xeon® Quad-Core Processor, running at 3.2 GHz or better. For better performance, 
please consider using higher. Be aware that the computer must be at least Quad-Core; a single core is 
not supported (with or without hyper-threading). 

• For Plant Applications or CIMPLICITY: In general, a Proficy WebSpace Server with CIMPLICITY or Plant 
Applications can support a 500 MHz CPU. 

• Proficy WebSpace supports a maximum round-trip latency of 500 milliseconds. 

• SpeedStep® technology is not supported and must not be enabled. 

• For time synchronization, the Windows Net Time and W32tm commands are both supported. 
However, if using the W32tm command, be sure to use the /nowait instruction when resynchronizing 
the clock. For example: W32tm /resync /nowait. The /nowait parameter instructs the operating system 
to make a stepping adjustment against the time server. 

• The power save settings on your computer must be disabled. Do not use any power setting features 
that affect CPU clock speed. 

• A minimum of 24 GB RAM. For better performance, please consider using more. 

NOTE: To use more than 4 GB of memory on a 32-bit platform, you need to use Microsoft Windows 
2008. 

• A minimum of 10 GB of free hard drive space. It is strongly recommended that many GBs of additional 
free space exist on the hard drive to avoid performance issues. Be aware that SCADA alarm and 
historical data files can grow dynamically. If you plan to perform extensive alarm or data collection on 
a node, you may need more disk space on that particular node.  

• Other Proficy products, such as Proficy CIMPLICITY, iFIX, and Plant Applications, impose additional 
requirements. Refer to the Important Product Information (IPI) topic in the product's electronic books 
for specific system requirements. Click the System Req. tab in that product's IPI for details. 

• A DVD drive. 

• 100 MBit or faster Full Duplex TCP/IP-compatible network interface adapter for network 
communication between SCADA and Client nodes. Since the server bandwidth scales linearly with the 
number of clients connected, the speed of the network card on the server should be able to 
accommodate these connections. 

NOTE: Proficy WebSpace does not support IPv6. If you disable IPv6 to use Proficy WebSpace, make 
sure that your local HOSTS file does not contain any IPv6 references. For example, remove the "::1 
localhost" lines from the HOSTS file, and replace them with a line that references the IP address 
and the local host name (if necessary). 
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• One free direct-connect USB port. Some touch screens, pointing devices, and I/O drivers require a 
serial port. Additional ports for I/O hardware should be ordered with the computer. 

• SVGA or better color monitor with a 24-bit (16,777,216 colors) graphics card capable of at least 
1024x768 resolution.  
NOTE: For better performance, considering using an external graphics card with a PCI-E interface 
adapter with 512MB RAM or better. 

• Two-button mouse or compatible pointing device (such as a touch screen) that is capable of opening a 
context menu.  

Proficy WebSpace Browser Sessions 

The speed of the client computer viewing the Proficy WebSpace session through a browser can also 
impact performance. Faster client machines typically load WebSpace pictures much quicker, and have 
improved performance while those pictures are open. For instance, in testing, a slow client with 512 MB 
RAM and 1.5 GHz processor had picture load times approximately 1.5 times longer than a faster client with 
1 GB RAM and 3.0 GHz processor.  

Network speeds and connection types also impact performance for a Proficy WebSpace session. A 100 
MBit or faster network adapter, which is recommended, allows the Proficy WebSpace session to utilize 
optimum speed for its performance. Companies using VPN connections for Proficy WebSpace sessions 
may experience a decrease in performance.  

IMPORTANT:  
• Running Proficy WebSpace client sessions (browser or desktop client) on the same computer as a 

Proficy WebSpace Server is not supported. 

• Proficy WebSpace does not support running the WebSpace client sessions on a 64-bit Internet 
Explorer browser; only 32-bit Internet Explorer browsers are supported. 

Proficy WebSpace with the Dell Wyse T50 ARM Thin Client 

You can use Proficy WebSpace with the Dell® Wyse® T50 ARM Thin Client.  The Dell Wyse T50 ARM Thin 
Client supports the following:  

• Operating System: Wyse-Enhanced Ubuntu operating system, version 10.04.1 LTS 

• Browser: Mozilla Firefox version 12 

• Client Session: For performance reasons, only one WebSpace client session should be opened on each 
physical Linux client machine. 

• Platform Products: iFIX only 
NOTE: CIMPLICITY and Plant Applications do not support the Dell Wyse T50 ARM Thin Client. 



Proficy* WebSpace 4.8 

7 

Compatibility with Other Proficy Products 

Several GE Intelligent Platforms products work with Proficy WebSpace. The following is a general set 
of required versions tested to work with the current Proficy WebSpace product: 

Product Required Version 

Proficy Plant Applications 6.2    

NOTE: Plant Applications installs Proficy Workflow 2.2. 

Proficy HMI/SCADA - 
CIMPLICITY  

8.2 and SIM 22 or higher, or 9.0 R2 SIM 9 or higher  

Proficy HMI/SCADA - iFIX 5.5 SP2 and SIM WorkSpace_017 or higher, or 5.8 or higher 

  Proficy Vision 6.2 or 6.3 

Language Support 
The English language Proficy WebSpace can run on any supported regional operating system: English, 
Chinese, Japanese, Polish, Russian, French, or German, but you must use English regional settings. For 
example, English WebSpace can run on an English operating system (OS), Chinese OS, Japanese OS, Polish 
OS, Russian OS, French OS, and German OS – all only with English regional settings. However, for a Chinese 
product language WebSpace, can only run on a Chinese OS, with local regional settings. 

The language of the installed Proficy WebSpace product must match the language of the iFIX, CIMPLICITY, 
or Plant Applications software that you are running. 

For more information on the available product version for each language, contact your regional Sales 
Representative. For a detailed list of the supported Windows Operating Systems (OS) for the Proficy 
WebSpace, refer to the System Requirements tab in the IPI. 

Unsupported Items 

• GE Intelligent Platforms does not support running the Proficy WebSpace Server on a different 
Operating System (OS) language than the iFIX, CIMPLICITY, or Plant Applications Server. Both OS 
languages must be the same for each server. For example:  one supported combination is an 
English OS for the iFIX SCADA Server, and an English OS for the Proficy WebSpace Server. 

• Proficy client/server configurations with different OS languages are not supported. For instance, 
connecting an English SCADA Server (on an English OS) with a German View node or iClient (on a 
German OS) is not supported. However, Proficy WebSpace sessions can log in from operating 
systems in other languages if the input language is added to the Proficy WebSpace Server, and 
keyboard layout for the client is set in that locale. For more information, refer to the Configuring 
Multiple Input Locales section. 

• GE Intelligent Platforms does NOT support running the localized version of the product on an 
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English operating system. 

Proficy WebSpace Features 
The Proficy WebSpace product provides the following features: 

• Background Tasks: The Proficy WebSpace Server allows other tasks to run such as drivers, a 
background server, iFIX ALMODBC tasks, the iFIX SAC task, the Proficy Historian for SCADA 
Archiver, the iFIX Collector, and anti-virus software such as McAfee and Norton. 

• Client Access: Provides transparent access to client-side resources like printers, files, sounds, and 
so on. It also provides seamless integration of client drives, and client machines' serial and parallel 
ports. 

• Client-Side Password Caching: With this feature, the user's name and password are taken from 
the Proficy WebSpace Server Logon dialog box after the first manual authentication and used 
automatically when the user accesses the web client again from that machine. 

• Display Capability: The Proficy WebSpace session displays all graphics developed using the 
Workspace as is, and without conversion. 

• Encryption: Provides support for a computer networking protocol that manages server 
authentication, client authentication, and encrypted communication between servers and clients.   

• Enhanced Failover: The Proficy WebSpace Server supports the iFIX Enhanced Failover 
configuration only when the Proficy WebSpace Server machine is separate to the SCADA pair. The 
Proficy WebSpace Server does not support Enhanced Failover while running on either of the 
SCADA machines configured in a redundant pair. The Proficy WebSpace session will successfully 
switch over to the secondary SCADA in a failover scenario. 

• Exporting Data: The Proficy WebSpace sessions support exporting of data from Trend Charts and 
Proficy Historian to a local drive. 

• Inactivity Time-out: Through the Proficy WebSpace Administration tool, administrators can 
specify time limits for the number of minutes of client inactivity. 

• Licensing: The Proficy WebSpace Server manages a server-based license for Proficy WebSpace 
sessions and iFIX, CIMPLICITY, or Plant Applications functionality. 

• Multiple Sessions: The Proficy WebSpace supports running multiple sessions on the same 
computer; however, each session will consume a license. Each open browser window (even if 
logged on under the same user name) consumes a license. 

• Network Access: The Proficy WebSpace Server communicates through a standard TCP/IP port, 
across a firewall. The Proficy WebSpace sessions can also communicate with the Proficy 
WebSpace Server through a single port across the firewall. 

• ODBC Connections: The Proficy WebSpace sessions support ODBC connections as supported by 
the Proficy WebSpace Server to connect to relational database tables. 
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• Other Applications: The Proficy WebSpace session supports running other applications. For 
instance, in the iFIX WorkSpace shell, you can run other applications such as Excel, Crystal 
Reports, and SQL Stored procedures. This is similar to the functionality on an iClient machine. 

• Other Proficy Products: The Proficy WebSpace sessions support displaying client controls from 
other Proficy products. 

• Proficy WebSpace Administration Dashboard: Allows the system administrator to manage the 
Proficy WebSpace Server application. 

• Relay Server Configuration:  The Proficy WebSpace Server supports the use of a Relay Server 
configuration. With this configuration, a Relay Server provides centralized control for distributing 
sessions across a set dependent application servers. The dependent application servers share the 
communication load for the Proficy WebSpace Server, and maintain the client connections. 

• Reporting: The Proficy WebSpace Server supports reporting of client activities, such as 
connections, disconnections, logins, and logouts, to the Event Log. 

• SCADA Identity Protection: When the SCADA and Proficy WebSpace Server are used together on 
separate machines, the Proficy WebSpace Server will not expose the details of the SCADA Server 
such as the IP address. 

• Security: Proficy WebSpace is secured with both Proficy product security and Windows security. 

• Session Shadowing: This feature allows an administrator and a session owner to view and control 
a single session. Only administrators can connect to running Proficy WebSpace sessions, but only 
with permission from the session's user. 

• Session Time-out: Through the Proficy WebSpace Administration tool, administrators can specify 
time limits for the number of minutes that sessions are allowed to run on a Proficy WebSpace 
Server. 

• Standard Security: The Proficy WebSpace Server follows standard Windows security synchronized 
with the Proficy product. 

• Supported Browsers for Clients: The Proficy WebSpace session can be run through Internet 
Explorer, Mozilla Firefox, and Google Chrome (Loose mode only) browsers on the Microsoft 
Windows operating systems. Web sessions are disconnected if you navigate away to another web 
page. Sessions can also be run from Windows Desktop clients. 

• Time Zone Redirection: This option allows web sessions to run in the time zone of the client 
computer, regardless of the time zone that is selected on the Proficy WebSpace Server. 

• VPN Support: The web session supports connecting to the Proficy WebSpace Server through VPN 
connections. 
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Proficy WebSpace Components 

Proficy WebSpace Server 

The following components are installed as part of the Proficy WebSpace Server: 

Component Description 

Proficy WebSpace 
Application 
Publishing Service 

The Proficy WebSpace Application Publishing Service receives client connection 
requests, authenticates users on the Proficy WebSpace Server, and launches 
Proficy WebSpace sessions. 

Proficy WebSpace 
Relay Client 
Manager Service 

The Proficy WebSpace Relay Client Manager Service manages the web sessions 
on the dependent application servers in a Relay Server configuration. 

Proficy WebSpace 
Server License 
Manager Service 

The Proficy WebSpace Server License Manager Service manages a server-based 
license for Proficy WebSpace Clients and Proficy product functionality. Each 
Proficy WebSpace session consumes a license. Each open browser window 
(even if logged on under the same user name) consumes a license. 

Proficy WebSpace 
Administration 
Dashboard 

The Proficy WebSpace Administration dashboard is a 32-bit Windows 
application that is installed on the Proficy WebSpace Server. Administrators use 
this tool to manage Proficy WebSpace Server settings. 

Proficy Software iFIX, CIMPLICITY, or Plant Applications Client software. It is recommended that 
you install and run your SCADA Server on another, separate computer. 

Proficy WebSpace Session 

The following clients can be used for Proficy WebSpace sessions (on the client computer): 

Client Description 

Microsoft Internet 
Explorer (iFIX Embedded 
Microsoft ActiveX Control) 

The Proficy WebSpace ActiveX Control is available to Windows users 
running Internet Explorer. 

Mozilla Firefox (Proficy 
WebSpace Plug-in) 

The Proficy WebSpace Plug-in allows you to connect to a Proficy 
WebSpace Server using Mozilla Firefox. 
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Client Description 

Mozilla Firefox v12 for 
Dell Wyse T50 ARM Thin 
Client 

Upgrading the Mozilla Firefox to version 12 allows you to connect to a 
Proficy WebSpace session using Mozilla Firefox. 

NOTE: Proficy CIMPLICITY and Proficy Plant Applications do not support 
the Dell Wyse T50 Thin Client. 

Google Chrome Loose 
Mode only (Proficy 
WebSpace Plug-in) 

The Proficy WebSpace Plug-in allows you to connect to a Proficy 
WebSpace Server using Google Chrome in Loose Mode only. 

Windows Desktop Client The Windows Desktop Client allows you to view WorkSpace pictures from 
a desktop application using web services. It does not require Internet 
Explorer or Mozilla Firefox. 

Unsupported Features for the Proficy 
WebSpace 
The Proficy WebSpace product does not support use with: 

• Browsers: 

• Not Listed: Other browsers such as Netscape, Opera, and Safari. 

• Google Chrome: Proficy WebSpace does not support Google Chrome when using Proficy 
Vision. 

• Microsoft Internet Explorer (64-bit): Proficy WebSpace does not support running the 
WebSpace client sessions on a 64-bit Internet Explorer browser; only 32-bit Internet 
Explorer browsers are supported. 

• Clients: The following Proficy WebSpace Clients are NOT supported:  Windows Pocket PC, 
Windows CE, Linux (with the exception of the Dell Wyse T50 ARM Thin Client), and Mac OS X. 

• Configure Mode for the iFIX WorkSpace: Proficy WebSpace sessions in configure mode are not 
supported. Only the WorkSpace run mode is supported. By default, when you log on to a Proficy 
WebSpace session from a supported browser, you automatically enter run mode. Several 
configuration tools (such as Key Macro Editor, Visual Basic Editor, Startup Profile Manager, and 
others) will not open in the Proficy WebSpace session. 

• Different Networks: Running the Relay Server and Dependent Application Servers on different 
networks. They must all be on the same network (domain). 

• Enhanced Failover: iFIX Enhanced Failover is not supported if the Proficy WebSpace Server is 
running on either of the SCADA machines configured in a redundant pair. Enhanced Failover is 
supported, however, if the Proficy WebSpace Server machine is separate to the SCADA pair. 

• Environment Protection: iFIX WorkSpace environment protection settings from the web session 
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are not supported. 

• FIX32 Nodes: Be aware that connections to FIX32 nodes are not supported by the Proficy 
WebSpace. For instance, in this case, you should not have animations or datalinks that point to 
FIX32 SCADA nodes in your web session pictures. This includes WorkSpace .GRF and View .ODF 
picture files. 

• iFIX Alarm ODBC:  Alarm ODBC in the Proficy WebSpace client is not supported. 

• iFIX Screen Saver: The iFIX Screen Saver is not supported in Proficy WebSpace sessions. The iFIX 
Screen Saver settings only apply to the iFIX applications running on the Proficy WebSpace Server 
itself, and not to web sessions. 

• IPv6: The Proficy WebSpace does not support IPv6. If you disable IPv6 to use Proficy WebSpace, 
make sure that your local HOSTS file does not contain any IPv6 references. For example, remove 
the "::1 localhost" lines from the HOSTS file, and replace them a line that references the IP address 
and the local host name (if necessary). 

• Language Versions of the Operating System (OS) that Differ:  Are not supported for the SCADA 
Server and the Proficy WebSpace Server. Both OS languages must be the same for each server. 
For example: German OS for the iFIX SCADA Server, and German OS for the Proficy WebSpace 
Server. 

• Language Versions of the Products that Differ: Are not supported for the Proficy WebSpace and 
iFIX/CIMPLICITY/Plant Applications. Both product languages must be the same if you want to use 
these products together. For example: French iFIX, and French Proficy WebSpace Server. 

• Modem Connections: Connecting a client to the Proficy WebSpace Server using a modem is not 
supported. 

• Network Folder for Logs: Proficy WebSpace Server logs stored directly in a network folder are not 
supported. 

• Proficy Change Management: Proficy Change Management is not supported. Be sure that the 
"Logon on WorkSpace Startup" option is cleared on the Change Management tab in the User 
Preferences dialog box in the WorkSpace. 

• Right-to-left Languages: Right-to-left languages are not supported. 

• Session and Server on the Same Computer: Running Proficy WebSpace sessions (browser or 
desktop client) on the same machine where the Proficy WebSpace Server is installed is not 
supported. 

• Server Operating Systems: The following operating systems are NOT supported with the Proficy 
WebSpace Server, Microsoft Windows XP, and Microsoft Windows Server 2003. Also, the 32-bit 
versions of Microsoft Windows 7 and Microsoft Windows 8.x (32-bit only) are NOT supported. 

• Terminal Server: A Terminal Server running on the same machine as the Proficy WebSpace Server 
is not supported. 

• THISNODE feature: THISNODE, which applies to the View nodes communicating with a remote 
SCADA, is not supported from the web session. 

Configuration Overview - Proficy WebSpace 
The Proficy WebSpace Server allows you to log on and run iFIX, CIMPLICITY, or Plant Applications from a 
web session. However, in order to do so, you must first configure your Proficy WebSpace Server through 
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the Proficy WebSpace Administration tool. 

The following sections provide information on how to access, use, and configure the Proficy WebSpace and 
its options through the Proficy WebSpace Administration tool: 

• Configuration Guidelines 

• Creating Mapped Drives on the Proficy WebSpace Server 

• Configuring Multiple Input Locales 

• Running the Proficy WebSpace Administration 

• Adding Applications to the Proficy WebSpace Administration 

• Secure Deployment and Whitelisting 

• Optimizing Proficy WebSpace Server Performance 

Installing WebSpace 

To install Proficy WebSpace: 

1. On the SCADA Server computer (recommended), install iFIX Server, CIMPLICITY Server, or the Plant 
Applications Server. 

2. On your Web Server, uninstall any previous builds of Proficy WebSpace. 

3. On your Web Server, if it is not already installed, install the Proficy iFIX View node, CIMPLICITY 
Viewer/Server, or Plant Applications Client software (for supported versions see the System 
Requirements tab, "Compatibility with Other Proficy Products" section). 

TIP: For CIMPLICITY, while the Viewer is supported, it is recommended that you use a CIMPLICITY 
HMI Server 75 I/O Development & Runtime System. This Server is the lowest CIMPLICITY Server I/O 
count that you can have that allows for network access. It also provides the best flexibility for any 
centralized client node. 

4. Shut down any Proficy applications or services that run on startup. For instance, if you have 
Proficy Historian for SCADA Collectors configured to start when you start Windows, use the 
Services window to shut them down. 

5. Confirm that a supported version of Microsoft Internet Information Server (IIS) or Apache HTTP 
Server was installed beforehand. If it is not, install it now, as the Proficy WebSpace install requires 
it. Remember Plant Applications does NOT support Apache if you are running Proficy Vision along 
with Plant Applications. 

6. If installing on Microsoft Windows 8.x 64-bit, Microsoft Windows 2008 R2, or Microsoft Windows 
Server 2012 64-bit, ensure that the ASP.NET feature is enabled: 

• In Microsoft Windows 8.x, from the Control Panel > Programs and Features, click, "Turn 
Windows Features on or off." In the Windows Features list, enable the following option: 
Internet Information Services > World Wide Web Services > Application Development 
Features > ASP .NET 4.5 or ASP .NET. Click OK to install. 

• In Microsoft Windows Server 2008, open the Server Manager, and from the tree view, click 
Roles and then click Add Roles link on the Roles page. From the Add Roles Wizard, click 
Next to get to the Server Roles page. Enable the following role:  Web Server (IIS). Next, 
from the Role Services page, select the following feature: Web Server > Application 
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Development > ASP .NET. Click Next and then click Install. 

• In Microsoft Windows Server 2012, open the Server Manager, and click Add Roles and 
Features. From the Add Roles and Features Wizard, click the Server Roles link (or click 
through the wizard until you get to this page). Enable the following role: Web Server (IIS) > 
Web Server  > Application Development > ASP .NET 4.5. Click Next until you get to the 
Confirmation page, and then click Install. 

NOTE: Microsoft Windows 8.x and Windows Server 2012 come with ASP .NET pre-installed 
and registered. Be sure to install the latest Windows updates. If ASP.NET 4.5 has not been 
registered on the Web server, you need to manually configure your Web server for 
ASP.NET 4.5 in order for your site to run correctly.  For example, to register ASP .NET for IIS 
on Windows 7 use the command line: 
%SYSTEMROOT%\Microsoft.NET\Framework64\v4.0.30319\aspnet_regiis.exe -i. For more 
information on installing using the command line refer to the Microsoft MSDN web site: 
http://msdn.microsoft.com/en-us/library/ms229858(v=vs.100).aspx. For more information 
on installing other ways, refer to MSDN: http://msdn.microsoft.com/en-
us/library/5a4x27ek(v=vs.110).aspx. Also be sure to install the latest Windows updates. 

7. If installing on Microsoft Windows 8.x (64-bit) and using Proficy Vision with Proficy WebSpace, you 
must enable the HTTP Activation feature (without this feature enabled for Vision, WebSpace server 
errors may occur): In Microsoft Windows 8.x, from the Control Panel > Programs and Features, 
click "Turn Windows Features on or off." In the Windows Features list, enable the following option: 
.NET Framework 4.5 Advanced Services > WCF Services > HTTP Activation. Click OK to install. 
IMPORTANT: On Microsoft Windows 7, DO NOT enable the Microsoft .NET 3.5.1 > Windows 
Communication Foundation HTTP Activation feature. 

8. Ensure that TCP/IP is enabled prior to installation. Configure any external firewall and any software 
firewall on the server to allow TCP port 491. 

9. Log in as a user with Administrator rights and start the Proficy WebSpace installation. 
10. From the Welcome screen, click Next. 
11. On the License Agreement screen, to continue the installation, accept the terms of the license 

agreement, and click Next. 
12. On the Logon credentials screen, enter the User Name and Password for the user you plan to use 

as the administrator for this Proficy WebSpace installation (for the IIS Proficy WebSpace 
application pool), and click Next. 

13. On the Ready to Install the Program screen, click Install to begin the installation. 
14. When the installation is completed, click Finish and then restart the computer. 
15. Continue with configuration steps for your iFIX, CIMPLICITY, or Plant Applications software. 

Setting up the Proficy Vision Server for Proficy WebSpace 

The following steps describe how to set up your Proficy Vision Server to be able to open Proficy WebSpace 
pictures. 

1. Set up the Proficy Vision server following the instructions in that product's release notes. 

2. Add a user who will have access to list equipment associations (URLs associated with displays). 

3. Using the Proficy Workflow client, associate WebSpace display URLs with different pieces of 
equipment. 

-Or- 

http://msdn.microsoft.com/en-us/library/ms229858(v%3dvs.100).aspx
http://msdn.microsoft.com/en-us/library/5a4x27ek(v%3dvs.110).aspx
http://msdn.microsoft.com/en-us/library/5a4x27ek(v%3dvs.110).aspx
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Using the Proficy Vision URL, associate WebSpace display URLs with different pieces of equipment 
using the Add Display dialog. 

 For example: 
• Process cell 1 can be associated with: 

  https://{WebSpaceserver1}/proficywebspace/launchsession.html? 
  vision=true&pic=pic1.grf,tags1.tgd&app=iFIX&embed=true 

• Process cell 2 can be associated with a different tag group: 

 https://{WebSpaceserver1}/proficywebspace/launchsession.html? 
 vision=true&pic=pic1.grf,tags2.tgd&app=iFIX&embed=true 

4. Follow instructions to export the server certificate to a .pfx file. All Vision Client browsers should 
import this certificate into the Trusted Root Certification Authorities store in order to access a 
WebSpace URL in Vision Client. 

NOTES: 

• This is only required if you are using self-signed certificates or those that are NOT trusted by 
default by your IT policy or client operating system. 

• Do not use https://{WebSpaceserver1}/proficywebspace/iFIX.Html as the Proficy Vision URL as 
this is not supported. 

Setting up the WebSpace Server with iFIX to allow Proficy Vision 

1. Set up the Proficy WebSpace server with iFIX. Refer to each product's release notes for details on 
URL parameters. 

2. Open the Proficy WebSpace administration tool. In the Host Options dialog, set the session 
disconnect timeout to a non-zero value. 

3. Enable the HTTP Activation feature on the server (Windows 8.x only). 

In Microsoft Windows 8.x, from the Control Panel > Programs and Features, click, "Turn Windows 
Features on or off." In the Windows Features list, enable the following option: .NET Framework 4.5 
Advanced Services > WCF Services > HTTP Activation. Click OK to install. 

IMPORTANT: On Microsoft Windows 7, DO NOT enable the Microsoft .NET 3.5.1 > Windows 
Communication Foundation HTTP Activation feature. 

4. Open the iFIX.html file and modify the pcv.attach function to allow access to your Proficy Vision 
Server. 

5. Make sure that the URL works, for example: https:/{webserver}/ProficyWebSpace/ifix.html, by 
opening a browser session to the URL from a remote client machine. 

6. Run CfgProficyWeb.exe from the C:\program files\Proficy\Proficy Webspace\programs folder. 
Configure a standard Windows user with credentials to create WebSpace sessions. 

7. Configure the Proficy Vision server connection using the Vision server name, and the credentials in 
Step 2 of the Setting up the Proficy Vision Server for Proficy WebSpace section. 

8. Run mmc, using the certificates add-in, and import the .pfx exported from the Vision server to the 
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trusted root certificates. 

9. Reboot the WebSpace server. 

Setting up the WebServer with CIMPLICITY to allow Vision 

1. Set up the Proficy WebSpace server with CIMPLICITY. Refer to each product's release notes for 
details on URL parameters. 

2. Make sure that the URL works, for example: 
https://{webserver}/ProficyWebSpace/i{cimpscreen}html, by opening a browser session to the URL 
from a remote client machine. 

3. Reboot the WebSpace server. 

4. In Proficy Vision, add a display to the URL in step 2. 

Connecting from Vision 

1. Connect to Proficy Vision using https://{visionserver}/vision (for Vision 6.3) or 
https://{visionserver}/GE.Web (for Vision 6.2). 

2. Log in with your Proficy or Windows credentials (based on your Vision configuration). 

3. Double-click on equipment in the left tree view to reveal the displays associated with them in the 
top pane. 

Configuration Guidelines 

iFIX Configuration 

On the SCADA Server computer: 

1. Update the HOSTS file with the name of the SCADA Server, to ensure the highest reliability for 
connectivity. If the SCADA Server node name is different from the computer name that it was 
installed on, you also need to add this name to the HOSTS file. The HOSTS file on the Proficy 
WebSpace Server should be identical to the one on the SCADA Server.   

2. In Windows (Workgroup or Domain, preferably Domain), add the user accounts that you want to 
use with the Proficy WebSpace Server. You must have the privileges to do so. 

3. If you want to enable security on the iFIX SCADA node (most likely), add these same users to the 
iFIX SCADA through the Security Configuration application (Edit > User Accounts). iFIX must be 
running to access this tool and enable security (Edit > Configuration). 

NOTES: 
• It is recommended that if security is enabled, that the iFIX SCADA Server and the Proficy 

WebSpace Server reside on the same network. These same user account names will later 
need to be added to the Proficy WebSpace Server. 

• When adding users through the Security Configuration application in iFIX, be sure to select 
the Windows Security option for the user. 
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• When assigning security privileges in iFIX, use care when allowing application features that 
could allow write access, such as the "Database Save/Reload" and "Runtime Visual Basic 
Editor" features, as well as creating pictures with Datalinks, or any other means to write 
values into tags. Use Security Areas and Security Groups to further restrict access. Also, use 
care when creating and sharing schedules in iFIX, so that unintended VBA code is not 
activated inadvertently by web sessions. For more information on iFIX Security, refer to the 
Configuring Security Features e-book in the iFIX online help. 

4. In the iFIX System Configuration (SCU) tool, ensure that the Network Configuration is set to TCP/IP 
(Configure > Network), and that SCADA is enabled (Configure > SCADA).    

5. Create your pictures. 

On the Web Server computer: 

1. Update the HOSTS file with the name of the SCADA Server, to ensure the highest reliability for 
connectivity. If the SCADA Server node name is different from the computer name that it was 
installed on, you also need to add this name to the HOSTS file. The HOSTS file on the Proficy 
WebSpace Server should be identical to the one on the SCADA Server. 

2. In Windows (Workgroup or Domain, preferably Domain), add the user accounts that you want to 
use with the Proficy WebSpace Server. If you are on a domain, you may have already done this. 
You must have the privileges to do so. 

3. In the iFIX Security Configuration program, add these same users accounts (Edit > User Accounts), 
and enable security (Edit > Configuration). iFIX must be running to access this tool and enable 
security. Unlike the SCADA Server, this step is not optional on the iFIX WebSpace Server. 

 NOTES: 
• It is recommended that if security is enabled, that the iFIX SCADA Server and the Proficy 

WebSpace Server reside on the same network. These same user account names will later 
need to be added to the Proficy WebSpace Server. 

• When adding users through the Security Configuration application in iFIX, be sure to select 
the Windows Security option for the user. 

• When assigning security privileges in iFIX, use care when allowing application features that 
could allow write access, such as the "Database Save/Reload" and "Runtime Visual Basic 
Editor" features, as well as creating pictures with Datalinks, or any other means to write 
values into tags. Use Security Areas and Security Groups to further restrict access. Also, use 
care when creating and sharing schedules in iFIX, so that unintended VBA code is not 
activated inadvertently by web sessions. For more information on iFIX Security, refer to the 
Configuring Security Features e-book in the iFIX online help. 

4. In the iFIX System Configuration (SCU) tool: 
• Open the WEB.SCU file. 

IMPORTANT: If an iFIX View node is not installed before you install Proficy WebSpace, you 
will need to manually create the WEB.SCU file; the WEB.SCU will not automatically be 
created if you install WebSpace before iFIX View node. 

• Verify that Network Configuration is set to TCP/IP (Configure > Network), that SCADA is 
disabled (Configure > SCADA), and that Workspace.exe appears in your tasks list 
(Configure > Tasks). By default, these settings are automatically configured during install. 
If these settings are not correct, update them now. 

• Specify the name of your iFIX SCADA Server in the Remote Nodes list (Configure > 
Network). 

5. Either copy your pictures from the SCADA Server to the PIC folder on the iFIX WebSpace Server 
(recommended for optimum performance), or map a drive to your PIC folder on your SCADA 
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Server. If you map a drive for pictures: 
• If you are using shared drives with Local Windows users (not on the Domain), make sure 

that the user is present on both the Proficy WebSpace Server machine, and the machine 
which contains the shared folder. 

• In the SCU on the Proficy WebSpace Server, open WEB.SCU and point the picture folder to 
that mapped drive letter (Configure > Paths). 

• Update the LoginScript.bat file provided in the C:\Program Files\Proficy\iFIX WebSpace 
Server\Programs folder with the mapped drive information, and then add the script name 
to the Session Startup options in the Proficy WebSpace Administrator. For more 
information, refer to the online help for the WebSpace Administrator. 

6. Optionally, in the Proficy WebSpace Administrator, configure printer options and other session 
properties. For more information, refer to the online help for the WebSpace Administrator. 

7. If you want to configure multiple input locales for your web sessions, add the input language and 
keyboard layout for that locale to the Regional Settings on the Proficy WebSpace Server. For more 
information, refer to the online help for the WebSpace Administrator. 

TIPS: 
o You can find the HOSTS file in the C:\WINDOWS\system32\drivers\etc folder. 

o Use a text editor such as Notepad to edit the HOSTS file, and do not add a file extension to the file. 

o An example entry in the HOSTS file is as follows: 
  198.212.170.4    SCADA01. 
If SCADA1 was the iFIX SCADA Server node name, but the computer name where the iFIX SCADA 
Server was installed was AREA1, you would need to add a second line to the HOSTS file for AREA1: 
  198.212.170.4    AREA1. 

o If you do not know the TCP/IP address of the SCADA computer, run the IPCONFIG command on the 
SCADA Server. 

o The same, identical entries should appear in the HOSTS file for the SCADA Server and the Proficy 
WebSpace Server. 

IMPORTANT: 

• In an Enhanced Failover setup, make sure that the primary and secondary servers are separate 
from the Proficy WebSpace server. 

• If iFIX is installed after Proficy WebSpace, manually create and configure a WEB.SCU file if iFIX is to 
be used with Proficy WebSpace. 

CIMPLICITY Configuration 

• On the Web Server computer, configure Windows-based security or Standard CIMPLICITY security 
for CIMPLICITY. 
IMPORTANT: Make sure the same security is configured for both the Proficy CIMPLICITY Server and 
Proficy WebSpace servers. 

• Make all of the paths (with their folders) that will be shared for the Web Clients read-only. This will 
avoid running into the Microsoft’s limitation for sharing files. 

• On the CIMPLICITY Server, to publish a web page for a CIMPLICITY CimView screen, right-click the 
CIMPLICITY Options and run as Administrator. On the Proficy WebSpace tab, click the "Create a 
Web Page" button. The next dialog box allows you to select the screen that you want and creates 
a web page for it; if it does not pick up the default Proficy WebSpace directory to place the html 
file in, you will need to enter it. If it's an Apache server, you will need to browse to the location of 
the Apache Server; by default, the Apache Server location is: "C:\Program Files (x86)\Apache 
Software Foundation\Apache2.2\htdocs\ProficyWebSpace." 
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• Run the CimView screen(s) natively in Cimview.exe on the Proficy WebSpace Server to ensure 
proper Viewer-to-Server communications are established. Since your CIMPLICITY project server(s) 
are most likely remote to the Proficy WebSpace Server, it is highly recommended that CIMPLICITY 
Deployment is configured to synchronize files with the Proficy WebSpace Server (and keep them 
up-to-date). 

• Do not use shared CimView screens. If you do, every client that connects will need to create their 
own share, which could run the server out of resources. This could increase the time it takes a user 
to log in, and could make the server fail. 

• A separate CimView.exe and CimLayout.exe session runs for each Proficy WebSpace session with 
CIMPLICITY. 

• For the CIMPLICITY Windows Desktop Client, be sure that the command line parameter "-r" 
specifies the command line parameters for CIMVIEW. For example, -r CIMVIEW 
"C:\MyProject\screens\MyScreen.cim" will open the correct screen, as long as -r comes after the -a 
parameter, and all the other parameters are correct. For example: "C:\Program Files 
(x86)\Proficy\Proficy WebSpace Client\Client\Proficy.exe" -h MyServer -c -a CimView -r CIMVIEW 
"c:\screens\userscreen.cim" 

• Do not configure the WebSpace machine for Power Save or Lock; either feature can block Web 
Clients from connecting or cause them to lose an active connection. 

• If the session has been configured to Zoom to Best fit, the CimView screen will fit into the ActiveX 
container. The ActiveX container will conform to the Internet Explorer size when the URL is 
accessed. 

• The ActiveX Control or plug-in fits into the size of the browser when the URL is accessed; the size 
does not change when you resize the browser. Therefore, make sure the browser is the size you 
want before you go to the URL that will start the Proficy WebSpace session. 

• Make sure in a redundant SCADA server setup, that the primary and secondary servers are 
separate from the Proficy Web Space server. 

• Optionally, in the Proficy WebSpace Administrator, configure printer options and other session 
properties. For more information, refer to the online help for the WebSpace Administrator. 

• If you want to configure multiple input locales for your web sessions, add the input language and 
keyboard layout for that locale to the Regional Settings on the Proficy WebSpace Server. For more 
information, refer to the online help for the WebSpace Administrator. 

• On the Web Server computer, configure Windows-based security or Standard CIMPLICITY security 
for CIMPLICITY. 

Plant Applications Configuration 

• In Windows (Workgroup or Domain, preferably Domain), add the user accounts that you want to 
use with the Proficy WebSpace Server. You must have the privileges to do so. 

• The WebSpace Server can be installed on a remote computer along with the Plant Applications 
Client (recommended for a more secure setup), or it can be installed on the same computer where 
the Plant Application Server and Plant Applications Client also both reside. 

• When Proficy WebSpace is used with Plant Applications, you must also manually install the Plant 
Applications Client on the same computer as the Proficy WebSpace install (whether or not Proficy 
WebSpace is installed on the same computer as the Plant Applications Server). 

• Make sure that the same security is configured on both the Proficy WebSpace Server and Plant 
Applications Servers, if they are installed on separate computers. 

• Optionally, in the Proficy WebSpace Administrator, configure printer options and other session 
properties. For more information, refer to the online help for the WebSpace Administrator. 

• If you want to configure multiple input locales for your web sessions, add the input language and 
keyboard layout for that locale to the Regional Settings on the Proficy WebSpace Server. For more 
information, refer to the online help for the WebSpace Administrator. 

• The ActiveX Control or plug-in fits into the size of the browser when the URL is accessed; the size 
does not change when you resize the browser. Therefore, make sure the browser is the size you 
want before you go to the URL that will start the Proficy WebSpace session. 
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Terminal Services Configuration 

IMPORTANT:  Do not install Proficy WebSpace on a CIMPLICITY, iFIX, or Plant Applications Server that has 
already been configured as a Terminal Server. This type of installation is not supported. 

Creating Mapped Drives on the Proficy WebSpace Server 

If you want mapped drives to be available for web users, you can use a batch file on the Proficy WebSpace 
Server to log on to share these drives, rather than directly mapping them through Windows Explorer.                  

For iFIX, an example of a batch file, LoginScript.bat, is provided in the C:\Program Files\Proficy\Proficy 
iFIX\Programs folder. A batch file, such as this example, can run on a global-basis when any user logs on, 
or on a user-specific basis. For steps on how to add a batch file script to the logon process, either global or 
user-specific, refer to the Logon Scripts section. If the Administrator wants to change the location of the 
batch file, be aware that the new location must be accessible to all the web users. 

NOTE: User-specific project paths for Proficy WebSpace sessions are not supported. For example, you 
cannot use different directory paths for iFIX files, such as pictures, across multiple users.  If you need to 
support this, it is suggested that you use iFIX with Terminal Server, instead of Proficy WebSpace. 

If all users require access to the same network share through a drive mapping, the drive mapping will 
generally need to be defined in a logon script, such as defined in the LoginScript.bat example. 

If you are using shared folders with Local Windows users (not on the Domain), make sure that the user is 
present on both the Proficy WebSpace Server machine, and the machine which contains the shared folder. 

Be aware that the Proficy WebSpace Server cannot back up logs to a network folder. For example, if you 
type a UNC path or a mapped network drive in the folder edit box, the following message is displayed: 
"Please specify a usable Windows folder where log files may be written." 

• Be aware of the Microsoft limitation on shared directories. Please see article KB5062 on the GE 
Intelligent Platforms Knowledgebase: http://www.ge-ip.com/support. 

Mark all of the paths (with their folders) that will be shared for the Web Clients as read-only. This will avoid 
running into the Microsoft's limitation for sharing files. 

Configuring Multiple Input Locales 

The Proficy WebSpace session can be configured to allow users with different input locales to log into the 
Proficy WebSpace Server. Although the Proficy WebSpace Server supports only the same operating system 
language as the iFIX, CIMPLICITY, or Plant Applications computer, Proficy WebSpace sessions can log in 
from operating systems in other languages. However, for this to work, the input language must be added 
to the Proficy WebSpace Server, and keyboard layout for that locale must be set.      

NOTE: Users will not be able to switch input locales when the Proficy WebSpace Sign In dialog box is 
displayed. The input locale for the default language of the Proficy WebSpace Server will be used instead. 
On Windows clients, the selected input locale of server-based applications is not displayed in the system 
tray of the client computer. 

http://support.ge-ip.com/support/index?page=kbchannel&id=S:KB5062&actp=search
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Example of How to Configure 

For example, say your English Proficy WebSpace Server is on an English Windows computer. Your Proficy 
WebSpace session is a browser running on a French Windows machine. For this scenario to work, you 
must add the French input language to the Regional and Language Options on the Proficy WebSpace 
Server. The French input language must be set to an English keyboard, however. The following figure 
shows an example: 

 

 

To allow clients on non-English operating systems to connect to the Proficy WebSpace Server: 

1. Log on interactively to the Proficy WebSpace Server computer that you want to add the Input 
Locale with an administrator account. 

2. On the Start menu, point to Settings, Control Panel, and then click Regional and Language Options. 
The Regional and Language Options dialog box appears. 

3. Click the Languages tab. 

4. In the Text services and input locales area, click Details. The Text Services and Input Languages 
dialog box appears. 

5. In the Installed Services area, click Add. The Add Input Language dialog box appears. 

6. In the Input Language field, select the language you want to allow. For example, in the above 
graphic, you would select French. 

7. In the Keyboard Layout/IME field, select US. This indicates that the physical keyboard should be set 
to a U.S. English keyboard layout. If the physical keyboard is not US, select the appropriate 
keyboard layout. 
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8. Click OK. 

9. On the Text Services and Input Languages dialog, click OK. You are returned to the Regional and 
Language Options dialog box. 

10. Click the Advanced tab. 

11. Select the "Apply all settings to the current user account and to the default user profile" check box. 
A message box appears. 

 IMPORTANT: 

• Users will not be able to switch input locales when the Logon dialog is displayed. The input 
locale for the default language of the Proficy WebSpace Server will be used. 

• For web sessions, the selected input locale of the Proficy WebSpace Server is not displayed 
in the system tray of the client computer. 

12. Click OK to continue. 

13. Click OK to close the Regional and Language Options dialog. 

Additional Keyboards and IMEs 

Before clients can use keyboards and/or IMEs that are different from the server's, the files used to support 
them must be installed on the Proficy WebSpace Server. In most cases the layouts are copied during the 
installation of the operating system, but East Asian and right-to-left input languages are not. For example, 
the following steps guide you on how to install these keyboard layouts. 

To install keyboard layouts on a server: 

1. Open the Server's Control Panel on the Server that clients will log into. 

2. Double-click the Regional and Languages Options icon. A Regional and Language Options dialog 
box opens. 

3. Select the Languages tab. 

4. Click either or both of the check boxes in the Supplemental language support box. A message may 
open reporting the amount of disk space that will be required for the checked option. 

NOTE: You may need to provide the Windows Server DVD or the network share name to complete 
the file installation. 

5. Click OK. Files for the checked languages will be installed. 

6. Restart your computer. 

As a result of these steps, additional files will be copied to your machine. Support for the new languages 
will become available after the computer is rebooted. 

Keyboard Layouts Behind the Scenes 

Be aware of the following when working with keyboard layouts: 

• If the standard mechanisms are unable to provide the session with a keyboard layout, the Proficy 
WebSpace Server will attempt to load a keyboard layout that matches the client's keyboard. 
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• The Windows Client will send the default keyboard layout (but not an IME) of the operating system, 
which will be used by the server to attempt to load the keyboard layout that best matches the 
client. This means that in most installations that do not utilize IMEs, the administrator is not 
required to perform any special configurations. 

• Standard language keyboards have Windows keyboard layouts that are identical to the 
language's locale ID. For example, the French locale ID is 040C and the standard French keyboard 
layout is 0000040C. 

• If the keyboard is not standard there might be mismatches. The keyboard layouts of non-standard 
keyboards are not unique across all Windows platforms. If all clients within an installation of 
Proficy WebSpace use the same non-standard keyboard, the fallback layout text registry key can 
be used to specify it for all sessions. This will ensure that all clients will get the proper keyboard for 
each session. 

• Client computers have different non-standard keyboards the best way to communicate this to the 
server is to specify the keyboard layout in the command line option or plug-in/applet tag 
parameter. For information on command line options, refer associated client to the section. 

NOTE: When connecting to a Chinese Proficy WebSpace Server, the Sign In dialog appears from the 
shortcut along with the IME bar specifying Chinese as the default language. Clicking CTRL + Space bar does 
not toggle the languages. Users must manually click the IME bar with the mouse pointer to select English. 
Without manually clicking the IME bar, users will be unable to type a user name and password to log in. 

Running the Proficy WebSpace Administration 

The left panel of the Proficy WebSpace Administration lists all Proficy WebSpace Servers running the 
Proficy WebSpace Application Publishing Service. By default, the Proficy WebSpace Administration displays 
information for the server running on your machine. To connect to other servers and view information 
about them, click the server name from the list of Proficy WebSpace Servers.                 

If a server's icon displays a red X, the administrator does not have administrative rights on the server. If a 
server's icon displays a red x and is grayed out, the server is no longer running the Proficy WebSpace 
Application Publishing Service or it has been turned off. In either case, the administrator is unable to access 
that server from the Proficy WebSpace Administration application.   

Click the All Servers icon in the left panel of the Proficy WebSpace Administration to view a list of all active 
sessions on the network. This allows you to view active sessions without connecting to individual servers. 
This is also helpful for locating a particular session's server. 

The Status Bar is displayed at the bottom of the Proficy WebSpace Administration window. The Status Bar 
provides brief descriptions of menu commands when the mouse pointer is placed over that item in the 
menu. The Status Bar indicates the name of the Proficy WebSpace Server currently being accessed, as well 
as the CPU utilization and memory usage for that server, as calculated by the Windows Task Manager. The 
last two items on the Status Bar, Sessions and Processes, indicate the number of sessions and the number 
of processes running on the active Proficy WebSpace Server. 

If All Servers is selected, the Sessions number will reflect all the sessions running on the network, and the 
Processes number will reflect all the processes on the network. 

To enable the Status bar: 

1. From the Proficy WebSpace Administration, on the View menu, click Options. The Options dialog 
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box appears. 

2. Select the Status Bar check box. 

-Or- 

Click View and then Status Bar. 

NOTES: 
• For a list of Proficy WebSpace Administration shortcuts, see Keyboard Shortcuts for the 

Proficy WebSpace Administration. 

• In the Proficy WebSpace Administration's dialog boxes, you can easily get Help by right-
clicking an item, and then clicking What's This? A pop-up window will appear, displaying a 
brief explanation of the item. You can also get Help by clicking  on the title bar of a dialog 
box and then selecting an item. 

Adding Applications to the Proficy WebSpace Administration 

For clients to run an application through Proficy WebSpace, the application must be added to the Proficy 
WebSpace Administration. Clients are then able to connect to the Proficy WebSpace Server and to access 
the application. When adding applications to the Proficy WebSpace Administration, you can specify startup 
parameters that control how the application opens and what processes are initiated when the application 
is started. 

To add an application to the Proficy WebSpace Administration: 

1. In the tree, from the list of All Hosts, select the server name that you want to add the application. 

2. Click the Applications tab. 

3. Click the Add button. The Add Application dialog box appears. 

4. Enter the Executable Path. For example: C:\Program Files\Proficy\Proficy 
WebSpace\Programs\ProficyWeb.exe. 

• If you browsed for the application's .exe file in the preceding step, the file name will 
automatically be entered in the Display Name box. This name is displayed to users in the 
Program Window. You can keep the default display name or you can type a new one. The 
application’s Display Name cannot consist entirely of spaces and it cannot contain a 
backslash (\). This field cannot be left blank. 

• If you browsed for the application's executable file, the path name of the directory will 
automatically be displayed in the Start Directory box. Otherwise, you will need to type the 
full path name of the directory in which you want the application to start. 

5. In the Start Directory box, type the full path name of the directory in which you want the 
application to start. For example: C:\Program Files\Proficy\Proficy WebSpace\Programs. 

6. In the Startup State section, select whether the application starts maximized, minimized, or in 
normal mode. 

7. In the Command-Line Options box, you can pass on launch parameters for the application. For 
example: 
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Application Examples of Command-Line Options 

iFIX IFIX /s"C:\Program Files (x86)\Proficy\Proficy iFIX\LOCAL\WEB.SCU" 

CIMPLICITY CIMVIEW or CIMLAYOUT (depends on the CIMPLICITY application you want to 
configure) 

For example: 

CIMVIEW /keypad "C:\Program Files (x86)\Proficy\Proficy 
CIMPLICITY\projects\CIMPDEMO\screens\1airhouse.cim" 

where: 
   /keypad is an optional command line argument for cimview.exe. 

Plant 
Applications 

PA /d userdisplay 

8. Click the Change Icon button if you would like to replace the application's default icon. Select a 
new icon from the Change Icon dialog box. 

9. Click OK when you are finished. 

10. Restart the Proficy WebSpace Application Publishing Service. For steps, refer to the Restarting the 
Proficy WebSpace Application Publishing Service section. 

Secure Deployment and Whitelisting 
NOTE: We strongly advise you to follow recommended practices with respect to network cybersecurity. For 
example, our products should be placed within a protected electronic security boundary, such as behind a 
properly configured firewall, and monitored by a properly tuned Intrusion Detection System (IDS) or an Intrusion 
Prevention System (IPS). Industrial Control System products should NOT be connected to the business network 
or directly to the Internet. (VPN is an example of a countermeasure that can be deployed.) 

Manually Configure a SandBox with Whitelist Entries for Files and Programs 

The SandBox feature allows administrators to restrict user access to files and programs on a Proficy 
WebSpace host (server) based on whitelist entries. These restrictions apply to users only, not to 
administrators or members of the Administrators Group. As a security practice, GE recommends assigning 
least-privileged user accounts for WebSpace access. This is a security configuration hardening feature, 
which allows only the executables required for iFIX, CIMPLICITY, or Plant Applications to be launched 
through the WebSpace interface. It helps mitigate security risks associated with unintended usage of 
WebSpace. 
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Whitelisting Overview 

The Proficy WebSpace host installation does not include a user interface for configuring SandBox white list 
entries. You can, however, manually edit the WorkspacePropertyDefinitions.xml file (typically in the 
C:\ProgramData\Proficy\WorkspacePropertyDefinitions.xml folder) to add files and programs to the white 
list for a Proficy WebSpace host installation. The SandBox feature for files and/or programs must be 
enabled before specifying white list entries. 

IMPORTANT: To enable whitelisting functionality, whitelisting must be enabled on ALL servers, including 
Relay Servers. 

How the Whitelist Works 

Whitelisted files are specified by a fully qualified directory path. The SandBox will allow access to all files 
within a directory that is listed in the whitelist for files, including subdirectories. The WorkSpace profile 
directory, %USERPROFILE%, including all subdirectories, is automatically added to the files whitelist when a 
session starts. 

Programs can be added to these desktops in four ways: 

• Place the actual program executable module in a desktop folder. (for example, 
C:\Users\Public\Desktop\ExampleApp.exe) 

• Place a shortcut to the program executable module in a desktop folder (for example, 
C:\Users\ExampleUser\Desktop\ExampleApp.lnk) 

• Place a document that has an associated program in a desktop folder (for example, 
C:\Users\Public\Desktop\ExampleDoc.doc) 

• Place a shortcut to a document that has an associated program in a desktop folder (for example, 
C:\Users\ExampleUser\Desktop\ExampleDoc.lnk). 

NOTE: The associated program of a whitelisted file, which is not in a desktop folder, is not automatically 
added to the programs whitelist. 

Once the WorkspacePropertyDefinitions.xml file has been edited, the changes must be propagated to the 
DefaultWorkspaceProperties.xml file as shown in the next section.  

Configuration 

The Proficy WebSpace product will deploy a WorkspacePropertyDefinitions.xml file that will include all 
paths and programs needed by iFIX, CIMPLICITY, and Plant Applications, but with the default set to disable 
SandBox. After installation, the Application Publishing Service generates a DefaultWorkspaceProperties.xml 
file from the values in the WorkspacePropertyDefinitions.xml file. The Application Publishing Service derives 
its settings from the DefaultWorkspaceProperties.xml file. 

System administrators can make additional changes by editing DefaultWorkspaceProperties.xml. 

Enabling the SandBox Feature 

For files: 

1. Stop the Application Publishing Service. 
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2. In a text editor, such as Notepad, open WorkspacePropertyDefinitions.xml. 

3. Locate the filesSandboxEnabled property id, and set the value to true. 

<propertygroup id="UserSandbox"> 
<property id="filesSandboxEnabled"> 
<label>User sandbox</label> 
<description>Enables the user sandbox feature.</description> 
<type>BOOL</type> 
<defaultvalue>true</defaultvalue> 
<constraints/> 

4. Save the file. 

5. Restart the Application Publishing Service. 

IMPORTANT: 

• The value for filesSandboxEnabled in the WorkspacePropertyDefinitions.xml is case-sensitive 
and must be all in lowercase ("true" or "false"). 

• When using filesSandBoxEnabled=true, and iFIX is not installed to the default install folder, the 
root drive of the iFIX installation needs to be allowed read access. For example, add the line 
"E:\", ACCESS_READ | ACCESS_ALLOW_VISIBLE_CHILDREN; to the filesRequiredWhiteList 
section. Also, if the Proficy documentation is not installed to the default install folder, make 
sure that the ProficyDoc folder is denied access by listing it in the 
WorkspacePropertyDefinitions.xml. For example, change 
"%ProgramFiles(x86)%\Proficy\ProficyDoc",ACCESS_DENIED; to "E:\Program Files 
(x86)\Proficy\ProficyDoc",ACCESS_DENIED; 

For programs: 

1. Stop the Application Publishing Service. 

2. In a text editor, such as Notepad, open WorkspacePropertyDefinitions.xml. 

3. Locate the programsSandboxEnabled property id, and set the value to true. 

<property id="programsSandboxEnabled"> 
<label>Programs</label> 
<description>Users may only run programs specified in the Programs 
white list.</description> 
<type>BOOL</type> 
<defaultvalue>true</defaultvalue> 
<constraints/> 

4. Save the file. 

5. Restart the Application Publishing Service. 

IMPORTANT: 

• The value for filesSandboxEnabled in the WorkspacePropertyDefinitions.xml is case-sensitive 
and must be all in lowercase ("true" or "false"). 

• When using filesSandBoxEnabled=true, and iFIX is not installed to the default install folder, 
the root drive of the iFIX installation needs to be allowed read access. For example, add the 
line "E:\", ACCESS_READ | ACCESS_ALLOW_VISIBLE_CHILDREN; to the filesRequiredWhiteList 
section. Also, if the Proficy documentation is not installed to the default install folder, make 
sure that the ProficyDoc folder is denied access by listing it in the 
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WorkspacePropertyDefinitions.xml. For example, change 
"%ProgramFiles(x86)%\Proficy\ProficyDoc",ACCESS_DENIED; to "E:\Program Files 
(x86)\Proficy\ProficyDoc",ACCESS_DENIED; 

Adding Folders to the WhiteList 

In the C:\ProgramData\Proficy\WorkspacePropertyDefinitions.xml file, locate the "filesWhiteList" property: 

<property id = "filesWhiteList"> 
<label>Files</label> 
<description>Files and directories that users are allowed to access from the session.</description> 
<type>STRING</type> 
<defaultvalue> 
</defaultvalue> 
<constraints></constraints> 
</property> 

You can add multiple directory paths between the <defaultvalue> tags using one path per line, enclosed in 
double quotes, no leading white space, and ending with a comma and a semicolon, (,;). Expandable 
environment variables can be included. For example: 

<property id = "filesWhiteList"> 
<label>Files</label> 
<description>Files and directories that users are allowed to access from the session.</description> 
<type>STRING</type> 
<defaultvalue> "C:\Departments\Accounting\Templates",; "%ALLUSERSPROFILE%\ExampleApp",; 
</defaultvalue> 
<constraints></constraints> 
</property> 

Adding Program Files to the WhiteList 

In the C:\ProgramData\Proficy\WorkspacePropertyDefinitions.xml file, locate the "programsWhiteList" 
property: 

<property id = "programsWhiteList"> 
<label>Programs</label> 
<description>Programs that users are allowed to run from the session.</description> 
<type>STRING</type> 
<defaultvalue> 
</defaultvalue> 
<constraints></constraints> 
</property> 

You can add multiple program file paths between the <defaultvalue> tags, using one path per line, 
enclosed in double quotes, no leading white space, ending with a semicolon (;). Expandable environment 
variables can be included. 

For example, here is how you would add two executables: 

<property id = "programsWhiteList"> 
<label>Programs</label> 
<description>Programs that users are allowed to run from the session.</description> 
<type>STRING</type> 
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<defaultvalue> "C:\ExampleApp\bin\ExampleApp.exe"; "%SystemRoot%\regedit.exe"; 
</defaultvalue> 
<constraints></constraints> 
</property> 

Applying Whitelisting Dynamically 

The most efficient way to apply any whitelisting changes is as follows: 

1. Stop the Application Publishing Service. 

2. Delete the DefaultWorkspaceProperties.xml file. 

3. Edit the WorkspacePropertyDefinitions.xml file. 

4. Re-start the Application Publishing Service. 

A new DefaultWorkspaceProperties.xml will now be generated. 

An easier way to make changes is to simply modify the DefaultworkspaceProperties.xml file itself. This 
doesn't require an APS restart. But be aware that if this modified file ever gets deleted, the edited settings 
will be lost since an APS restart will generate the file from WorkspacePropertyDefinitions.xml. As a best 
practice, you should keep a backup of a working XML. 

Custom Applications 

For custom applications, you will need to add the path and the programs to the corresponding lists 
(property id="filesWhiteList" and property id="programsWhitelist") with the right permissions to the path 
(ACCESS_READ | ACCESS_WRITE, ACCESS_ALLOW_ALL_CHILDREN, ACCESS_ALLOW_DESCENDANTS, or 
ACCESS_DENIED). 

CIMPLICITY Project Paths 

You will need to add all project paths to "filesWhitelist" with ACCESS_READ, ACCESS_WRITE, 
ACCESS_ALLOW_ALL_CHILDREN, and ACCESS_ALLOW_DESCENDANTS permissions. 

Optimizing Proficy WebSpace Server Performance 

To optimize the performance of the Proficy WebSpace Server, use the following tips:              

Setup Recommendations 

• Restrict usage of mapped drives on the Proficy WebSpace Server. The more mapped drives 
available, the longer it takes to log on to the Proficy WebSpace Server. 

• Try to limit the number of user and global logon scripts that you configure to run on the Proficy 
WebSpace Server. 

• If the SCADA Server and the Proficy WebSpace Server are on different computers, avoid running 
iFIX on the Proficy WebSpace Server machine. 
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• If the SCADA Server and the Proficy WebSpace Server are on different computers, copy the needed 
shared files from the SCADA Server onto the Proficy WebSpace Server machine. Use local copies of 
pictures on the Proficy WebSpace Server machine. 

• For printer driver options, only select the minimum set you need (such as the Universal driver). 

• If you want to view pictures with historical information, make sure that you install Proficy Historian 
for SCADA or the Proficy Historian Client Tools on the Proficy WebSpace Server. 

• Always start the browser session in full screen so that the WorkSpace uses more of the browser 
client area. Be aware that in browser sessions in full screen mode (your iFIX User Preferences are 
set to open pictures in full screen mode), you cannot Alt+Tab to other open applications such as 
Word or Excel that appear behind the Proficy WebSpace application. 

Picture Recommendations 

• Restrict the usage of high color graphics, such as bitmaps, as they take longer to load and tax 
system resources depending on the size and resolution. Try to use smaller sized files and at a 
lower resolution. Combine multiple bitmaps into a single image. 

• For iFIX, disable auto-scaling on the Proficy WebSpace Server (User Preferences > Picture 
Preferences) if you do not want the resolution of graphics and text in your pictures to change (and 
be auto-sized) when you open a picture from a web session. By default, auto scaling is enabled. 
You may want to disable this feature if text or images appear slightly distorted from the original 
picture when viewed via the web session.   

• For iFIX, disable picture caching on the Proficy WebSpace Server (User Preferences > Picture 
Preferences). By default, picture caching is enabled. Although it speeds up the picture 
performance, it will slow down the processing on the Proficy WebSpace Server. If any memory 
needs to be freed up on the server, it is a good idea to disable picture caching. 

• If you use Enhanced Charts in iFIX, use Bitmap/Gradient Styles sparingly. 

• Minimize the number of pictures that are open at the same time in your Proficy WebSpace client. 
In iFIX, try to avoid using the OpenPic command in pictures. We have found in testing that the 
OpenPic command results in slower performance. The ReplacePic command is preferred. 

• If using Proficy Portal controls in your pictures, and you experience display issues in the Proficy 
WebSpace sessions try some of these suggestions: 

• If Internet Explorer does not display these Proficy Portal controls, clear any proxy server 
settings. (On the Tools  menu, click Internet Options. In the Internet Options dialog box, 
click the Connections tab and then the LAN Settings button to access proxy settings.) 
 Next, clear the User JRE version for applet option in the Advanced Settings. (On the Tools 
menu, click Internet Options. In the Internet Options dialog box, click the Advanced tab 
and then scroll to the Java (Sun) category and locate the User JRE version for applet 
option.) 

• If the web browser's security levels are set to allow only trusted sites, make sure you add 
the Proficy Portal Server to the list of trusted sites. 

• Refresh rates on pictures can also impact browser performance. In the Proficy WebSpace, by 
default, datalinks, animations, and charts (Enhanced and Standard) in pictures will refresh at a 
rate no faster than once per second. For example, in the Expression Builder, if you enter .1 or .5 as 
the refresh rate for your data source, it will NOT be adhered to. The historical update rate for both 
Enhanced and Standard charts will also be adjusted accordingly. For the alarm blink rate, alarm 
fetch rate, and alarm data refresh rate in the Alarm Summary objects, the Proficy WebSpace will 
refresh the data no faster than every 5 seconds. For instance, even if you set the refresh rates in 
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the Alarm Summary object to be faster, the Proficy WebSpace will not allow a rate faster than 
every 5 seconds. 

• You can adjust these default settings without opening any pictures. Open the FixUserPreferences.ini 
file on the iFIX WebSpace Server. (By default, for iFIX, this file is located in the C:\Program 
Files\Proficy\Proficy iFIX\LOCAL folder. Scroll to the following section and enter larger numbers: 

[WebSpacePreferences] 
DataRefreshThrottleInSecs=1 
AlarmSummaryThrottleInSecs=5 

• A larger number for either of these settings (a slower refresh rate) is intended to improve the Proficy 
WebSpace performance when opening pictures and may also improve mouse click response time. 

NOTE: If you have slower refresh rates entered in the objects in your pictures, the Proficy WebSpace 
will not reset the refresh rate settings to the lower default values of 1 and 5 when you open a 
picture. 

• The acceptable values for the DataRefreshThrottleInSecs are: 1, 2, 5, 10, 15, 30, and 60. Any other 
number will be reset to the lowest value it is closest to. For example, a 3 will become a 2, a 4 will 
become a 2, a 13 will become a 10, a 35 will become a 30, a 59 will become a 30, and a 65 will 
become a 60. 

• An acceptable value for AlarmSummaryThrottleInSecs is any whole number less than or equal to 
300. If you enter a number greater than 300, it will be set to 300. 

IMPORTANT: Use caution when changing these .ini settings, since user data displayed in the Proficy 
WebSpace is refreshed at these rates. 

Improving Picture Open Time 

• If you do experience performance issues (for instance, a picture takes a long time to open, or the 
CPU on the Proficy WebSpace Server or Client starts to spike), try opening the picture on a client 
(View node). If you notice similar performance issues on the client, consider modifying your 
pictures. For instance, you may want to set the picture refresh rates to a slower rate than the 
default. On a high-end server, the login time for the Proficy WebSpace session is approximately 1.5 
times that of a Windows View Node. For example, if your Windows View Node takes 30 seconds to 
start iFIX and open the picture, then the web browser will take approximately 45 seconds. 

• If you experience high CPU usage on the Proficy WebSpace Server, and you are using Alarm 
Summary objects in your pictures, try to reduce the number of rows displayed in the Alarm 
Summary object. Also, when viewing pictures from the web sessions, try closing any unnecessary 
pictures that display Alarm Summary objects. When multiple web sessions display pictures with 
Alarm Summary objects that include multiple rows, the CPU usage on the Proficy WebSpace 
Server may rise. In this scenario, if you reduce the number of rows and open pictures, the CPU 
usage on the Proficy WebSpace Server should improve. 

• If login time (the time from when you enter the Proficy WebSpace URL to the display of the login 
dialog box) increases with each successive client browser connection, this may indicate that the 
CPU usage on the server may be too high and there may be a hardware limitation on the web 
server. Consider using a higher-end server. 

Network Considerations 

• The speed of the computer running the Proficy WebSpace session from a browser can impact 
performance. Faster client machines typically load iFIX pictures much quicker, and have improved 
performance while those pictures are open. For instance, in testing, a slow client with 512 MB RAM 
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and 1.5 GHz processor had picture load times approximately 1.5 times longer than a faster client 
with 1 GB RAM and 3.0 GHz processor. 

• Network speeds and connection types also impact performance for a Proficy WebSpace session. A 
100BaseT network adapter, which is recommended, allows the Proficy WebSpace session to utilize 
optimum speed for its performance. Companies using VPN connections for Proficy WebSpace 
sessions may experience a decrease in performance. 

• Network bandwidth and traffic appears to have a significant impact on system performance. 
Higher traffic networks experience degraded load times and picture performance. 

• Network capability in a Relay Server configuration is especially important, as it directly impacts 
system performance. A Relay Server will perform better on a network with greater speed and 
bandwidth. 

Administering the Proficy WebSpace Server 
The Proficy WebSpace Administration tool allows you to administer, monitor, and control client access to 
the Proficy WebSpace Server, and to add or remove Proficy WebSpace sessions. It displays a list of the 
users logged on to an Proficy WebSpace Server, along with the Proficy WebSpace sessions the users are 
running, and the time the session was started. The Proficy WebSpace Administration lets you terminate 
sessions and end processes taking place on the server. 

Administrators use the Proficy WebSpace Server to monitor processes, sessions, and server activity. The 
following sections provide information on functions the administrator may want to perform or know more 
about:   

• Administration Window Overview 

• Host Options Dialog Box 

• User Account Settings 

• Session Startup 

• Session Shutdown 

• Security Options 

• Password Change 

• Monitoring Server Activity 

• Log Files 

 

Administration Window Overview 

The Proficy WebSpace Administration Window displays information about your Proficy WebSpace Server. 
This information includes: 

• Server activity and processes taking place on the server. 

• A list of the users logged onto a selected Proficy WebSpace Server. 
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• Applications users are running. 

• Times that applications were started. 

This information enables you to perform several administrative tasks, such as: 

• Determine which applications are no longer being used and whether additional servers are 
required. 

• Monitor clients. 

• Administer sessions and processes including: 

• Terminate user sessions. 

• End processes running on the server. 

• Control client access to the Proficy WebSpace Server. 

Window Overview 

The following figure shows an example of the Proficy WebSpace Administration window. 

 

The following table outlines each of the areas in the Proficy WebSpace Administration window. 
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Screen 
Area 

Description 

 

The Tools Menu 

The Tools menu is where you access the Host Options dialog box to configure your Proficy 
WebSpace Server. 

 

The Tree View Pane 
The tree view portion of this window displays a list of Proficy WebSpace Servers on the 
network and their status. For a list of icons and descriptions, refer to the Tree View Icons 
section in this topic. 

IMPORTANT: You must belong to the Administrators group on each WebSpace Server in 
order to access that server from the Proficy WebSpace Administration window. Without 
administrative rights on a server, you will be unable to add applications and terminate 
processes, and so on. 

If a red X displays on the icon, the administrator does not have administrative rights on 
the server. 

If the server's icon has a red X and is grayed out, the server is no longer running the 
Application Publishing Service or it has been turned off. 

A dependent server is orphaned when its relay server has gone down. 

 

The Sessions Tab 
Sessions can be connected, terminated or refreshed through this tab on the Proficy 
WebSpace Administration window. 

Information displayed about each session includes: a unique identifier for the session 
name, the network user name for that session, number of clients connected to a session 
(2 or higher indicates the session is being shadowed), the IP address of the client 
computer from which the user is accessing the server, the date and time the user started 
the application, and the number of applications the user is accessing. 

 

The Processes Tab 
Process information can be viewed, refreshed, or terminated from this tab. 

NOTE: Ending a process without giving users a chance to close their application can result 
in the loss of data. 

 

The Applications Tab 
You can assign command line parameters for the associated application, or change the 
icon that displays for the  application from this tab. 



Proficy* WebSpace 4.8 

35 

Screen 
Area 

Description 

 

The Status Bar 
The status bar provides the following for a selected Proficy WebSpace Server currently 
being accessed: 

• Name. 

• CPU utilization. 

• Memory usage. 

• Number of running sessions. 

• Number of running processes. 

NOTE: If All Hosts is selected, the Sessions number will reflect all the sessions running on 
the network, and the processes number will reflect all the processes on the network. 

Tree View Icons 

The following table describes the icons that can appear in tree view area of the Proficy WebSpace 
Administrator. 

Icon Description Status 

 

Proficy WebSpace Server (Not part of a Relay Server Configuration) Available 

 

Dependent Application Server (in a Relay Server Configuration) Orphaned 

 

Relay Server Unavailable 

 

Relay Server Available 

 

Dependent Application Server (in a Relay Server Configuration) Available 

 

Dependent Application Server (in a Relay Server Configuration) Unavailable 

Accessing the Proficy WebSpace Administration 

During the Proficy WebSpace installation, a shortcut to the Proficy WebSpace Administration is created by 
default. You can access the Proficy WebSpace Administration from the desktop shortcut or from the Start 
menu. 
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To access the Proficy WebSpace Administration: 

• On the desktop, double-click the Proficy WebSpace Administration icon. 

-Or- 

On the Start menu, point to Programs, Proficy WebSpace, Tools, and then click Proficy WebSpace 
Administration. 

Host Options Dialog Box 

The Host Options dialog box is accessed from the Tools menu, from the Options command. It contains 
information for configuring your Proficy WebSpace Server. The Host Options dialog box with example 
settings is shown in the following figure. 

 

The Host Options dialog box displays the following tabs: 

Session Startup 

The Session Startup tab displays the following items: 
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Item Description 

Apply Group Policy Select to apply Group Policy to a user's session at startup. Using Group Policy 
and its extensions, administrators can: 

• Manage registry-based policy. 

• Assign scripts. 

• Redirect folders. 

• Manage applications 

• Specify security options. 

Display Progress 
Messages 

Select to allow various progress messages to be shown to users during 
session startup, after a user is authenticated. Displayed messages include: 

• A user's personal settings are being loaded. 

• Group Policy is being applied. 

• Network drives are being connected. 

• Logon scripts are being run. 

Always in Front Select so that session startup progress messages will be displayed in front of 
all other windows. Clear to permit other windows to be placed in front of the 
progress messages. 

Logon Scripts: User-
specific 

Enable to permit a user-specific executable file to be run during the 
individual logon process. 

IMPORTANT: Authenticated users must have read and execute access to the 
logon script files. User-specific logon scripts are specified using the 
functionality provided by the operating system. 

Logon Scripts: Global Specifies the path of an executable file to be run for all users that log on to 
the server. 

IMPORTANT: Authenticated users must have read and execute access to the 
logon script files. 

Maximum Sessions 
Per User 

Allows you to specify the maximum number of sessions that a user may run 
concurrently. Clear the check box next to this field to allow each user to have 
an unlimited number of sessions. 

The default is to have an unlimited number of user sessions. 



Administering the Proficy WebSpace Server 

38 

Item Description 

Maximum Sessions 
on this Host 

Specifies the maximum number of sessions allowed on this server. When the 
entered maximum sessions are reached on the Proficy WebSpace Server, 
additional sessions are denied access. For example, if the maximum number 
of sessions is 25, the user who initiates the 26th session will be prevented 
from logging on. 

The default is 25 sessions per Proficy WebSpace Server. 

IMPORTANT: In a relay server setting, Proficy WebSpace checks the 
maximum sessions setting on the relay server AND its dependent application 
servers. The value entered for the Maximum sessions on the relay server is 
the maximum number of sessions that can be run concurrently on all 
dependent application servers assigned to that relay server. 

Minimum Available 
Physical Memory 

Specifies the minimum number of megabytes of physical memory that must 
be available for a session to start. When the available physical memory falls 
below the entered number (MB), additional users cannot log on. 

The default is 128 MB. 

Minimum Available 
Virtual Memory 

Specifies the minimum percentage of virtual memory that must be available 
for a session to start. When the available virtual memory falls below the 
entered percentage value, additional users cannot log on. 

The default is 10 percent (%). 

Session Shutdown 

The Session Shutdown tab displays the following items: 

Item Description 

Timeouts: 
Session 

Lets you set a limit on how many minutes a session may run on a server. By 
default, this option is disabled. 

Timeouts: Idle Lets you specify a limit to the number of minutes of idle time allowed on a server, 
since the last mouse or keyboard input event was received in a session. By default, 
this option is disabled. 

Idle Action Select Disconnect to disconnect users when the idle limit has been reached, or 
select Log to log off users when the idle limit has been reached. 
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Item Description 

Warning Period Lets you specify the number of minutes before a session or idle limit is reached 
when users are warned that they are about to be disconnected or logged off. 

This option may be selected if either Session or Idle is enabled. However, the 
Warning Period must be less than the session limit and idle limit settings. Values 
less than or equal to zero provide no warning period. 

Grace Period Lets you specify the number of minutes necessary to provide for a graceful 
shutdown of the application and all of its processes when a session is being closed. 
The Grace Period defaults to a value of 1 minute and should ONLY be changed at 
the instruction of GE Intelligent Platforms Customer Support personnel. 

Disconnected 
Sessions 
Terminate: 
Immediately 

Select so that sessions will terminate as soon as their clients disconnect. 

Disconnected 
Sessions 
Terminate: After 

Lets you specify how many minutes sessions should remain running after their 
clients disconnect. For example, if the network connection is lost or if users 
unintentionally disconnect from the Proficy WebSpace, their session state is 
preserved for the length of time entered here. 

Client Access 

The Client Access tab displays the following items: 

Item Description 

Clipboard Enables client clipboard support. 

Any clipboard data from the browser session is available only within the 
WorkSpace application. In order to copy the contents to other applications on 
the local disk of the client machine you must create a shell script within an 
object inside your WorkSpace picture that launches Notepad.exe, on the 
Proficy WebSpace Server. After you do this, you can use this object to launch 
Notepad in run mode from the web session. Paste the contents into Notepad, 
and save this file to the local disk of web session computer. 
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Item Description 

Sound Enables client sound support. 

The Proficy WebSpace supports sound capability for any application that uses 
PlaySound, sndPlaySound, or waveOut. It is not required that sound cards 
and/or speakers be installed on Proficy WebSpace Servers. The client 
machine, however, does require a sound card and speakers. Audio support is 
disabled by default on the Proficy WebSpace sessions. 

IMPORTANT: Be aware that client sound capability requires the loading of Proficy 
WebSpace libraries into session processes. This can affect the startup of a 
process, make some processes incompatible with Proficy WebSpace, or have fatal 
consequences during suspend/resume operations. Use caution when enabling 
this setting. 

Drives Enables client file access. 

Hide Lets you specify the drives letter(s) of client drives you would like to hide. For 
example: A, B, G-J. Hidden drives are inaccessible to the user through the 
Proficy WebSpace session. 

Assign 
consecutive 
letters starting 
at... 

Lets you remap client drives by listing client drives sequentially starting at a 
given drive letter. 

Increment By... Lets you remap client drives by incrementing client drive letters by a fixed 
value. 
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Item Description 

Universal Printer 
Driver 

Enables the use of the Universal Printer Driver that can print to any client printer. 
When only the Universal Printer Driver is enabled, only the Universal Printer 
Driver will be used as a printer driver. No native drivers will be used. This is the 
default setting. 

The Universal Printer Driver uses a standard printing properties dialog box and 
may not offer some of the more advanced printing options other drivers do. 

The Universal Printer Driver can be used when the native driver is not available. 

When neither the Universal Printer Driver nor Windows Printer Drivers is enabled, 
no printers will be configured and client printing is disabled. 

NOTE: A printer named Preview PDF is configured in each session when the 
Universal Printer Driver is enabled. Documents printed to this printer are 
automatically converted to a .pdf file and displayed on the client computer. 
Users can save, print, or email the document at their discretion. A PDF reader, 
such as Adobe Reader, is required on the client computer in order to use the 
Universal Printer Driver's PDF conversion feature. 

Windows Printer 
Driver 

Enables printers to be configured using already installed native drivers. When 
only the Windows Printer Drivers option is enabled, only native printer drivers 
that are installed on the Proficy WebSpace Server will be used. If a printer's 
native driver is not installed, that printer will not be configured. 

To allow the Proficy WebSpace to automatically install native printer drivers that 
ship with Microsoft Windows click the Automatically install drivers. 

The Windows Printer Driver option is preferred when configuring proxy printers, if 
they are available and if settings allow them to be used. 

When both the Universal Printer Driver and the Windows Printer Drivers are 
enabled, and a printer's native driver is installed on the Proficy WebSpace Server, 
the printer's native driver will be used to configure the printer. If it is not installed 
on the Proficy WebSpace Server, the printer is configured to use the Universal 
Printer Driver. 

When Windows Printer Drivers and Automatically install drivers are enabled, only 
native printer drivers that are installed on the Proficy WebSpace Server or those 
that are included with Windows will be used. If a printer's native driver is not 
installed and it is not included with Windows, that printer will not be configured. 

When neither the Windows Printer Drivers nor Universal Printer Driver is enabled, 
no printers will be configured and client printing is disabled. 

Automatically 
Install Drivers 

Allows the Proficy WebSpace to automatically install native printer drivers that 
ship with Microsoft Windows. The Automatically Install Drivers option is only 
available when the Windows Printer Driver option is selected. 
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Item Description 

Automatically 
Update Clients 

Lets you automatically update a Proficy WebSpace Desktop Client when a user 
connects to a Proficy WebSpace Server that is running a newer version. 

NOTE: The Automatically Update Clients option on the Client Access tab of the 
Proficy WebSpace Administration tool is only available for the Windows Desktop 
Client. It does not apply to other clients such as Mozilla Firefox and Internet 
Explorer. 

Serial and Parallel 
Ports 

Allows applications running on the host to access client machines' serial and 
parallel ports. Serial and parallel ports are disabled by default. 

Be aware that Client Serial and Parallel Ports requires the loading of Proficy 
WebSpace libraries into session processes. This can affect the startup of a 
process, make some processes incompatible with Proficy WebSpace, or have 
fatal consequences during suspend/resume operations. As such, when Serial 
and Parallel Ports is enabled, a message box opens and asks for confirmation. 

Security 

The Security tab displays the following items: 

Item Description 

Transport Lets you select the protocol to use for communication between clients and 
Proficy WebSpace Servers. When selecting the Encrypted transport, an X.509 
Certificate file must be specified. 

Port Lets you change the port on which this Proficy WebSpace Server is listening. 

Encryption Lets you specify the type of encryption of the data that is transmitted between 
the client and the server. Encryption includes: 

• The client's user name and password, which are supplied during logon 

• Any application data submitted by the client or returned by the server. 

Proficy WebSpace uses 56-bit DES encryption. After you have enabled 
encryption, all succeeding Proficy WebSpace sessions will be encrypted. 
Sessions that are active when the feature is enabled will not be encrypted. A 
user must log off, then onto the Proficy WebSpace Server for his or her session 
to be encrypted. 
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Item Description 

X.509 Certificate Lets you specify the full path of the X.509 Certificate that is required to use the 
Encrypted transport. You can obtain a certificate from a trusted Certificate 
Authority (CA) such as Verisign or Thawte, or you can create your own certificate 
authority and then sign your server certificates from this authority. 

When the Encrypted transport is selected, all connections to that Proficy 
WebSpace Server use the Encrypted transport and the selected encryption 
algorithm, including connections from Proficy WebSpace sessions. 

Consult the documentation from the CA of your choice using the following 
information as a guide to obtain a server certificate from a CA that is trusted by 
the client operating system. 

In order for a certificate to work in Proficy WebSpace: 

• A private key is required. 

• The certificate must be in PEM format. 

Consult Microsoft documentation for details. 

Notify Users 
When 
Connections are 
Secure 

Enable to notify users with a message when connections between client and 
server are secure. This option is only available when the Encrypted transport 
mode is selected. 

Standard 
Authentication 

Allows users to log on with their user name and password every time they 
connect to the server. Users are added to the server's INTERACTIVE group and 
have the same access rights they would have if they logged on to the server at its 
console. This is the default setting. 

NOTE: To make the "Cache Passwords on the Client" option available for 
selection, you must have the Standard Authentication option selected. 
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Item Description 

Cache Passwords 
on Client 

Allows users to log on without having to enter their user name and password 
every time they connect to the server. Available only when Standard 
Authentication is enabled. 

With this option enabled, the Login dialog box will display a "Remember me on 
this Computer" check box. If a user selects this check box on the first login from 
the client, the next time that user logs in from that same computer, the Logon 
dialog box will show the User Name and Password dialog box pre-populated with 
the previous login. All the user needs to do to continue is click Sign In. 

Passwords are encrypted on the server, transmitted over the network, and stored 
on client computers in user-private directories. Users are added to the server's 
INTERACTIVE group and have the same access rights they would have if they 
logged on to the server at its console. 

The cached password is saved in the following directory: 

C:\Documents and Settings\<user name> folder\Application Data\Proficy\Proficy 
WebSpace\<server name>.dat 

Integrated 
Windows 
Authentication 

Allows users who sign in from Windows computers that are members of the 
same domain as the Proficy WebSpace Server without having to re-enter their 
user name and password every time they connect to the server. When Integrated 
Windows Authentication is the only option enabled, users' passwords are never 
transmitted over the network. Users are added to the INTERACTIVE group, and 
passwords are cached on the server by default. 

If both Standard authentication and Integrated Windows authentication are 
enabled, the Proficy WebSpace Server attempts to log in the user with Integrated 
Windows authentication first, and then Standard authentication, if Windows 
authentication fails. 

Log 

The Log tab displays the following items: 

Item Description 

Folder Specifies a folder to which log files will be written and in which there are 
subfolders where backed up logs will be stored. The default location is: 
C:\Program Files\Proficy\Proficy WebSpace\Log. Proficy WebSpace Server 
does not support storing logs directly in a network folder. 

Output Level Specifies the level of information written to the log file, with numbers 1 to 6 
capturing ever greater detail, and 0 capturing no output. The default level is 2. 
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Item Description 

Maintenance Lets you select which action will be performed on log files that have reached the 
specified age or size. The action applies to the current log file as well as to those 
which are inactive. 

Files More than 
... days old 

Specifies how many days old log files can become before being deleted or moved 
to the Backup subdirectory of the Log folder. The setting applies to the current log 
file as well as to those which are inactive. 

or... MBs in size Specifies at what size, in megabytes, log files are to be deleted or moved to the 
Backup subdirectory of the Log folder. The setting applies to the current log file as 
well as to those which are inactive. 

 

General 

The General tab displays the following items: 

Item Description 

Shared 
Account 

Allows you to create an account that be shared by multiple users. 

If an administrator designates an existing user name as a shared account while 
that user is disconnected from his or her session, the session will remain running 
on the server until the termination limit has been reached. The session will then be 
terminated. Before specifying a shared account, verify in the Proficy WebSpace 
Administration that there are no connected or disconnected sessions using that 
account. 

NOTE: Proficy WebSpace does not support the use of domain names (for example, 
NORTH\johnq) for shared accounts. 

Relay Server 
Lets you specify the name or IP address of a Proficy WebSpace Server that 
manages the communication between Proficy WebSpace Clients and a set of 
dependent application servers. 

Use Client Time 
Zone 

Select this option to run Proficy WebSpace sessions in the time zone of the client 
computer. 

  

User Account Settings 

To access Proficy WebSpace sessions on a Proficy WebSpace Server, client users must log on to the server 
machine. When users start a Proficy WebSpace session, they are prompted for their user name, password, 
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and the name of the server they wish to access. This information is encrypted and passed to the Proficy 
WebSpace Application Publishing Service running on the Proficy WebSpace Server. The Proficy WebSpace 
Application Publishing Service then performs the logon operation using standard multi-user features of 
Windows. 

When a user logs on to a server and a domain is not specified, the Proficy WebSpace Server first tries to 
authenticate the account on the local machine, then the machine's domain, and finally the trusted 
domains. Users can override this default behavior and specify a domain by typing the domain name 
followed by a backslash and their network user name in the user name field of the Logon dialog box. For 
example: NORTH\johng. 

When a local user name on the Proficy WebSpace Server is the same user name as a domain account, 
each with a different password, Proficy WebSpace treats them as two separate accounts. 

After a user is logged on, the Proficy WebSpace relies on the server's operating system to provide the 
security necessary to run applications safely in a multi-user environment. Applications run in the security 
context of the client user to ensure private sessions. Access to all machines and network resources is 
governed by the operating system and the rights that have been granted to individual user's sessions. 

Users must be able to log on interactively (locally) on the Proficy WebSpace Server. Assign local logon rights 
to users in Local Security Policy, Domain Security Policy, and Domain Controller Security Policy. 

For more detailed information on administration of user accounts, please consult your Microsoft Windows 
Help. 

Setting File Permissions 

As the system administrator, you may need to restrict user access to certain files and resources. Keep in 
mind that there are multiple users accessing the server. 

Particularly in a Relay Server environment, it is recommended to write-protect your system and application 
folders so that users are unable to save files on a Proficy WebSpace Server. Otherwise, the next time a user 
logs on to Proficy WebSpace and is routed to a different server, the files and folders will be inaccessible. 

You must use Windows Explorer to set the permissions for files on the server. By setting file permissions, 
you can restrict user access to applications, printers, and folders. Please note that file permissions can only 
be set on drives formatted with the Windows NT file system (NTFS). If you are using the FAT file system, you 
will be unable to set permissions for specific files or restrict access to applications. 

Once an application's permissions have been set, you can assign specific parameters for the application 
with the Proficy WebSpace Administration. 

NOTE: While in Windows Explorer, open the Help for more information on setting file permissions. 

Setting up a Network Printer 

If the printer on the Proficy WebSpace Server is a network printer, and you want to allow printing on the 
web sessions to this printer, you must add the network printer to the Proficy Web Server. As the 
administrator, you can set up network printers for use by Proficy WebSpace sessions. You must first create 
a port on the Proficy WebSpace Server that connects directly to the server and then install the printer 
locally. This provides direct access to the printer. 

Network printers are set up using the Windows Add Printer Wizard. 
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NOTES: 

• If a printer is physically connected to the Proficy WebSpace Server, and you want to allow printing 
from the web sessions to this printer, no additional configuration changes need to be made on the 
Proficy WebSpace Server or web session. 

• If you want to allow printing in the web sessions from client printers, refer to the Client Printing 
section for information on how to configure. 

To add a printer to the Proficy WebSpace Server: 

1. On the Start menu, point to Settings, and then click Printers and Faxes. 

2. Double-click the Add Printer icon. 

3. Select local printer, then click Next. 

4. Click Create a new port and select Local Port or Standard TCP/IP Port as the type. Click Next. 

5. In the Port Name dialog, type the UNC path to the printer or the printer's IP address. For example: 
\\PRINTSERVER\LASERPRINTER. 

6. Select the printer manufacturer on the left and the printer model on the right or click Have Disk. 

7. Follow the directions provided by the Add Printer Wizard to install the proper printer driver. 

Session Startup 

For information on starting up Proficy WebSpace sessions, refer to the following sections: 

• Applying Group Policy 

• Displaying Progress Messages 

• Logon Scripts 

• Setting Resource Limits 

• Logging in with One Login Dialog Box 

Applying Group Policy 

The Microsoft Group Policy is supported. Using Group Policy and its extensions, administrators can manage 
registry-based policy, assign scripts, redirect folders, and specify security options. For more information 
regarding this feature, go to: https://technet.microsoft.com/en-us/library/Hh147307(v=WS.10).aspx. 

To apply Group Policy on a Proficy WebSpace Server: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. On the Session Startup tab, select the Apply Group Policy check box. 

4. Click OK. 

NOTE: It may take users longer to log on to the Proficy WebSpace Server when the Group Policy is enabled. 

https://technet.microsoft.com/en-us/library/Hh147307(v%3dWS.10).aspx
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Displaying Progress Messages 

After a user is authenticated, a message box that reports session startup progress can be displayed to 
users. When enabled, these messages inform users of the following: 

• When their personal setting are being loaded. 

• When Group Policy is being applied. 

• When network drives are being connected. 

• When logon scripts are being run. 

To display session startup progress messages to users: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Session Startup tab. 

4. Select the Display progress messages check box. 

5. To ensure that messages are displayed in front of all other windows, select Always in front check 
box. 

NOTE: If a logon script has the ability to display user interface to the user, the Always in front 
option should not be enabled. Otherwise, the logon script's user interface may be partially 
obscured by the progress message. 

6. Click OK. 

Logon Scripts 

Logon scripts allow administrators to configure the operating environment for Proficy WebSpace users. 
Scripts may perform an arbitrary set of tasks such as defining user-specific environment variables and 
drive letter mappings.  

The Proficy WebSpace supports two types of logon scripts: global scripts that execute for all users that log 
on to the server, and user-specific scripts that execute for individual users. Before loading the user's profile, 
the Proficy WebSpace checks to see if a script of either (or both) type has been specified. If so, the Proficy 
WebSpace runs the script(s) within the user's security context each time the user is authenticated. 

NOTE: User-specific project paths for Proficy WebSpace sessions are not supported. For example, you 
cannot use different directory paths for iFIX files, such as pictures, across multiple users.  If you need to 
support this, it is suggested that you use iFIX with Terminal Server, instead of Proficy WebSpace. 

User-specific logon scripts are specified using the functionality provided by the operating system. For 
example, the logon script for local users on a Windows 2000 server is specified as follows: 

1. Right-click My Computer and click Manage. 

2. Navigate to the \System Tools\Local Users and Groups\Users folder. 

3. Select a user and click Properties. 

4. Click Profiles. 
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5. In the Logon script box, type the file name of the user's logon script. 

If the value entered in the Logon script box specifies a file name and extension only, Proficy WebSpace 
searches for the file in the following directories, in the following order: 

1. If the user's account is a domain account: 

a. \\pdcname\NETLOGON; for instance, the NETLOGON share of the primary domain 
controller. 

b. \\pdcname\SYSVOL\domainname; for instance, the domain subdirectory of the primary 
domain controller's SYSVOL share. 

2. If the user's account is a local account: 

a. systemroot\System32\Repl\Import\Scripts 

b. systemroot\sysvol\sysvol\domainname 

If the logon script is stored in a subdirectory of one of the above directories, precede the file name with the 
relative path of that subdirectory. For example: Admins\JohnG.bat. 

Administrators specify global and user-specific logon scripts through the Proficy WebSpace 
Administration's Session Startup dialog. 

To run user-specific logon scripts: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Session Startup tab. 

4. Select the User-specific check box. 

5. Click OK. 

To run a global logon script: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Session Startup tab. 

4. Select the Global check box. 

5. In the field next to the check box, specify the path of the global script file. 

For example, you may want to add the LoginScript.bat, provided in the C:\Program 
Files\Proficy\Proficy WebSpace Server\Programs folder as an example for configuring mapped 
drives, as a global script. 

6. Click OK. 

NOTE: Authenticated users must have read and execute access to the logon script files. An example of a 
logon script is described in the Creating Mapped Drives on the Proficy WebSpace Server section. The 
LoginScript.bat example described in this section can be applied on a global or user-specific basis. 
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Setting Resource Limits 

Proficy WebSpace allows administrators to prevent users from starting new sessions when certain 
resource limits are exceeded on a Proficy WebSpace Server. These limits help administrators prevent 
servers from becoming loaded to the point where users experience performance problems and random 
resource allocation failures. You can also limit the total number of session connections to the Proficy 
WebSpace Server. And, you can prevent users from logging on when the available physical memory or 
virtual memory on a server falls below a given value.  

These resource limits are especially important in a Relay Server configuration. For each dependent server 
in a Relay Server configuration, you must configure these limits. 

To limit the number of sessions per user: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Session Startup tab. 

4. Select Maximum sessions per user check box. 

5. In the field next to the check box, enter the maximum number of sessions allowed per user on this 
server. 

6. Click OK. 

To limit the number of sessions per Proficy WebSpace Server: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Session Startup tab. 

4. In the Maximum sessions per host field, enter the total maximum number of sessions allowed for 
this server. 

5. Click OK. 

To specify the minimum available physical memory necessary for this server to start a session: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Session Startup tab. 

4. In the Minimum Available Physical Memory field, enter the minimum number of free megabytes 
(MBs) necessary for sessions to be allowed on this server. 

5. Click OK. 
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To specify the minimum percentage of virtual memory necessary for this server to start a 
session: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Session Startup tab. 

4. In the Minimum Available Virtual Memory field, enter the minimum percentage number necessary 
for sessions to be allowed on this server. 

5. Click OK. 

Logging in with One Login Dialog Box with iFIX 

The Proficy WebSpace provides the ability to pass through the authenticated Windows user from the 
Proficy WebSpace session without asking for re-authentication in iFIX.  If enabled, no longer will you see 
the double logins: one for Proficy WebSpace and one for the iFIX session. Logins are simplified to a single 
login with this feature enabled. 

However, if you need to do writes within your picture from a WebSpace session, the currently logged in 
user MUST be logged out and manually logged back in. In order to do this in iFIX, you need to have a login 
script in the picture to open the iFIX Login dialog box. For more information, refer to the LogIn Subroutine 
section in the iFIX Automation Reference. Otherwise, writes will not be allowed from the following: 

• A Datalink 

• An Alarm Acknowledgement (in the Alarm Summary or Command Expert) 

• A Write Value change (Command Expert) 

• A Ramp Value change (Command Expert) 

• The Toggle Digital Value (Command Expert) 

• The Toggle Scan (Command Expert) 

• Within a DataEntry field (Slider Expert for example) 

• Through EDA (using the EDAQUICK tool) 

How to Enable 

To enable this option, edit the FixUserPreferences.ini in the iFIX Local folder. By default, this folder is: 
C:\Program Files\Proficy\Proficy iFIX\LOCAL. Add the SHOWIFIXLOGIN key and set its value to 0, as shown 
in the following snippet of code. 

[WebSpacePreferences] 
DataRefreshThrottleInSecs=1 
AlarmSummaryThrottleInSecs=5 
SHOWIFIXLOGIN=0 

By default, this feature is disabled for compatibility issues with previous versions. 

NOTE: For this option to work properly in a Relay Server setup, the SHOWIFIXLOGIN key update should exist 
in the FixUserPreferences.ini on all the dependent servers. 
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Session Shutdown 

For information on shutting down the Proficy WebSpace session, refer to the following sections: 

• Specifying the Session Limit 

• Specifying the Idle Limit 

• Specifying the Warning Period 

• Specifying the Grace Period 

Specifying the Session Limit 

The session limit is the number of minutes that sessions are allowed to run on a Proficy WebSpace Server. 

To specify the session limit: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Session Shutdown tab. 

4. Select the Session check box. 

5. In the field next to the check box, enter the number of minutes that a session is allowed to run on 
a server before its user is logged off. 

6. Click OK. 

The minimum number of session time is 1 minute and the maximum is 44640 minutes (31 days). This 
feature is disabled by default. 

Specifying the Idle Limit 

Idle time refers to the number of minutes since the last mouse or keyboard input event was received in a 
session. The idle limit is the number of minutes of idle time that a Proficy WebSpace Server allows.  

To specify the idle limit: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Session Shutdown tab. 

4. Select the Idle check box. 

5. In the field next to the check box, enter the number of minutes of idle time allowed by the server. 

6. From the Action drop-down list, select either Disconnect to disconnect users when the idle limit 
has been reached, or Log off to log users off when the idle limit has been reached. 

7. Click OK. 
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The minimum number of idle time is 1 minute and the maximum is 44640 minutes (31 days). This feature is 
disabled by default. 

Specifying the Warning Period 

The warning period represents the number of minutes before a session limit or idle limit is reached when 
users are warned they are about to be disconnected or logged off. For example, if the warning period is set 
to 2, users will be warned 2 minutes before the session limit or the idle limit is reached. 

The warning period must be less than the session limit and idle limit settings. This feature is disabled by 
default.  

To specify the warning period: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Session Shutdown tab. 

4. Select the Warning period check box.    

NOTE: Either a Session or Idle time-out must be configured for the Warning period check box to 
become available. 

5. In the field next to the check box, enter the number of minutes before a session or idle limit is 
reached when users are warned that they are about to be disconnected or logged off.   

6. Click OK. 

Specifying the Grace Period 

The grace period allows you specify the number of minutes required to provide for a graceful shutdown of 
the application and all of its processes when a session is being closed. The Grace Period defaults to a value 
of 1 minute and should ONLY be changed at the instruction of GE Intelligent Platforms Customer Support 
personnel.  

To specify the grace period: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Session Shutdown tab. 

4. Select the Grace period check box. 

NOTE: Either a Session or Idle time-out must be configured for the Grace period check box to 
become available. 

5. In the field next to the check box, enter the number of minutes after a logoff that users are able to 
save files and close applications, and so on.   

6. Click OK. 
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The minimum grace period value is 1 minute and the maximum value is 15. By default, the grace period is 
1 minute. 

Security Options 

For information on Proficy WebSpace security options, refer to the following sections: 

• Authentication Overview 

• Selecting the Transport Mode 

• Encrypting Sessions 

• Generating a CSR Using IIS Certificate Wizard 

• Notifying Users of a Secure Connection 

• Modifying the Server Ports 

• Client-Side Password Caching 

• Hiding Server Drives 

Authentication Overview 

The Proficy WebSpace provides two methods of authentication: 

• Standard Authentication (the default setting) 

• Integrated Windows Authentication 

The Proficy WebSpace requires that at least either Standard authentication or Integrated Windows 
authentication be enabled. If both Standard authentication and Integrated Windows authentication are 
enabled, the Proficy WebSpace Server attempts to log the user on in the following order: 

• Integrated Windows authentication. 

• Standard authentication, if Windows authentication fails. 

Standard Authentication 

Standard Windows authentication is the default method for authenticating users on a Proficy WebSpace 
Server. Standard authentication allows users to sign in to a Proficy WebSpace Server from the Logon 
dialog box by supplying their user name and password. Once authenticated, users are added to the 
server's INTERACTIVE group and given the same access rights as if they had signed in to the Proficy 
WebSpace at its console. 

Users logging onto a Proficy WebSpace Server with standard authentication are: 

• Added to the server's INTERACTIVE group. 

• Granted the same access rights that they have when logging onto the server at its console. 

IMPORTANT: In a Relay Server configuration, a user logs in to the Dependent Application Server, but the 
user credentials must also be authenticated at the Relay Server  to obtain a Proficy WebSpace “license 
token." 
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Standard authentication includes logging on either with a user name and password supplied by any of the 
following: 

• Logon dialog·box 

• HTML parameters· 

• Command-line arguments 

Optionally, when Standard Authentication is enabled, you can also enable Client-Side Password Caching to 
allow the user name and password to be saved locally on the client, if the Remember Me on this Computer 
check box was selected in the Logon dialog box on the previous login. With the Remember Me on this 
Computer option enabled, the Logon dialog box appears with the user name and password pre-populated. 

Integrated Windows Authentication 

Integrated Windows authentication allows users to connect to a Proficy WebSpace Server and start a 
session without having to sign in to the server and re-enter their user name and password. When 
Integrated Windows authentication is the only option enabled, the user’s user name and password are 
never transmitted over the network. Instead, the Proficy WebSpace simply runs the user’s session in the 
same security context as the Proficy WebSpace Client. Users are added to the server's INTERACTIVE group, 
and passwords are cached on the server by default. 

IMPORTANT: Integrated Windows authentication is only available to users who sign in from Windows 
computers that are members of the same domain as the Proficy WebSpace Server. 

NOTE: When Integrated Windows authentication is the only option enabled, the user’s user name and 
password are never transmitted over the network. Instead, the Proficy WebSpace runs the user’s session in 
the same security context as the client. 

To avoid these conditions, when Integrated Windows Authentication is enabled, the Proficy WebSpace 
automatically caches passwords on the server. Doing so allows users to sign in from Windows computers 
that are members of the same domain as the Proficy WebSpace Server without having to enter their user 
name and password every time they connect. Users are prompted for a password when first connecting to 
the server or following a password change. Passwords are stored within their respective profiles and can 
only be decrypted from within their respective security contexts. With subsequent connections to Proficy 
WebSpace, users are automatically signed in and added to the host's INTERACTIVE group. They are granted 
the same access rights had they signed in to the host at its console. 

Proficy WebSpace caches passwords on the host using the industry standard encryption algorithms 
provided by Microsoft’s Data Protection application programming interface (DPAPI). For more information 
about DPAPI search the MSDN Library (http://msdn.microsoft.com/library/default.asp) for “Windows Data 
Protection.” 

IMPORTANT: If User Account Control (UAC) is enabled on  the Proficy WebSpace Server, be aware that if 
you first log in to the Proficy WebSpace Server console and then try to start a Proficy WebSpace session on 
a remote client by logging in under the same user, you may experience issues with the application not 
being able to start on the Proficy WebSpace Server.  Log out of the Proficy WebSpace Server console, and 
then log back in to the console to resolve this issue. 

Selecting the Transport Mode 

The Proficy WebSpace supports transport protocols that provide communication between Windows and 
the Proficy WebSpace Server. When selecting the Encrypted transport, an X.509 Certificate file must be 

http://msdn.microsoft.com/library/default.asp
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specified. X.509 certificates are required to secure communication between Proficy WebSpace sessions 
and the Proficy WebSpace Server. You can obtain a certificate from a trusted Certificate Authority (CA) such 
as Verisign or Thawte, or you can create your own certificate authority and then sign your server 
certificates from this authority.  

IMPORTANT: The Apache and IIS web servers and their components (for example, OpenSSL) must be 
maintained and patched as per the latest security guidelines provided by their respective software 
vendors. The security of Proficy WebSpace  sessions depends on the security that  the web servers provide. 

To select the transport mode: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Security tab. 

4. In the Transport drop-down list, select Encrypted. 

5. When selecting Encrypted transport, type or browse to the path of the server's certificate in the 
X.509 Certificate box. 

6. Click OK. 

When the Encrypted transport is selected, all connections to that Proficy WebSpace Server use the 
Encrypted transport and the selected encryption algorithm, including connections from Proficy WebSpace 
sessions. Proficy WebSpace sessions that do not support the Encrypted transport will be unable to connect 
to the server using the Encrypted transport unless the Use TCP as fallback option is enabled. 

To select TCP as the fallback transport mode: 

1. From the Proficy WebSpace Administration, in the server tree, select the desired server from the 
list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Security tab. 

4. In the Transport drop-down list, select Encrypted. 

5. Select the Use TCP as fallback check box. 

6. Click OK. 

Encrypting Sessions 

For purposes of security, administrators can optionally encrypt all data transmitted between the client and 
the server. This includes the client's user name and password, which are supplied during logon, and any 
application data submitted by the client or returned by the server. The Proficy WebSpace uses 56-bit DES 
encryption.    

To encrypt a server's sessions: 

1. From the Proficy WebSpace Administration, in the Proficy WebSpace Server tree, select the desired 
server from the list. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 
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3. Click the Security tab. 

4. From the Encryption drop-down list, select an encryption level. 

5. Click OK. 

After you have enabled encryption, all new Proficy WebSpace sessions will be encrypted. Sessions that 
are active when the feature is enabled will remain unencrypted. The next time the user logs on to the 
Proficy WebSpace Server, however, his or her session will be encrypted. The user must log off the Proficy 
WebSpace Server, and log back on in order for his or her session to be encrypted. 

Generating a CSR Using IIS Certificate Wizard 

The Proficy WebSpace requires that the certificate be in PEM format.  

Notifying Users of a Secure Connection 

When the Encrypted transport is selected as the transport mode, you can opt to notify users when 
connections are secure.  

To notify users when connections are secure: 

1. In the Proficy WebSpace Administration, in the Proficy WebSpace Server tree, select the server. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Security tab. 

4. In the Transport list box, select Encrypted.   

5. In the X.509 Certificate field, type or browse to the path of the server's certificate file. 

6. Select the Notify users when connections are secure option. 

7. Click OK. 

Modifying the Server Ports 

When you install the Proficy WebSpace, and the firewall is enabled, the install automatically prompts you 
to add the Proficy WebSpace to your exception list.  This allows users to access the Proficy WebSpace 
Server through a firewall or router. Administrators can modify the Proficy WebSpace Server port setting for 
the Proficy WebSpace Application Publishing Service. The default port number for the Encrypted transport 
is 491.  

• Port 492 is the port used by the “Proficy WebSpace Relay Client Manager Service" to centrally 
manage the WebSpace user count in a Relay Server configuration. This port is not configurable 
through the Proficy WebSpace Administration application. 

To modify the server port setting for the Proficy WebSpace Application Publishing Service: 

1. In the Proficy WebSpace Administration, in the Proficy WebSpace Server tree, select the server. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Security tab. 
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4. In the Port edit box, enter a new port number. 

5. Click OK. 

NOTE: In a Relay Server Configuration, if you change the ports, make sure the port usage is the 
same on the Relay Server and each Dependent Application Server. 

After You Change the Port 

After changing the server port number, you must: 

• Restart the service and any other services that depend on it.  For example, if you change port 491 
and you allow client printing, you must restart the "Proficy WebSpace Application Publishing 
Service" and the Print Spooler Service in order for client printing to work on a port other than the 
default port 491. 

• Modify the port parameter from the Proficy WebSpace hyperlink, if you are using a command line. 
Use the port parameter followed by the new port number. For example: 

• For iFIX: http://WebSpaceServerName/ProficyWebspace/iFIX.html?port=1667. 

• For Plant Applications: 
http://WebSpaceServerName/ProficyWebspace/PlantApplications.html?port=1667). 

• For CIMPLICITY:  "C:\Program Files (x86)\Proficy\Proficy Webspace 
Client\Client\Proficy.exe" -a CimView -h server1 -hp 1667. 

• Modify the port parameter argument, if using the Proficy WebSpace from a desktop shortcut or 
the Connection dialog box. Append the -hp argument (followed by the new port number) to the 
shortcut. For example: 

• For iFIX: "C:\Program Files (x86)\Proficy\Proficy WebSpace Client\Client\Proficy.exe" -a iFIX 
-h server1 -hp 1667.    

• For Plant Applications: "C:\Program Files (x86)\Proficy\Proficy WebSpace 
Client\Client\Proficy.exe" -a PlantApps -h server1 -hp 1667.   

• For CIMPLICITY, specify the host port in the .HTML file.  For details, refer to the CIMPLICITY 
HTML File Overview (the table in the General Options section describes the hostport 
parameter). 

• If you specify the port number in the Connection dialog box when signing in to Proficy WebSpace, in 
the Host Address box, type the host name or IP address, followed by a colon and the port number 
(for example, server1:1667). If the new port number is not specified by either of these methods, 
users will be unable to sign in to Proficy WebSpace. 

• Enable the new port through your firewall software. For example, the following figure shows a list 
of Windows Firewall exceptions that includes the Proficy WebSpace applications: 
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Client-Side Password Caching 

NOTE: To make the "Cache Passwords on the Client" option available for selection, you must have the 
Standard Authentication option selected on the Security tab in the Host Options dialog box. 

Client-side password caching allows users who are not members of the Proficy WebSpace Server's domain 
to log on without having to enter their user name and password every time they connect to the server.   

With this option enabled, the Login dialog box will display a "Remember me on this Computer" check box. If 
a user selects this check box on the first login from the client, the next time that user logs in from that 
same computer, the Logon dialog box will show the User Name and Password dialog box pre-populated 
with the previous login. All the user needs to do to continue is click Sign In. 

After the first manual authentication, the user logon credentials are encrypted on the server using the 
SYSTEM account context, transmitted over the network, and stored on client computers in user-private 
directories. 

When the user makes subsequent connections to the server, the cached password is transmitted back to 
the server, where it is decrypted using the SYSTEM account context and then used to automatically log the 
user on to the Proficy WebSpace Server. The user is added to the server's INTERACTIVE group and granted 
the same access rights had that user logged on to the server at its console. The Sign In dialog is displayed 
with the user name and password and with Remember me on this computer checked. If the user disables 
the Remember me on this computer option, the user's credentials will be deleted from the client computer. 

Proficy WebSpace caches passwords on the server using the industry standard encryption algorithms 
provided by Microsoft’s Data Protection Application Programming Interface (DPAPI). For more information 
about DPAPI search the MSDN Library (http://msdn.microsoft.com/library/default.asp) for "Windows Data 
Protection." 

To enable client-side password caching: 

1. From the Proficy WebSpace Administration, on the server list, select the desired server. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Security tab. 

http://msdn.microsoft.com/library/default.asp
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4. Select the Cache Passwords on the Client check box. 

NOTE: This option is only available if the Standard Authentication option is also selected. 

5. Click OK. 

On most platforms, the cached password is stored in the user's home directory in a .dat file named for the 
Proficy WebSpace Server. For example, for the Proficy WebSpace ActiveX Control, C:\Documents and 
Settings\user1\Application Data\Proficy\Proficy WebSpace Server\server1.dat is an example location of the 
cached password. In this example, user1 is the user logged into the WebSpace session, and server1 is the 
name of the Proficy WebSpace Server. 

Client-side password caching is supported on Internet Explorer, Mozilla Firefox, and the Desktop Client. 

IMPORTANT: If you are concerned about public computers retaining cached passwords, you should clear 
the Cache Passwords on the Client check box on the WebSpace Server. By default, this option is cleared. 

Hiding Server Drives 

Microsoft's Group Policy Objects lets you hide specific host drives. For instructions, see 
http://support.microsoft.com/kb/231289. To hide host drives, the Apply Group Policy option must be 
enabled in the Host Options dialog box in the Proficy WebSpace Administration application.   

Password Change 

Password changes can be made through Windows security groups and accounts. Users can change 
passwords when:     

• The administrator requires the user to change his or her password at the next logon. For more 
information, refer to the Changing Passwords at Next Logon section. 

• The security policy is configured to prompt users to change passwords before expiration. For more 
information, refer to the Prompting Users to Change Passwords Before Expiration section. 

• The user's password has expired. For more information, refer to the Prompting Users to Change 
Passwords After Expiration section. 

Changing Passwords at Next Logon 

Administrators can require a user to change his or her password by checking the User must change 
password at next logon option in the Windows user configuration setup.   

For Local accounts, you can access these properties by right-clicking My Computer and Selecting Manage. 
The Computer Management window appears. In the System Tools folder, there is a Local Users and Groups 
folder. Locate the user name in this folder, right-click it and select Properties. The General tab displays the 
settings. 

To log on when the "User must change password at next logon" option is enabled: 

1. From your web browser, access the Proficy WebSpace default page 
(http://ProficyWebSpaceServerName/ProficyWebspace/Proficy.html) and select the appropriate 
Proficy WebSpace session. 

http://support.microsoft.com/kb/231289
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2. In the Logon dialog, type the user name and password. If the account does not exist in the domain 
in which the Proficy WebSpace Server resides, include the domain name in the User name field as 
a prefix (for example: domain\username). 

3. Click OK. The following message displays: 

You are required to change your password at first logon. 

4. Click OK. The Change Password dialog box appears. 

5. In the New Password and Confirm New Password fields, enter the new password. 

6. Click OK. 

Prompting Users to Change Passwords Before Expiration 

By default, users are prompted to change their passwords whenever they log on within 14 days of their 
password's scheduled date of expiration. Administrators can modify the change password "prompt" period 
by editing the Prompt user to change password security setting. For example, the Local security settings 
can be viewed and changed by clicking Start, and then pointing to Settings, Control Panel, Administrative 
Tools, and then Local Security Policy. The User Configuration folder contains the Security Settings.   

NOTE: Be aware that if you open a web session and the user name includes a password that is due to 
expire, the Password Expiration dialog box remains in the background and loses focus. As a workaround, 
move the Login dialog box to access the Password Expiration dialog box, and then click Yes and continue. 

To log on during the password change "prompt" period: 

1. From your web browser, access the Proficy WebSpace logon page 
(http://ProficyWebSpaceServerName/ProficyWebspace) and select the appropriate Proficy 
WebSpace session. 

2. In the Logon dialog, type the user name and password. If the account does not exist in the domain 
in which the Proficy WebSpace Server resides, include the domain name in the User name field as 
a prefix (for example: domain\username). 

3. Click OK. The following message displays: 

"Your password will expire in x day(s). Do you want to change your password 
now? Yes/No" 

If you click No, the Proficy WebSpace session starts. If you click Yes, the Change Password dialog 
appears. 

4. If the Change Password dialog box appears, in the New Password and Confirm New Password 
fields, enter the new password and click OK.  

Prompting Users to Change Passwords After Expiration 

To log on after a password has expired: 

1. From your web browser, access the Proficy WebSpace default page 
(http://ProficyWebSpaceServerName/ProficyWebspace/Proficy.html) and select the appropriate 
Proficy WebSpace session.     
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2. In the Logon dialog, type the user name and password. If the account does not exist in the domain 
in which the Proficy WebSpace Server resides, include the domain name in the User name field as 
a prefix (for example: domain\username).    

3. Click OK. The following message displays: 

Your password has expired and must be changed. 

4. Click OK. The Change Password dialog box appears. 

5. In the New Password and Confirm New Password fields, enter the new password. 

6. Click OK. 

Monitoring Server Activity 

The Proficy WebSpace Administration displays information about server activity and processes taking 
place on the Proficy WebSpace Server. Administrators can use this information to determine whether 
additional servers are required and which sessions are no longer being used. 

The following sections provide more information on how to monitor and refresh server activity: 

• Refreshing the Proficy WebSpace Administration 

• Setting the Refresh Rate in the Proficy WebSpace Administration 

• Restarting the Proficy WebSpace Application Publishing Service 

• Viewing Performance Counters 

• Working with Sessions and Processes 

Refreshing the Proficy WebSpace Administration 

You can update the information displayed in the Proficy WebSpace Administration manually or you can set 
it to update automatically. If the Proficy WebSpace Administration is set to update automatically, you can 
still update it manually at any time.    

For information about setting the Proficy WebSpace Administration to update automatically or manually, 
refer to the Setting the Refresh Rate in the Proficy WebSpace Administration section. 

To refresh the Proficy WebSpace Administration: 

1. From the Proficy WebSpace Administration, on the server list, select the desired server. 

2. On the View menu, click Refresh. The data should refresh in the window as you are viewing it. 

Setting the Refresh Rate in the Proficy WebSpace Administration 

You can set the Sessions, Processes, and Applications tabs in the main window of the Proficy WebSpace 
Administration to manually refresh or to automatically refresh at a specified frequency.    
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To set the refresh rate to allow only manual refresh: 

1. From the Proficy WebSpace Administration, on the server list, select the desired server. 

2. On the View menu, click Options. The Options dialog box appears. 

3. Select Manual. 

4. Click OK. 

To set the refresh rate to refresh automatically: 

1. From the Proficy WebSpace Administration, on the server list, select the desired server. 

2. On the View menu, click Options. The Options dialog box appears. 

3. Select the Refresh every _ seconds option. 

4. In the Seconds edit box, type a value. 

5. Click OK. 

Restarting the Proficy WebSpace Application Publishing Service 

There may be times when you need to restart the Proficy WebSpace Application Publishing Service. For 
example, if you change the SCU path on the Applications tab, after you already entered it for the first time, 
you will need to restart this service.    

You can restart the service from the Proficy WebSpace group on the Start menu, or from the Services 
window from the Windows Administrative tools. 

To restart the Proficy WebSpace Application Publishing Service: 

1. On the Start menu, point to Programs, Proficy WebSpace, and then click Stop Proficy WebSpace 
Server. 

2. Wait a few moments for the action to complete. A command window opens briefly and then 
closes. 

3. On the Start menu, point to Programs, Proficy WebSpace, and then click Start Proficy WebSpace 
Server. 

4. Wait a few moments for the action to complete. A command window opens briefly and then 
closes. 

Viewing Performance Counters 

Proficy WebSpace Server performance counters can be added to the Windows Performance Monitor to 
track the number of active sessions and the number of clients connected to a server. Proficy WebSpace 
Server performance counters allow administrators to monitor server activity from any machine with 
network access to a Proficy WebSpace Server. The Remote Registry Service (Regsvc.exe) must be enabled 
for remote performance monitoring to work.     

To add Proficy WebSpace Server performance counters to the Performance Monitor: 

1. On the Start menu, point to Programs, Settings, Control Panel, Administrative Tools, and then click 
Performance. The Performance window appears. 
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2. Click the + button to add counter(s). The Add Counters dialog box appears. 

3. From the Performance Object drop-down list, locate and click Proficy WebSpace Server. 

4. From the Counter list, select the desired counters (Active Sessions, Client Connections, Maximum 
Sessions, Server Connections) and click Add. 

5. Click Close. 

Proficy WebSpace Server Performance Counters 

Proficy WebSpace Server performance counters include: 

Counter Description 

Client Connections The total number of client connections on the Proficy WebSpace Server. 

Server 
Connections 

Not applicable. 

Active Sessions For sessions host on that server, currently running on the computer. 

Maximum 
Sessions 

This displays the Maximum Sessions per user setting in the Host Options dialog, 
on the Session Startup tab. 

 

Working with Sessions and Processes 

The following sections describe how to view session and process information for the Proficy WebSpace 
product: 
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• Viewing Session Information 

• Viewing Process Information 

• Ending Client Processes 

• Reconnecting a Session 

• Shadowing a Session 

• Terminating Sessions 

• Setting the Session Termination Option 

Viewing Session Information 

The Proficy WebSpace Administration displays the following session information:      

Column Displays the... 

Session Name Unique identifier assigned to each session. 

User Network user name of the user accessing the server. 

Connected Clients The number of clients connected to a session. 0 indicates that no one is 
connected to the session (the client has disconnected). 1 indicates that the client 
is connected and the session is active. 2 or higher indicates that the session is 
being shadowed. 

IP Address IP address of the client computer from which the user is accessing the server. 
(Each computer on a network has a unique IP address.) 

Startup Time Date and time the user started the application. 

Applications Number of processes the user is accessing. 

To view session information: 

• Click the Sessions tab. 

NOTE: Click the All Servers icon from the left panel of the Proficy WebSpace Administration to view a list of 
all active sessions on the network. This allows you to view active Proficy WebSpace sessions without 
connecting to individual servers. 
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Viewing Process Information 

A process refers to the specific application that a client is running from the server. The Proficy WebSpace 
Administration displays the following process information:       

Column Displays the... 

Name Name of the application running on the server. 

User Network user name of the user accessing the application. 

Startup Time Date and time the user started the application. 

Process ID Process identification number assigned by the server's operating system. (The 
number for each running application matches the process identification number 
displayed in the Windows Task Manager.) 

To view Proficy WebSpace process information: 

• From the Proficy WebSpace Administration application, in the main window, click the Processes 
tab. 

Ending Client Processes 

Processes are any actions taking place on the Proficy WebSpace Server that are initiated by a client. a 
Proficy WebSpace session, for example, is a process. Each running Proficy WebSpace session is assigned a 
unique name and process ID in the Windows Task Manager. These process names and IDs are duplicated 
in the Proficy WebSpace Administration. Proficy WebSpace administrators can end any process from the 
Proficy WebSpace Administration.             

To end a Proficy WebSpace process: 

1. From the Proficy WebSpace Administration application, in the main window, click the Processes 
tab. 

2. Select the process or processes you want to end. 

3. On the Tools menu, point to Processes, and then click Terminate. 

Reconnecting a Session 

Session reconnect allows sessions to be maintained on a Proficy WebSpace Server without a client 
connection. If the client's connection to the server is lost, intentionally or unintentionally, the user's session 
remains running on the Proficy WebSpace Server for the length of the session time-out specified with the 
Proficy WebSpace Administration. Session reconnect allows users to return to their Proficy WebSpace 
session in the exact state they left it.                  

If the network connection is lost or if users unintentionally disconnect from Proficy WebSpace, their session 
state is preserved for the length of time specified in the Proficy WebSpace Administration. After a user is 
authenticated through normal logon procedures, the Proficy WebSpace Server determines if the user has 
an active session. If so, that session is resumed and appears exactly as it did prior to disconnection. If not, 
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a new session is started. Users are also able to disconnect from one client and reconnect to the session 
from another client. 

When attempting to reconnect to a disconnected session, users are required to specify their logon 
credentials.  After the server validates them, the server reconnects them to the disconnected session. If the 
session is hosted on a server that is part of a Relay Server configuration, the user is routed to his or her 
session without any indication that the session is on a Relay Server. If Integrated Windows authentication 
is available, users are automatically re-authenticated and re-connected to their session.    

Shadowing a Session 

Session shadowing allows multiple users to view and control a single Proficy WebSpace session. Only 
administrators can connect to running Proficy WebSpace sessions, but only with permission from the 
session's user. A shadow session does not consume a license; however, each open browser window (even 
if logged on under the same user name) does consume a license.                 

To shadow a session: 

1. From the Proficy WebSpace Administration application, in the main window, click the Sessions tab. 

2. From the Sessions Name column, select the session(s) you would like to shadow. 

3. On the Tools menu, point to Sessions, and then click Connect. 

-Or- 

From the Sessions Name column, right-click the session you would like to shadow, then click 
Connect. 

Once the session is selected, a message is displayed to the session's user requesting permission to connect 
to the session. If the user clicks Yes, and allows access to his or her session, the connection is made 
immediately and the Proficy WebSpace session opens in a new frame window. 

If the user clicks No and denies access, the following message is displayed on the server: 

The session's owner has denied access to the session. 

Session shadowing will also be denied when the session is disconnected, when the session is in the process 
of shutting down, or when the user fails to respond within one minute. Connection is also denied in the 
event of a Proficy WebSpace communication failure. 

The Sessions tab in the main windows of the Proficy WebSpace Administration displays the number of 
clients connected to a session. Two or more clients in the Connected Clients column indicates that the 
session is being shadowed. Disconnected sessions have 0 connected clients. To disconnect from a session 
and end session shadowing, simply close the frame window where the session is displayed. 

NOTE: When an Proficy WebSpace session is being shadowed, the server's cursor remains on the client 
until that session is closed. It does not go away even when the session is no longer being shadowed. 

Terminating Sessions 

When terminating a user's session, all Proficy WebSpace sessions for that user stop, and the user is logged 
off the Proficy WebSpace Server. 

To terminate a session:                  
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1. From the Proficy WebSpace Administration application, in the main window, click the Sessions tab. 

2. From the Session Name column, select the session(s) you want to terminate. 

3. On the Tools menu, point to Sessions, and then click Terminate. 

NOTES: 
• You can also right-click on the selected session(s) and click Terminate from the shortcut menu. 

• Terminating a session without giving users a chance to close their application can result in the 
loss of data. 

Setting the Session Termination Option 

Administrators control how long Proficy WebSpace sessions remain running on the Proficy WebSpace 
Server through the Proficy WebSpace Administration's Host Options dialog. Select the Immediately option if 
you want the Proficy WebSpace sessions and all running processes to be terminated as soon as the 
session disconnects. Select the After _ minutes option to specify the number of minutes that a session will 
remain running after a client has disconnected from the session. Figure the number of minutes (n) and 
enter (n+1) in the edit field that a session should remain running after the client disconnects. This extra 
minute allows the application to shut itself down gracefully instead of getting terminated immediately. The 
After 1 minute option is the default setting.                   

If you select the After 1 minute option, a shutdown message appears in the event log and the processes 
stop gracefully. With the Immediately option, running processes get terminated without notice, and stop 
immediately. 

The Sessions tab in the main windows of the Proficy WebSpace Administration displays the number of 
clients connected to a session. Disconnected sessions have 0 connected clients. 

To set the session termination option: 

1. From the Proficy WebSpace Administration, on the server list, select the desired server. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Session Shutdown tab. 

4. In the Disconnected sessions terminate area, select one of the following disconnected session 
termination options: 

• Immediately 

• After _ minutes. In the edit box, type the number of minutes plus one that sessions should 
remain running after their clients disconnect. For example, if you want to leave it running 
2 minutes, enter 3 minutes in this edit field. 

5. Click OK. 

Log Files 

The Proficy WebSpace Server creates log files for certain Proficy WebSpace processes. These files are 
stored in the log directory and are used to record program errors and events. With this information, 
Technical Support can diagnose and correct problems that may arise. This can be especially helpful for 
errors that are only reproducible on specific machines or with a specific application. 
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All log files, whether they pertain to the client or server machine, are located on the Proficy WebSpace 
Server. By default, this path is: C:\Program Files\Proficy\Proficy WebSpace\Log. In Log folder are three 
subfolders: Backup, Codes, and Templates. Be careful not to delete these folders. Proficy WebSpace 
messages are recorded within log files prefixed with aps and followed by the date and time (to the nearest 
millisecond) the Proficy WebSpace Application Publishing Service was started (for example: aps_2007-04-
04_09-55-47-636.html). A new log file is created each time the Proficy WebSpace Application Publishing 
Service is started. The log file with the latest date and time stamp contains messages for the current or 
most recent instance of the Proficy WebSpace Application Publishing Service.                        

Problems detected in the execution of Proficy WebSpace are described by entries in the log file. Each entry 
is uniquely identified by an item number along with a date and time stamp, and a description of the event 
or program error. Technical Support uses this information to locate a problem's source and to determine its 
resolution. 

Entries in the log file may also include prefixes for locating messages associated with an individual user's 
session. If the event occurred within the context of a given session, the name of the session will appear at 
the beginning of the message, for example, SuzyG on Server1.  If the message prefix contains the 
connection name aps, the event occurred within the Proficy WebSpace Application Publishing Service, but 
was not associated with a connection to another process. 

For example, for "iexplore (1908) A client at IP address 3.26.60.91 disconnected from session Logon2 on 
Fxbifixoct", 1908 is the ID of the process in which the event took place, 3.26.60.91 is the IP address of the 
Proficy WebSpace session, and Fxbifixoct is the name of the Proficy WebSpace Server. 

Example Use of Log Files 

Say for instance you can not make a connection to the Proficy WebSpace Server when you log on from a 
web session. It could be because you do not have enough physical or virtual memory available to make the 
connection. Set the output log level to 4 on the server, as described in the Setting the Output Level section, 
and try to log on again. If the issue was a memory issue, you would see a message similar to this in the log 
file: 

"A session could not be created for user because only 62,935,040 bytes of physical memory were 
available. The minimum requirement is 134,217,728 bytes." 

Selecting a New Location for the Log Files 

By default, log files are created and stored in the Log folder on the Proficy WebSpace Server machine. By 
default, this folder is:  C:\Program Files\Proficy\Proficy WebSpace\Log. You can select a new location for 
the log files through the Proficy WebSpace Administration's Host Options dialog.                            

Be aware that the Proficy WebSpace Server cannot back up log files directly to a network folder. For 
example, if you type a UNC path or a mapped network drive in the folder edit box, the following message is 
displayed: 

"Please specify a usable Windows folder where log files may be written." 

To select a new location for the Log files: 

1. From the Proficy WebSpace Administration, on the server list, select the desired server. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Log tab. 
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4. In the Folder edit box, type the path to the new directory or browse to its location. 

NOTE: You should move the Backup folder and existing log files to the new location, along with the 
Templates and Codes subfolders. 

Setting the Output Level 

Proficy WebSpace offers six log output levels, as follows:                                  

Level Description 

0 No output 

1 Errors 

2 Errors and Events (Default Setting) 

3 Errors, Events and Warnings 

4 Errors, Events, Warnings, and Diagnostic Messages 

5, 6 Errors, Events, Warnings, Diagnostic Messages, and Trace Messages 

To set the output level: 

1. From the Proficy WebSpace Administration, on the server list, select the desired server. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click Log tab. 

4. In the Output level edit box, enter one of the above numeric values. 

IMPORTANT: 

• Setting the log output value to 5 or 6 may adversely affect Proficy WebSpace 
performance. These output levels yield very large files, and should only be used in a 
controlled environment – preferably when only one client is accessing the Proficy 
WebSpace Server. The default value for the Output level is 2. 

• Changes to the Output Level are applied to Proficy WebSpace sessions that are started 
after the change. 

Selecting a New Location for the Log Files 

Maintaining Log Files 

The Proficy WebSpace creates a new log file every time the Proficy WebSpace Application Publishing 
Service starts. Over time these files can accumulate and consume a significant amount of disk space. To 
help manage these files, the Proficy WebSpace lets you delete or backup log files and set file size or age 
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limits. By default, the logs are stored in this folder on the Proficy WebSpace Server: C:\Program 
Files\Proficy\Proficy WebSpace\Log.                        

To delete log files: 

1. From the Proficy WebSpace Administration, on the server list, select the desired server. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Log tab. 

4. In the Maintenance area, from the drop-down list, select Delete. 

5. In the Files more than _ days old field, specify how old (in days) log files can become before being 
deleted. 

6. In the _ MBs in size field, specify at what size (in megabytes) log files are to be deleted. 

7. Click OK. 

8. Restart the Proficy WebSpace Application Publishing Service. 

To backup log files: 

1. From the Proficy WebSpace Administration, on the server list, select the desired server. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Log tab. 

4. In the Maintenance area, from the drop-down list, select Back Up. 

5. In the Files more than _ days old field, specify how old (in days) log files can become before being 
moved to the Backup subdirectory of the Log folder. 

6. In the _ MBs in size field, specify at what size (in megabytes) log files are to be moved to the 
Backup subdirectory of the Log folder. 

7. Click OK. 

8. Restart the Proficy WebSpace Application Publishing Service. 

Once every half hour, and each time it is started, the Proficy WebSpace Application Publishing Service 
searches the Log folder for files that have not been modified for more than the specified number of days. It 
then either deletes the files or moves them to the Backup subdirectory of the Log folder. If while sweeping 
the log files, the Proficy WebSpace Application Publishing Service finds that nothing that the age or size 
limit has been met in the current log file, it closes the file and installs a newly created file in its place.   

By default, inactive log files are backed up after 7 days or when the file size has reached 20 MB. 

Configuring Optional Web Session Properties 
There are other optional settings that you can configure for your Proficy WebSpace session through the 
Proficy WebSpace Administration. These include the following items: 

• Clipboard Access 
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• Sounds 

• Drive Access 

• Hidden Drives 

• File Usage Restrictions 

• Client Drive Remapping 

• Port Access 

• Client Printing 

• Network Printing 

• Client Time Zone Redirection 

Refer to each section for more information. All of these settings can be configured from the Client Access 
and General tabs of the Host Options dialog box in the Proficy WebSpace Administration application, as 
shown in the following figures. 
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Clipboard Access 

You can cut and copy information from a Proficy WebSpace session and paste it into applications running 
on a Proficy WebSpace Server, and vice versa. Clipboard support is disabled by default.               

To enable clipboard support: 

1. In the Proficy WebSpace Administration, select the desired server from the list of All Servers. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Client Access tab.   

4. Click the Clipboard check box. 

5. Click OK. 

Any clipboard data from the browser session is available only within the WorkSpace application. In order to 
copy the contents to other applications on the local disk of the client machine you must create a shell 
script within an object inside your WorkSpace picture that launches Notepad.exe, on the Proficy WebSpace 
Server. After you do this, you can use this object to launch Notepad in run mode from the web session. 
Paste the contents into Notepad, and save this file to the local disk of web session computer. 

Sounds 

The Proficy WebSpace supports sound capability for any application that uses PlaySound, sndPlaySound, 
or waveOut. It is not required that sound cards and/or speakers be installed on Proficy WebSpace Servers. 
The client machine, however, does require a sound card, speakers, and that it's Media Feature (Windows 7 
/ Windows 8) or Desktop Experience Feature (Windows Server 2008 / Windows Server 2012) be enabled.. 
Audio support is disabled by default on the Proficy WebSpace sessions.                   

IMPORTANT: Be aware that client sound capability requires the loading of Proficy WebSpace libraries into 
session processes. This can affect the startup of a process, make some processes incompatible with 
Proficy WebSpace, or have fatal consequences during suspend/resume operations. Use caution when 
enabling this setting. 

To enable support for client sound: 

1. In the Proficy WebSpace Administration, select the desired server from the list of All Servers. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Client Access tab.   

4. Click the Sound check box. 

5. Click OK. 

Drive Access 

The Proficy WebSpace allows users to access files stored on the client computer, and to save files locally. 
Client drives will be listed in the application's Open and Save as dialog boxes, and are designated with a 
Client prefix. For example: Client C (K:), Client D (L:).                        
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The dialog boxes list both client and server drives. In order for clients to open or save files locally, the client 
drives feature must be enabled on the Proficy WebSpace Server. Support for client drives is disabled by 
default. 

Proficy WebSpace allows users to access USB drives. Removable drives such a floppy disks, CD ROMs, and 
DVD-ROMs are not supported as client drives. 

To enable support for client drives: 

1. In the Proficy WebSpace Administration, select the desired server from the list of All Servers. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Client Access tab.   

4. Select the Drives check box. 

5. Click OK. 

Hidden Drives 

Hiding Client Drives 

Through the Proficy WebSpace Administration, administrators can hide drives on the client machine where 
the Proficy WebSpace session runs, such as the operating system drive, floppy drive, and CD ROM drive. 
Hidden drives are inaccessible to the user through the Proficy WebSpace session.                            

To hide one or more client drives: 

1. From the Proficy WebSpace Administration, on the server list, select the desired server. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Client Access tab. 

4. Select the Drives check box. 

5. In the Hide field, enter the client drive letters you want to hide. 

NOTE: All client drives are mapped by default. Drives listed in the Hide box can be listed in any 
order. To hide server drives, see Hiding Server Drives.  

6. Click OK. 

The following figure shows an example of hidden H, J, and K drives, along with drives P through S. 
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Hiding Server Drives 

Microsoft's Group Policy Objects lets you hide specific host drives. For instructions, see 
http://support.microsoft.com/kb/231289. To hide host drives, the Apply Group Policy option must be 
enabled in the Host Options dialog box in the Proficy WebSpace Administration application. 

File Usage Restrictions 

As the system administrator, you may need to restrict user access to certain files and resources from the 
Proficy WebSpace sessions. Keep in mind that there are multiple users accessing the server.                 

Particularly in a Relay Server environment, it is recommended to write-protect your system and application 
folders so that users are unable to save files on a Proficy WebSpace Server. Otherwise, the next time a user 
logs on to Proficy WebSpace and is routed to a different server, the files and folders will be inaccessible. 

You must use Windows Explorer to set the permissions for files on the server, in an individual file-by-file or 
folder-by-folder basis. By setting file permissions, you can restrict user access to applications, printers, and 
folders. File permissions can only be set on drives formatted with the Windows NT file system (NTFS). If you 
are using the FAT file system, you will be unable to set permissions for specific files or restrict access to 
applications. 

Once an application's permissions have been set, you can assign specific parameters for the application 
with the Proficy WebSpace Administration. 

http://support.microsoft.com/kb/231289
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Client Drive Remapping 

With the Client Drives feature enabled, the Proficy WebSpace must ensure there is a one-to-one mapping 
between drive letters and the drives of the client and server computers. If a drive on the client and a drive 
on the server are assigned the same drive letter, the Proficy WebSpace must assign a new drive letter to 
one of the drives. Client drives can be remapped by either listing them sequentially starting at a given drive 
letter or incrementing their drive letters by a specified value. 

To list client drives sequentially starting at a given drive letter: 

1. From the Proficy WebSpace Administration, on the server list, select the desired server. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Client Access tab. 

4. Select the Drives check box. 

5. Select the Assign consecutive letters starting at: _ option. 

6. In the drop-down list next to the field, select the drive letter that should start the sequence. 

7. Click OK. 

To increment client drive letters by a fixed value: 

1. From the Proficy WebSpace Administration, on the server list, select the desired server. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Client Access tab. 

4. Select the Drives check box. 

5. Select the Increment by: _ option. 

6. In the edit field, type a number greater than or equal to 1 that will yield the desired offset. 

7. Click OK. 

Example 1 

For example, if a client computer has A, C, D, and H drives, and the starting point is set to drive letter M, the 
client's drives will be remapped respectively to M, N, O, and P. If a drive letter is already assigned to a drive, 
the next available letter is used. This feature is disabled by default. Once enabled, the default drive letter is 
M. 
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Example 2 

For this example, if the client computer has the same drives as above (A, C, D, and H), and the offset is 12, 
each of the client's drives will be incremented by 12 letters. The drives will be remapped respectively to M, 
O, P, and T. The default value for this setting is 12. 
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Port Access 

Server-based applications can access modems, handhelds, and other devices that are connected to the 
serial and parallel ports of the client computer. This feature uses the client file protocol to transfer data 
between the client device and the Proficy WebSpace Server. Client port access is enabled when the Serial 
and Parallel Ports option in the Host Options dialog is enabled. Serial and parallel port access is disabled by 
default.                         

IMPORTANT: Be aware that Client Serial and Parallel Ports requires the loading of Proficy WebSpace 
libraries into session processes. This can affect the startup of a process, make some processes 
incompatible with Proficy WebSpace, or have fatal consequences during suspend/resume operations. Use 
caution when enabling this setting.  A message box appears and asks for confirmation when Serial and 
Parallel Ports is checked. 

To enable client port access: 

1. In the Proficy WebSpace Administration, select the desired server from the list of All Servers. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Client Access tab. 

4. Select the Serial and Parallel Ports check box. A message box appears. 

5. Click Yes to continue. 

6. Click OK to save your settings and close the Host Options dialog box. 

Client Printing 

Client printing is disabled by default. Administrators enable client-side printing through the Client Access 
tab on the Proficy WebSpace Administration's Host Options dialog.   

By default, the Proficy WebSpace automatically detects the client's default printer information after the 
user logs in the Proficy WebSpace Server. This includes the default printer's port and printer driver. If the 
printer driver is not installed on the Proficy WebSpace Server, the Proficy WebSpace will attempt to locate 
the driver and automatically install it.                   

Client printers are temporarily installed on the Proficy WebSpace Server for the duration of the client's 
session. Printer drivers are installed permanently. Administrators can view the list of printers and drivers in 
the Printers folder on the Proficy WebSpace Server. 

NOTES: 

• The Print Spooler Service must be running on the Proficy WebSpace Server in order to configure 
client printers. 

• If a printer is physically connected to the Proficy WebSpace Server, and you want to allow printing 
from the web sessions to this printer, no additional configuration changes need to be made on the 
Proficy WebSpace Server or Web Session. 

• If the printer on the Proficy WebSpace Server is a network printer, and you want to allow printing 
on the web sessions to this printer, you must add the network printer to the Proficy Web Server. As 
the administrator, you can set up network printers for use by Proficy WebSpace sessions. You 
must first create a port on the Proficy WebSpace Server that connects directly to the server and 
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then install the printer locally. This provides direct access to the printer. If you want to allow 
network printing from the Proficy WebSpace Server within the web sessions, refer to the Network 
Printing and Setting up a Network Printer sections. 

Printer Driver Access 

Proficy WebSpace can obtain printer drivers from the following sources: 

Source Description 

Universal 
Printer Driver 

Enables the use of the Universal Printer Driver that can print to any client printer. 
When only the Universal Printer Driver is enabled, only the Universal Printer Driver 
will be used as a printer driver. No native drivers will be used. This is the default 
setting. 

The Universal Printer Driver uses a standard printing properties dialog box and may 
not offer some of the more advanced printing options other drivers do. 

The Universal Printer Driver can be used when the native driver is not available. 

When neither the Universal Printer Driver or Windows Printer Drivers is enabled, no 
printers will be configured and client printing is disabled. 

NOTE: A printer named Preview PDF is configured in each session when the 
Universal Printer Driver is enabled. Documents printed to this printer are 
automatically converted to a .pdf file and displayed on the client computer. Users 
can save, print, or email the document at their discretion. A PDF reader, such as 
Adobe® Reader, is required on the client computer in order to use the Universal 
Printer Driver's PDF conversion feature. 
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Source Description 

Windows 
Printer Driver 

Enables printers to be configured using already installed native drivers. When only 
the Windows Printer Drivers option is enabled, only native printer drivers that are 
installed on the Proficy WebSpace Server will be used. If a printer's native driver is 
not installed, that printer will not be configured. 

To allow the Proficy WebSpace to automatically install native printer drivers that 
ship with Microsoft Windows click the Automatically install drivers. 

The Windows Printer Driver option is preferred when configuring proxy printers, if 
they are available and if settings allow them to be used. 

Native drivers are selected in the following order: 

1. Printers Applet:  A user's manual selection of a printer driver in the 
Printers window takes precedence over all other driver selection 
methods. The Printers Applet is accessible via the Program Window 
which is the first window of the Windows Desktop Client. 

2. Mapped Printer Drivers:  MappedPrinterDrivers.xml contains a list of 
driver names that can be used for each driver. This file is generated by 
the Application Publishing Service, but can also be manually edited by 
administrators. For most Proficy WebSpace deployments, 
administrators will not need to edit this file. It is used to specify which 
driver to use when a host's driver name does not identically match the 
client's, or when the administrator wants to override native drivers and 
force clients to use a different printer driver or the Universal Printer 
Driver. The MappedPrinterDrivers.xml file is usually found in the 
C:\ProgramData\Proficy or C:\Documents and Settings\All 
Users\Application Data\Proficy folder. 

3. Client driver name: The driver with the exact name of the driver that is 
installed on the client is used to configure the proxy printer. 

IMPORTANT: If the Windows Printer Drivers option is disabled in the Proficy 
WebSpace Administration tool, this hierarchy is not applied. 

When both the Universal Printer Driver and the Windows Printer Drivers are 
enabled, and a printer's native driver is installed on the Proficy WebSpace Server, 
the printer's native driver will be used to configure the printer. If it is not installed on 
the Proficy WebSpace Server, the printer is configured to use the Universal Printer 
Driver. 

When Windows Printer Drivers and Automatically install drivers are enabled, only 
native printer drivers that are installed on the Proficy WebSpace Server or those 
that are included with Windows will be used. If a printer's native driver is not 
installed and it is not included with Windows, that printer will not be configured. 

When neither the Windows Printer Drivers or Universal Printer Driver is enabled, no 
printers will be configured and client printing is disabled. 
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To designate access to printer drivers: 

1. In the Proficy WebSpace Administration, select the desired server from the list of All Servers. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Client Access tab.   

4. Select the check box next to the desired printer source: Universal Printer Driver or Windows Printer 
Driver. 
NOTE: The Universal Printer Driver uses a standard printing properties dialog and may not offer 
some of the more advanced printing options other drivers do. 

5. If you select the Windows Printer Driver and you want to allow for automatic installs of native 
drivers that ship with Windows, also select the Automatically Install Drivers check box. 

6. Click OK. 

To disable client printing: 

1. In the Proficy WebSpace Administration, select the desired server from the list of All Servers. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Client Access tab.   

4. Clear the check boxes next to both the Universal Printer Driver and Windows Printer Driver fields. 

5. Click OK. 

NOTE: Client printers are temporarily installed on the Proficy WebSpace Server for the duration of the 
client's session. Printer drivers are installed permanently. Administrators can view the list of printers and 
drivers in the Printers folder on the Proficy WebSpace Server. If you start two or more web sessions, at the 
same time, with different user accounts from the same client system, client printers will only be available to 
the first session. 

Network Printing 

If the printer on the Proficy WebSpace Server is a network printer, and you want to allow printing from the 
web sessions to this printer, you must add the network printer to the Proficy WebSpace Server. First create 
a port on the Proficy WebSpace Server that connects directly to the server, and then install the printer 
locally. For steps, refer to the Setting up a Network Printer section.                    

If a printer is physically connected to the Proficy WebSpace Server, and you want to allow printing from the 
web sessions to this printer, no additional configuration changes need to be made. 

NOTE: If you want to allow printing in web sessions from client printers, refer to the Client Printing section 
for information on how to configure. 

Client Time Zone Redirection 

By default, all Proficy WebSpace sessions are run in the time zone of the Proficy WebSpace Server 
machine. Administrators can opt to run Proficy WebSpace sessions in the time zone of the client computer 
by enabling the Use client's time zone option from the Proficy WebSpace Administration. With the Use 
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client's time zone option selected, timestamps and associated data viewed from Proficy WebSpace 
sessions appear in the client's time zone instead of the Proficy WebSpace Server's time zone.                     

For example, alarms, charts (Standard and Enhanced), Historical Trend Display, Current Date Stamp, 
Current Time Stamp, and the Historical Datalink will show time stamps and data based on the web client's 
time zone if the "Use client's time zone" is selected. Otherwise, the time zone of the Proficy WebSpace 
Server is reflected in the time stamps and data being displayed. 

The Client Time Zone feature is configured from the Proficy WebSpace Administration's Host Options 
dialog, as shown in the following figure. 

 

IMPORTANT: Be aware that when you select the Client Time Zone check box that these settings also affect 
data retrieved by any VisiconX queries in your pictures. 

To enable client time zone redirection: 

1. From the Proficy WebSpace Administration, from the Server tree, select the server name you want 
to configure. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the General tab. 

4. Select the "Use client's time zone" check box. 

5. Click OK. 

Deploying and Running Proficy WebSpace 
Sessions 
Proficy WebSpace allows you to open iFIX, CIMPLICITY, or Plant Applications pictures in run mode from a 
web session. Users can connect to a Proficy WebSpace Server from any computer that supports a Proficy 
WebSpace session. The following clients are currently supported: 

• Microsoft Internet Explorer Client 

• Mozilla Firefox Client 

• Google Chrome Client (Loose Mode only) 

• Microsoft Windows Desktop Client 
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Overview of All Clients 

The AllClients.html page on the Proficy WebSpace Server describes all supported clients. From here, you 
can also install the client. By default, this file is located on the Proficy WebSpace Server computer in the 
folder where you publish the files to be hosted by your IIS or Apache server. 

The following clients are currently supported: 

• Microsoft Internet Explorer Client 

• Mozilla Firefox Client 

• Google Chrome Client Loose Mode only 
NOTE: Proficy WebSpace does not support Google Chrome when running Proficy Vision. 

• Microsoft Windows Desktop Client 

For information on client version numbers, refer to the System Requirements tab in the IPI. 

AllClients.html 

To start the Proficy WebSpace using the AllClients.html page, enter the following address in your web 
browser: 

http://ProficyWebSpaceServerName/ProficyWebSpace/AllClients.html 

Illustration of AllClients.html 

The following figure illustrates the options on the AllClients.html web page and the clients that you can 
install. 
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Microsoft Internet Explorer Client 

The Proficy WebSpace ActiveX Control is available to Windows users running Internet Explorer. The ActiveX 
control is automatically installed the first time a user accesses the Proficy WebSpace HTML page in 
Internet Explorer.                    

Loose vs. Embedded Mode 

There are two modes in which you can run the Internet Explorer client: Loose and Embedded mode. Loose 
mode displays the WorkSpace in an application window (providing you with more screen real estate), while 
the Embedded mode displays the WorkSpace directly in an Internet Explorer window (in a single window). 

Embedded mode is the default setting. You can change this setting using a command line option, however. 
You can also launch in either loose or embedded mode using the AllClients.html web page, and selecting 
the Microsoft ActiveX: Loose or Embedded option. 

Loose Mode 

NOTE: In loose mode, the browser window will automatically close if there are no other tabs open in the 
browser. 
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Embedded Mode 

 

Installing the Client 

NOTE: If your Internet Explorer web browser is not configured to allow active scripting, you must enable it 
to start  a Proficy WebSpace session via the ActiveX add-on. (Refer to the section, To enable Internet 
Explorer Active Scripting settings for instructions.) 

The ActiveX control is automatically installed the first time a user accesses the Proficy WebSpace HTML 
page in Internet Explorer. By default this web page is: 
http://ProficyWebSpaceServerName/ProficyWebSpace, where ProficyWebSpaceServerName is the 
computer name or IP address of your Proficy WebSpace Server. The default page that opens is: 
http://ProficyWebSpaceServerName/proficywebspace/proficy.html?embed=true. 

You also can browse to the http://ProficyWebSpaceServerName/ProficyWebSpace/AllClients.html page to 
install and run this ActiveX control. The AllClients.html page allows you to specify Loose or Embedded mode 
when running. 

Additionally, you can install this ActiveX control with the proficy-client.windows.exe installer provided in any 
of these locations: 

• The DVD in the WebSpaceServer subfolder. 

• The Proficy WebSpace install folder, which is by default the C:\Program Files\Proficy\Proficy 
WebSpace\Web\Clients folder. 

• The Proficy WebSpace Server computer in the folder where you publish the Proficy WebSpace files 
to be hosted by your IIS or Apache server. 

To enable Internet Explorer Active Scripting settings: 

1. Open Internet Explorer.   

2. Click the Tools menu, and then click Internet Options. 

3. On the Security tab, click the Custom level button. 
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4. Scroll down the Security Settings list until you see Scripting > Active scripting. 

 

5. Click Enable. 

6. Click OK, and then click OK again. 

Updating the Client 

When users running the ActiveX Control connect to a Proficy WebSpace Server with an updated client for 
the same version, the ActiveX Control will update automatically when the user browses to the Proficy 
WebSpace page. 

Running the Client 

The Proficy WebSpace ActiveX control is automatically installed the first time a user accesses the Proficy 
WebSpace HTML page. To run the client, all you need to do is access the Proficy WebSpace Server HTML 
page. 

NOTE: If you want to change the options available when you run the Proficy WebSpace Embedded ActiveX 
control, refer to the Command-line Options section below. 

To run the iFIX WebSpace ActiveX control: 

1. Start Internet Explorer. 

2. In the URL box, type http:// followed by the Proficy WebSpace Server computer name (or IP 
address) and then /ProficyWebSpace. For example: 

http://ProficyWebSpaceServerName/ProficyWebspace 

An installation message box appears the first time you log on to this page. 

3. Click Install. Trust the digitally signed ActiveX control.   

4. When the Logon dialog appears, type the following information: 

• Your network user name in the User name field. 
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• Your network password in the Password field. 

NOTE: Users are allowed three invalid logon attempts before the logon process shuts down. 

Uninstalling the Client 

• To uninstall the Proficy WebSpace ActiveX control, remove the Proficy WebSpace Class for the 
ActiveX control, and clear the browser cache. 

To uninstall the Proficy WebSpace ActiveX control: 

1. Close Internet Explorer. 

2. Locate the Proficy WebSpace Class in WinNT or Windows\Downloaded Program files. 

3. Right-click the file and click Remove. 

To clear the browser cache: 

1. Open Internet Explorer. 

2. On the Tools menu, click Internet Options. The Internet Options dialog box appears. 

3. On the General tab, in the Temporary Internet Files area, click Delete Files. A message box 
appears. 

4. Click OK to continue. 

If you are still having difficulty, consult an administrator to check the Downloaded Program Files folder for 
Proficy WebSpace related files. 

To check the Downloaded Program Files folder: 

1. Open a Command Prompt window. 

2. Type the location of the Downloaded Program Files folder and check for any Proficy WebSpace 
related files. If any exist, delete them. 

3. Close the Command Prompt window. 

Command-line Information and Guidelines 

Optionally, you can use command-line settings to override the defaults of your Proficy WebSpace session 
on open. You can do this by either: 

• Directly entering the commands following the web address when you type it into the Address bar 
of Internet Explorer, or from the hyperlink command you refer to on a custom web page. For 
example, the address plus command-options could read like this: 

• For iFIX: 
http://ProficyWebSpaceServerName/ProficyWebSpace/iFIX.html?embed=false&bInBrowse
r=false 

• For Plant Applications: 
http://ProficyWebSpaceServerName/ProficyWebSpace/PlantApplications.html?embed=fal
se&bInBrowser=false 
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• For CIMPLICITY, specify the command-line parameters in the .HTML file.  For details, refer 
to the CIMPLICITY HTML File Overview section. 

-Or- 

Changing the default settings for every user, by editing the Logon call in the index.html 
and index.htm files on the Proficy WebSpace Server in the directory where you publish the 
Proficy WebSpace files to be hosted by your IIS or Apache server. For example, you would 
modify the window.location.href = "proficy.html?embed=true"; line in the index.html and 
index.htm files with the settings you want to change. For instance, you might want to 
change that line to allow for loose mode, instead of embedded mode: 
window.location.href = "proficy.html?embed=false". 

Be aware of the following when working with command-line options: 

• Command-line passing of variables to CIMPLICITY is supported through the .HTML file.  For details, 
refer to the CIMPLICITY HTML File Overview section. 

• Parameters are optional and case-sensitive. They can be appended in any order. 

• Command-line options that are also configurable in the Administration tool, override the default 
settings in the Proficy WebSpace Administration tool. 

• Before the first command-line option, and after the .html reference, add a ? symbol. For example: 
iFIX.html?embed=false; PlantApplications.htm?embed=false. 

• After the first command, each additional command that you add should be appended with the & 
symbol before the additional command. For example: embed=false&bInBrowser=false. 

• Spaces within parameters must be replaced with the %20 symbol. 

To edit the Index.html and Index.htm page to change the command-line options for the default 
login page (for all Proficy products - iFIX, CIMPLICITY, and Plant Applications): 

1. Access the Proficy WebSpace Server computer, and locate the he folder where you publish the 
Proficy WebSpace files to be hosted by your IIS or Apache server. 

2. Open the index.html or index.htm page in a text editor, such as Notepad. 

3. Scroll to the following line: 

window.location.href = "proficy.html?embed=true"; 

4. Add or change the command line options. Refer to the Summary of Command-line Options for a 
full list of available options. For example, to enable loose mode instead of embedded mode, enter: 

window.location.href = "proficy.html?embed=false"; 

5. Save the file. 

To use a custom hyperlink command to open a web page (for all Proficy products - iFIX, 
CIMPLICITY, and Plant Applications): 

1. Open a web page in an editor. 

2. Choose the editor's Insert Hyperlink option. 
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3. Enter the address of the host, followed by the desired hyperlink parameters. Refer to the Summary 
of Command-line Options for a full list of available options. For example, to enable loose mode 
instead of embedded mode, enter: 

http://ProficyWebSpaceServerName/ProficyWebSpace/proficy.html?embed=false 

4. Save the page. 

Summary of Command-line Options 

The following table describes the available command-line options for the Proficy WebSpace startup in 
Internet Explorer. 

Option Description 

user=user_name The name of the user's account. 

password=actual_password The user's password. 

port=port_number The port on which the Proficy WebSpace Server accepts 
connections. By default, this port number is 491. 

autoclose=true|false This setting describes whether the browser window closes if 
you close the WorkSpace window within your Proficy 
WebSpace session. 

When autoclose=true, closing the program window closes the 
associated browser window and ends the user's Proficy 
WebSpace session. When autoclose=false, closing the program 
window ends the user's Proficy WebSpace session, but does not 
close the browser window. By default, autoclose=false. 

embed=true|false This setting describes whether your web session runs in Loose 
mode or Embedded mode. When embed=true, Proficy 
WebSpace sessions run within the browser window (in 
Embedded mode). When embed=false, applications run outside 
the browser window (in Loose mode). By default, embed=true. 

NOTE: Do not use Embedded mode with FIX Desktop View. Use 
Loose mode with Internet Explorer in this case, or use the Microsoft 
Windows Desktop Client for the Proficy WebSpace. 
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Option Description 

bInBrowser=true|false This setting describes whether the Proficy WebSpace session 
will disconnect when a user closes the loose browser window, 
or browses to another page. 

The bInBrowser setting only applies to loose mode. In this 
mode, when bInBrowser=true, users will be disconnected from 
their Proficy WebSpace sessions when they close the browser 
or browse to another page. In these cases, the session will 
terminate on the server, based on the Proficy WebSpace 
Server's time-out settings for disconnected sessions. When 
bInBrowser=false, the Proficy WebSpace will run in a separate 
process and users will not be disconnected from their sessions 
when they close the browser or browse to another page. By 
default, bInBrowser=true. 

Mozilla Firefox Client 

The Proficy WebSpace Plug-in allows you to connect to a Proficy WebSpace Server using Mozilla Firefox. To 
connect to a Proficy WebSpace Server, browse to the Proficy WebSpace HTML page. If the plug-in is 
already installed on the client machine, it is automatically loaded and run by the browser. Otherwise, 
Mozilla Firefox prompts you to download the plug-in and install it on the desktop computer.                

NOTE: For upgrading Mozilla Firefox on the Dell Wyse T50 ARM Thin Client, refer to the Use the Dell Wyse 
T50 ARM Thin Client section. 

Loose vs. Embedded Mode 

There are two modes in which you can run the Mozilla Firefox client: Loose and Embedded mode. Loose 
mode displays the WorkSpace in an application window (providing you with more screen real estate), while 
the Embedded mode displays the WorkSpace directly in a Mozilla Firefox window (in a single window). 

Embedded mode is the default setting. You can change this setting using a command line option, however. 
You can also launch in either loose or embedded mode using the AllClients.html web page, and selecting 
the Plug-in: Loose or Embedded option. 

Loose Mode 

NOTE: In loose mode, the browser window will automatically close if there are no other tabs open in the 
browser. 
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Embedded Mode 

 

Installing the Client 

If the plug-in is already installed on the client machine, it is automatically loaded and run by the browser. 
Otherwise, you are prompted to download the plug-in and install it on the desktop computer the first time 
you browse to this web page: http://ProficyWebSpaceServerName/ProficyWebSpace, where 
ProficyWebSpaceServerName is the computer name or IP address of your Proficy WebSpace Server. The 
default page that opens is: 
http://ProficyWebSpaceServerName/proficywebspace/proficy.html?embed=true. 

You also can browse to the http://ProficyWebSpaceServerName/ProficyWebSpace/AllClients.html page to 
install and run this plug-in control. The AllClients.html page allows you to specify Loose or Embedded mode 
when running. 

Additionally, you can install this plug-in with the proficy-client.windows.exe installer provided in any of 
these locations: 
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• The DVD in the WebSpaceServer subfolder. 

• The Proficy WebSpace install folder, which is by default the C:\Program Files\Proficy\Proficy 
WebSpace\Web\Clients folder. 

• The Proficy WebSpace Server computer in the folder where you publish the Proficy WebSpace files 
to be hosted by your IIS or Apache server. 

Updating the Client 

Users who have installed the plug-in with Mozilla Firefox can update the plug-in via Firefox's Add-on 
manager. If you are unable to do that, you can also manually uninstall and then reinstall the plug-in. 

NOTE: The Firefox Plug-in update feature does not work if you install the Windows Desktop Client installer 
(proficy-client.windows.exe). It only works when the web client has been installed via the web browser 
page. 

To update the FireFox Plug-in with the Add-on Manager: 

1. In Firefox, on the Tools menu, select Add-ons. 

2. Click the Find Updates button. 

3. Install the update. 

Running the Client 

The Proficy WebSpace Plug-in is automatically installed the first time a user accesses an HTML page 
containing the plug-in. To run the client, all you need to do is access the Proficy WebSpace Server HTML 
page. 

NOTE: If you want to change the options available when you run the Proficy WebSpace plug-in, refer to the 
Command-line Options section below. 

To run the Proficy WebSpace Plug-in: 

1. Start Mozilla Firefox. 

2. In the URL box, type http:// followed by the Proficy WebSpace Server computer name (or IP 
address) and then /ProficyWebSpace. For example: 

http://ProficyWebSpaceServerName/ProficyWebspace 

3. Select the appropriate plug-in link from the list. 

4. When the Logon dialog appears, type the following information: 

• Your network user name in the User name field. 

• Your network password in the Password field. 

NOTE: Users are allowed three invalid logon attempts before the logon process shuts down. 

Uninstalling the Client 

• To uninstall the Proficy WebSpace Plug-in, uninstall the plug-in and then clear the 
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browser cache. 

To uninstall the Proficy WebSpace Plug-in: 

1. Open Firefox. 

2. On the Tools menu, click Add-ons. The Add-ons dialog box appears. 

3. Click the Extensions tab and select the Proficy WebSpace Plug-in. 

4. Click the Uninstall (or Remove) button. 

5. Restart Firefox. 

To clear the browser cache: 

1. Open Mozilla Firefox. 

2. On the Tools menu, click Options. The Options dialog box appears. 

3. Click Advanced. 

4. Click the Network tab. 

5. In the Cache area, click Clear Now. 

If you are still having difficulty, consult an administrator to check the Downloaded Program Files folder for 
Proficy WebSpace related files. 

To check the Downloaded Program Files folder: 

1. Open a Command Prompt window. 

2. Type the location of the Downloaded Program Files folder and check for any Proficy WebSpace 
related files. If any exist, delete them. 

3. Close the Command Prompt window. 

Command-line Information and Guidelines 

Optionally, you can use command-line settings to override the defaults of your Proficy WebSpace session 
on open. You can do this by either: 

• Directly entering the commands following the web address when you type it into the Address bar 
of Mozilla Firefox, or from the hyperlink command you refer to on a custom web page. For 
example, the address plus command-options could read like this: 

• For iFIX: 
http://ProficyWebSpaceServerName/ProficyWebSpace/iFIX.html?embed=false&bInBrowse
r=false 

• For Plant Applications: 
http://ProficyWebSpaceServerName/ProficyWebSpace/PlantApplications.html?embed=fal
se&bInBrowser=false 

• For CIMPLICITY, specify the command-line parameters in the .HTML file.  For details, refer 
to the CIMPLICITY HTML File Overview section. 

 -Or- 
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Changing the default settings for every user, by editing the Logon call in the index.html and 
index.htm files on the Proficy WebSpace Server in the directory where you publish the Proficy 
WebSpace files to be hosted by your IIS or Apache server. For example, you would modify the 
window.location.href = "proficy.html?embed=true"; line in the index.html and index.htm files 
with the settings you want to change. For instance, you might want to change that line to 
allow for loose mode, instead of embedded mode, like this: window.location.href = 
"proficy.html?embed=false"; 

Be aware of the following when working with command-line options: 

• Command-line passing of variables to CIMPLICITY is supported through the .HTML file.  For details, 
refer to the CIMPLICITY HTML File Overview section. 

• Parameters are optional and case-sensitive. They can be appended in any order. 

• Command-line options that are also configurable in the Administration tool, override the default 
settings in the Proficy WebSpace Administration tool. 

• Before the first command-line option, and after the proficy.html reference, add a ? symbol. For 
example: proficy.html?embed=false. 

• After the first command, each additional command that you add should be appended with the & 
symbol before the additional command. For example: embed=false&bInBrowser=false. 

• Spaces within parameters must be replaced with the %20 symbol. 

To edit the Index.html and Index.htm page to change the command-line options for the default 
login page: 

1. Access the Proficy WebSpace Server computer, and locate the he folder where you publish the 
Proficy WebSpace files to be hosted by your IIS or Apache server. 

2. Open the index.html or index.htm page in a text editor, such as Notepad. 

3. Scroll to the following line: 

window.location.href = "proficy.html?embed=true"; 

4. Add or change the command line options. Refer to the Summary of Command-line Options for a 
full list of available options. For example, to enable loose mode instead of embedded mode, enter: 

window.location.href = "proficy.html?embed=false"; 

5. Save the file. 

To use a custom hyperlink command to open a web page: 

1. Open a web page in an editor. 

2. Choose the editor's Insert Hyperlink option. 

3. Enter the address of the host, followed by the desired hyperlink parameters. Refer to the Summary 
of Command-line Options for a full list of available options. For example, to enable loose mode 
instead of embedded mode, enter: 

http://ProficyWebSpaceServerName/ProficyWebSpace/proficy.html?embed=false 

4. Save the page. 
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Summary of Command-line Options 

The following table describes the available command-line options for the Proficy WebSpace startup in 
Mozilla Firefox. 

Option Description 

user=user_name The name of the user's account. 

password=actual_password The user's password. 

port=port_number The port on which the Proficy WebSpace Server accepts 
connections. By default, this port number is 491. 

autoclose=true|false This setting describes whether the browser window closes if 
you close the WorkSpace window within your Proficy 
WebSpace session. 

When autoclose=true, closing the program window closes the 
associated browser window and ends the user's Proficy 
WebSpace session. When autoclose=false, closing the program 
window ends the user's Proficy WebSpace session, but does not 
close the browser window. By default, autoclose=false. 

embed=true|false This setting describes whether your web session runs in Loose 
mode or Embedded mode. When embed=true, Proficy 
WebSpace sessions run within the browser window (in 
Embedded mode). When embed=false, applications run outside 
the browser window (in Loose mode). By default, embed=true. 

NOTE: Do not use Embedded mode with FIX Desktop View. Use 
Loose mode with Mozilla Firefox in this case, or use the Microsoft 
Windows Desktop Client for the Proficy WebSpace. 
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Option Description 

bInBrowser=true|false This setting describes whether the Proficy WebSpace session 
will disconnect when a user closes the loose browser window, 
or browses to another page. 

The bInBrowser setting only applies to loose mode. In this 
mode, when bInBrowser=true, users will be disconnected from 
their Proficy WebSpace sessions when they close the browser 
or browse to another page. In these cases, the session will 
terminate on the server, based on the Proficy WebSpace 
Server's time-out settings for disconnected sessions. When 
bInBrowser=false, the Proficy WebSpace will run in a separate 
process and users will not be disconnected from their sessions 
when they close the browser or browse to another page. By 
default, bInBrowser=true. 

Google Chrome Client 

The Proficy WebSpace Plug-in allows you to connect to a Proficy WebSpace Server using Google Chrome in 
Loose mode only.                            

NOTE: Proficy WebSpace does not support Google Chrome when running with Proficy Vision. 

To connect to a Proficy WebSpace Server, browse to the Proficy WebSpace HTML page. If the plug-in is 
already installed on the client machine, it is automatically loaded and run by the browser. Otherwise, 
Google Chrome prompts you to download the plug-in and install it on the desktop computer. The Google 
Chrome Client Add-on requires the Microsoft Windows Desktop Client. 

Loose Mode  

You can run the Google Chrome Client only in Loose mode. Loose mode allows Proficy WorkSpace to 
display in an application window, which provides you with more screen real estate in a single window (as 
opposed to displaying the WorkSpace directly in a Google Chrome window). 

IMPORTANT: Proficy WebSpace supports Google Chrome in Loose mode only.  Embedded sessions are 
NOT supported. 

NOTE: In Loose mode,  the browser window automatically closes if there are no other tabs open in the 
browser. 
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Installing the Client 

If the plug-in is already installed on the client machine, it is automatically loaded and run by the browser. 
Otherwise, you are prompted to download the plug-in and install it on the desktop computer the first time 
you browse to this web page: http://ProficyWebSpaceServerName/ProficyWebSpace. 

where: ProficyWebSpaceServerName is the computer name or IP address of your Proficy WebSpace 
Server. 

The default page that opens is: 
http://ProficyWebSpaceServerName/proficywebspace/proficy.html?embed=true. 

Click on one of the products listed. 

This launches the link to http://ProficyWebSpaceServerNameI/ProficyWebSpace/installChrome.html and 
displays the Installing the Proficy WebSpace Chrome Extensions page, similar to the following. 

 

To install the Proficy WebSpace Chrome Extension: 

1. On the Installing the Proficy WebSpace Chrome Extension page, click on the Chrome Extension link 
to download the plug-in from the Chrome Web Store. 

2. Click the  button to install the extension. 

A pop-up message warns you to 'Please install the Windows Client (version 4.8.2 or later) before 
launching the Chrome Extension.' 
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TIP:  Pop-ups for ProficyWebSpaceServerName must be enabled to view this message. 

3. Click on the Windows Client link to download and install the Microsoft Windows Desktop Client. 
(This connects through http:// ProficyWebSpaceServerName/ProficyWebSpace/allclients.html.) 
Refer to the Microsoft Windows Desktop Client section for more information. 

4. In the Chrome browser, connect to http://ProficyWebSpaceServerName/proficywebspace/ifix.html 
and/or connect to a product by selecting a product name from the list. 

The Chrome client is redirected to launch with the Windows Desktop Client. You can also install the 
Windows plug-in with the proficy-client.windows.exe installer provided in any of these locations: 

• The WebSpaceServer subfolder on the DVD. 

• The Proficy WebSpace install folder, which is by default the C:\Program Files\Proficy\Proficy 
WebSpace\Web\Clients folder. 

• The Proficy WebSpace Server computer in the folder where you publish the Proficy WebSpace 
files to be hosted by your IIS or Apache server.  Connect to http:// 
ProficyWebSpaceServerName /ProficyWebSpace/allclients.html and select the link to 
download and install the client. 

Updating the Client 

If you have installed the plug-in with Google Chrome, then you can update the plug-in via Chrome's Add-on 
Manager. If you are unable to do that, you can also manually uninstall and then reinstall the plug-in. 

NOTE: The Chrome plug-in update feature does not work if you install the Windows Desktop Client installer 
(proficy-client.windows.exe). It only works when the web client has been installed via the web browser 
page. 

To update the Chrome Plug-in with the Add-on Manager: 

1. In Chrome, on the Tools menu, select Add-ons. 

2. Click the Find Updates button. 

3. Install the update. 

Running the Client 

To run the client, access the Proficy WebSpace Server HTML page. 

NOTE: If you want to change the options available when you run the Proficy WebSpace plug-in, refer to the 
Command-line Options section. 

To run the Proficy WebSpace Plug-in: 

1. Start Google Chrome. 

2. In the URL box, type http:// followed by the Proficy WebSpace Server computer name (or IP 
address) and then /ProficyWebSpace. For example: 

http://ProficyWebSpaceServerName/ProficyWebspace 

3. Select the appropriate product from the list. 
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4. When the Logon dialog appears, type the following information: 

• Your network user name in the User name field. 

• Your network password in the Password field. 

NOTE: Users are allowed three invalid logon attempts before the logon process shuts down. 

Uninstalling the Client 

To uninstall the Proficy WebSpace Plug-in, first uninstall the plug-in and then clear the browser cache. 

To uninstall the Proficy WebSpace Plug-in: 

1. Open Google Chrome. 

2. On the Tools menu, click More Tools. 

3. On the More Tools menu, click the Extensions tab and select the Proficy WebSpace Plug-in. 

4. Click the Uninstall (or Remove) button. 

5. Restart Google Chrome. 

To clear the browser cache: 

1. Open Google Chrome. 

2. On the Tools menu, click Options. The Options dialog box appears. 

3. Click Advanced. 

4. Click the Network tab. 

5. In the Cache area, click Clear Now. 

If you are still having difficulty, consult an administrator to check the Downloaded Program Files folder for 
Proficy WebSpace related files. 

To check the Downloaded Program Files folder: 

1. Open a Command Prompt window. 

2. Type the location of the Downloaded Program Files folder and check for any Proficy WebSpace 
related files. If any exist, delete them. 

3. Close the Command Prompt window. 

Command-line Information and Guidelines 

Optionally, you can use command-line settings to override the defaults of your Proficy WebSpace session 
on open. You can do this by either: 

• Directly entering the commands following the web address when you type it into the Address bar 
of Mozilla Firefox, or from the hyperlink command you refer to on a custom web page. For 
example, the address plus command-options could read as follows: 

For iFIX only: 
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 http://ProficyWebSpaceServerName/ProficyWebSpace/iFIX.html?embed=false&bInBrowser=false 

-Or- 

Changing the default settings for every user, by editing the Logon call in the index.html and 
index.htm files on the Proficy WebSpace Server in the directory where you publish the Proficy 
WebSpace files to be hosted by your IIS or Apache server. For example, you would modify the 
window.location.href = "proficy.html?embed=true"; line in the index.html and index.htm files with 
the settings you want to change. For instance, you might want to change that line to allow for 
loose mode, instead of embedded mode, like this: window.location.href = 
"proficy.html?embed=false"; 

Be aware of the following when working with command-line options: 

• Command-line passing of variables to CIMPLICITY is supported through the .HTML file.  For details, 
refer to the CIMPLICITY HTML File Overview section. 

• Parameters are optional and case-sensitive. They can be appended in any order. 

• Command-line options that are also configurable in the Administration tool, override the default 
settings in the Proficy WebSpace Administration tool. 

• Before the first command-line option, and after the proficy.html reference, add a ? symbol. For 
example: proficy.html?embed=false. 

• After the first command, each additional command that you add should be appended with the & 
symbol before the additional command. For example: embed=false&bInBrowser=false. 

• Spaces within parameters must be replaced with the %20 symbol. 

To edit the Index.html and Index.htm page to change the command-line options for the default 
login page: 

1. Access the Proficy WebSpace Server computer, and locate the he folder where you publish the 
Proficy WebSpace files to be hosted by your IIS or Apache server. 

2. Open the index.html or index.htm page in a text editor, such as Notepad. 

3. Scroll to the following line: 

window.location.href = "proficy.html?embed=true"; 

4. Add or change the command line options. Refer to the Summary of Command-line Options for a 
full list of available options. For example, to enable loose mode instead of embedded mode, enter: 

window.location.href = "proficy.html?embed=false"; 

5. Save the file. 

To use a custom hyperlink command to open a web page: 

1. Open a web page in an editor. 

2. Choose the editor's Insert Hyperlink option. 

3. Enter the address of the host, followed by the desired hyperlink parameters. Refer to the Summary 
of Command-line Options for a full list of available options. For example, to enable loose mode 
instead of embedded mode, enter: 

http://ProficyWebSpaceServerName/ProficyWebSpace/proficy.html?embed=false 
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4. Save the page. 

Summary of Command-line Options 

The following table describes the available command-line options for the Proficy WebSpace startup in 
Google Chrome. 

Option Description 

user=user_name The name of the user's account. 

password=actual_password The user's password. 

port=port_number The port on which the Proficy WebSpace Server accepts 
connections. By default, this port number is 491. 

autoclose=true|false This setting describes whether the browser window closes if 
you close the WorkSpace window within your Proficy 
WebSpace session. 

When autoclose=true, closing the program window closes the 
associated browser window and ends the user's Proficy 
WebSpace session. When autoclose=false, closing the program 
window ends the user's Proficy WebSpace session, but does not 
close the browser window. By default, autoclose=false. 

bInBrowser=true|false This setting describes whether the Proficy WebSpace session 
will disconnect when a user closes the loose browser window, 
or browses to another page. 

The bInBrowser setting only applies to Loose mode. In this 
mode, when bInBrowser=true, users will be disconnected from 
their Proficy WebSpace sessions when they close the browser 
or browse to another page. In these cases, the session will 
terminate on the server, based on the Proficy WebSpace 
Server's time-out settings for disconnected sessions. 

When bInBrowser=false, the Proficy WebSpace will run in a 
separate process and users will not be disconnected from their 
sessions when they close the browser or browse to another 
page. By default, bInBrowser=true. 
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Microsoft Windows Desktop Client 

The Windows Desktop Client allows you to view WorkSpace pictures from a desktop application using web 
services. It does not require Internet Explorer or Mozilla Firefox. Optionally, you can customize the 
command-line settings you use to open this Desktop Client. The following figure shows an example of the 
Windows Desktop Client in use.                    

 

Installing the Windows Desktop Client 

You can install the desktop client with the proficy-client.windows.exe installer provided on the Proficy 
WebSpace Server computer in the folder where you publish the Proficy WebSpace files to be hosted by 
your IIS or Apache server, or from the Proficy WebSpace install folder, which is the C:\Program 
Files\Proficy\Proficy WebSpace\Web\Clients folder by default. You can also install it using the 
AllClients.html web page, and selecting the Windows Client option. 

To install the Windows Desktop Client: 

1. Obtain the proficy-client.windows.exe installer from the: 

• Proficy WebSpace Server computer in the directory where you publish the Proficy 
WebSpace files to be hosted by your IIS or Apache server. 

• The DVD in the WebSpaceServer subfolder. 

• Proficy WebSpace install folder, which is by default the C:\Program Files\Proficy\Proficy 
WebSpace\Web\Clients folder. 

• The AllClients.html web page, which allows you to download and run the file on the client 
computer. 

2. Copy this file to the client computer. 

3. Double-click proficy-client.windows.exe to start the install. 

4. Click OK. The Welcome screen appears. 

5. Click Next to continue. The License Agreement screen appears. 
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6. Select the "I accept the terms in the license agreement" and click Next to continue. The Setup Type 
screen appears. 

7. Select Complete (which includes the Desktop Client, as well as the Internet Explorer, and Firefox 
plug-in), or Custom (to choose only the Desktop Client), and then click Next. The Ready to Install 
screen appears. 

8. Click Install. After a few moments, the Completion screen appears. 

9. Click Finish. 

10. Confirm that the Desktop Client short-cut appears on the Start menu (on the Start menu, point to 
Programs > Proficy WebSpace Client > Proficy WebSpace Client). 

Running the Windows Desktop Client 

The Proficy WebSpace Windows Desktop Client can be run by selecting the option on the Start menu, or by 
running a custom short-cut. 

IMPORTANT:  When using the Proficy WebSpace Windows Desktop Client, a custom short-cut 
configuration is required. If launched without configuring the short-cut,  you may encounter the following 
error:  "Proficy WebSpace failed to launch the Program window for your session. The problem is explained 
in your system administrator's log file." 

NOTE: If you want to change the options available when you run the Windows Desktop Client, refer to the 
Command-line Options section below. 

To run the Windows Desktop Client: 

1. On the Start menu, point to Programs > Proficy WebSpace Client > Proficy WebSpace Client. The 
Desktop Client appears. 

-Or- 

Double-click the short-cut you created to start the Windows Desktop Client. The Desktop Client 
appears. 

2. When the Logon dialog appears, type the following information: 

• Your network user name in the User name field. 

• Your network password in the Password field. 

NOTE: Users are allowed three invalid logon attempts before the logon process shuts down. 

Uninstalling the Windows 

Desktop Client 

• To uninstall the Windows Desktop Client, use the Add or Remove Programs option in the Windows 
Control Panel. 

To uninstall the Proficy WebSpace Desktop Client: 

1. From the Control Panel, select Add or Remove Programs. The Add or Remove Programs dialog box 
appears. 
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2. Select the Proficy WebSpace Client in the list of programs. 

3. Click Remove. 

4. Follow the instructions on your screen. 

Command-line Information and Guidelines 

Optionally, you can use command-line settings to override the defaults of your Windows Desktop Client 
session on open. You can do this by either: 

• Changing the default settings you use on the Start menu to open the Windows Desktop Client, by 
changing the Properties on the shortcut. 

-Or- 

Creating a new shortcut with the command-line options that you want to use. 

Be aware of the following when working with command-line options: 

• Parameters are optional and case-sensitive. They can be appended in any order with the 
exception of -r. If -r is used, it must be the last parameter on the command-line and it must be 
used with the –a parameter. 

• Command-line options that are also configurable in the Administration tool, such as -hp and -ac, 
override the default settings in the Proficy WebSpace Administration tool. 

• Command-line options can only be appended to desktop shortcuts that call the "C:\Program 
Files\Proficy\Proficy WebSpace\Client\Proficy.exe" file. 

• In order to accommodate spaces in user names and passwords, quotation marks must be 
included when using command-line arguments. 

To modify the default settings on the Start menu option for the Windows Desktop Client: 

1. On the Start menu, point to Programs > Proficy WebSpace Client > Proficy WebSpace Client. 

2. Right-click the WebSpace Client and select Properties. The Proficy WebSpace Client Properties 
dialog box appears. 

3. On the Shortcut tab, in the Target field, add parameters you want to include after the path to 
Proficy.exe. Refer to the Summary of Command-line Options for a full list of available options. For 
example, this option will open the Windows Desktop Client with a server named MyServer, and 
includes command-line options for each program: 

• For iFIX: "C:\Program Files (x86)\Proficy\Proficy WebSpace Client\Client\Proficy.exe" -h 
MyServer -c -a iFIX -r IFIX /puserscreen.grf  (for a specific picture, specify -r IFIX 
/ppicname.grf) 

NOTE:  iFIX 5.5 does not support the /ppicname parameter in the command line. 

• For CIMPLICITY:  "C:\Program Files (x86)\Proficy\Proficy WebSpace 
Client\Client\Proficy.exe" -h MyServer -c -a CimView -r CIMVIEW 
"c:\screens\userscreen.cim" 

• For Plant Applications: "C:\Program Files (x86)\Proficy\Proficy WebSpace 
Client\Client\Proficy.exe" -h MyServer -c -a PlantApps -r PA /d userdisplay. 

• Click OK to save your changes. 
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To create a desktop shortcut for Windows Desktop Client: 

1. Right-click on the desktop, and select New and then Shortcut. The Create Shortcut dialog box 
appears. 

2. In the Create Shortcut dialog box, browse to the Proficy WebSpace executable file: "C:\Program 
Files (x86)\Proficy\Proficy WebSpace Client\Client\Proficy.exe" 

3. Add parameters after the path to Proficy.exe. Refer to the Summary of Command-line Options for 
a full list of available options. For example, this option will open the Windows Desktop Client with a 
server named MyServer, and includes command-line options for each program: 

• For iFIX: "C:\Program Files (x86)\Proficy\Proficy WebSpace Client\Client\Proficy.exe" -h 
MyServer -c -a iFIX -r IFIX /puserscreen.grf  (for a specific picture, specify -r IFIX 
/ppicname.grf) 

NOTE:  iFIX 5.5 does not support the /ppicname parameter in the command line.  

• For CIMPLICITY:  "C:\Program Files (x86)\Proficy\Proficy WebSpace 
Client\Client\Proficy.exe" -h MyServer -c -a CimView -r CIMVIEW 
"c:\screens\userscreen.cim" 

• For Plant Applications: "C:\Program Files (x86)\Proficy\Proficy WebSpace 
Client\Client\Proficy.exe" -h MyServer -c -a PlantApps -r PA /d userdisplay 

4. Type a name for the shortcut and click Finish. 

TIP: You can also create a Desktop shortcut automatically from the Connection dialog box. When 
you click on the Start menu, and point to Programs > Proficy WebSpace Client > Proficy 
WebSpace Client, a dialog box appears similar to the following figure. You can select the Create 
Desktop Shortcut to this Host option, as shown in the following dialog box. 

•  

Summary of Command-line Options 

The following table describes the available command-line options for the Proficy WebSpace startup in the 
Windows Desktop Client (Proficy.exe). 

Parameters are optional and case-sensitive. Parameters can be appended in any order with the exception 
of the -r option.   When the -r parameter is used, it must be the last parameter on the command line and it 
must be used with the -a parameter. 

Option Description 

-u user_name The name of the user's account. 
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Option Description 

-p 
actual_password 

The user's password. 

-hp port_number The port on which the Proficy WebSpace Server accepts connections. By 
default, this port number is 491. 

-h host_name The name or IP address of your Proficy WebSpace Server machine. 

-c or -nc -c enables compression. (Compression is enabled by default.)   
-nc disables compression. 

-f (0 | 1) This setting describes whether each session will be displayed in a bounding 
window. When you use -f followed by a 1, all applications running in the 
session will be displayed within a bounding window. When you follow the -f 
respectively with a 0, applications will be displayed within their own 
individual windows. 

-a app_name The application you want to open: 

• iFIX 

• CimView 

• CimLayout 

• PlantApps 

NOTE: When using the -a option with CimView, the –r option must also be 
supplied. 
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Option Description 

- r app_name 
parameters 

The application you want to open, with the specified parameters. Examples 
with additional parameters include: 

• iFIX /puserscreen.grf     

• CimView "c:\screens\userscreen.cim" 

• CimLayout “c:\CIMPLICITY_webfiles\layoutfile.cimlayout” 

• PA /d userdisplay 

NOTE: The -a option must be supplied before the -r option.  The -r option does 
not replace the -a option. The -r option simply allows you  to supply additional 
parameters for your application. 

Automatically Update the Desktop Client Version 

Administrators can configure the Proficy WebSpace Server to automatically update the Proficy WebSpace 
Desktop Client when a user connects to a Proficy WebSpace Server that is running a newer version. When 
enabled, when a user tries to connect and an upgrade is available, the following message appears: 

"An update has been downloaded and will be available the next time  you run the Proficy 
WebSpace." 

NOTE: The Automatically Update Clients option on the Client Access tab of the Proficy WebSpace 
Administration tool is only available for the Windows Desktop Client. It does not apply to other clients such 
as Mozilla Firefox and Internet Explorer. 

To enable automatic Windows Desktop Client updates: 

1. From the Proficy WebSpace Administration, from the Server tree, select the server name you want 
to configure. 

2. On the Tools menu, click Host Options. The Host Options dialog box appears. 

3. Click the Client Access tab. 

4. Select the "Automatically Update Clients" check box. 

5. Click OK. 

CIMPLICITY HTML File Overview 

A CIMPLICITY .html file is created for Proficy WebSpace based on entries that are made in the Create Web 
Page dialog box on the CIMPLICITY Server. You can manually modify the values in the created .html file. 
This section describes the HTML file and values you can edit. 

NOTE: On the CIMPLICITY Server, to publish a web page for a CIMPLICITY CimView screen, right-click the 
CIMPLICITY Options and select Run as Administrator. On the Proficy WebSpace tab, click the "Create a Web 
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Page" button. The next dialog box allows you to select the screen that you want and creates a web page 
for it; if it does not detect the default Proficy WebSpace directory to place the html file in, you will need to 
enter it. If it's an Apache server, you will need to browse to the location of the Apache Server; by default, 
the Apache Server location is: "C:\Program Files (x86)\Apache Software 
Foundation\Apache2.2\htdocs\ProficyWebSpace." 

IMPORTANT: The parameters listed in the HTML file are pulled from a DynamicGlobalViewApplication.js file. 
 Do not edit the DynamicGlobalViewApplication.js file. 

Example HTML File 

<HTML> 
<HEAD> 
<TITLE>Proficy HMI/SCADA CIMPLICITY</TITLE> 
<LINK href="stylesheet.css" rel="stylesheet" type="text/css" > 
<SCRIPT LANGUAGE="JavaScript1.1" SRC="/GlobalView/WhatPlatform.js"></SCRIPT> 
<SCRIPT LANGUAGE="JavaScript1.1" SRC="/GlobalView/NPInstallFunctions.js"></SCRIPT> 
<SCRIPT LANGUAGE="JavaScript1.1" SRC="/CimWeb/DynamicGoGlobalApplication.js"></SCRIPT> 
<SCRIPT LANGUAGE=javascript > 
<!-- 
downloadNow(); 
// --> 
</SCRIPT> 
</HEAD> 
<BODY BOTTOMMARGIN="0" LEFTMARGIN="0" RIGHTMARGIN="0" TOPMARGIN="0" 
       onload="loadGoGlobalApplication('', '', '', 'CimView', '/noexit ' + 
document.getElementById('params').getAttribute('name'), 'true', 'true', '', 'false', 'true', 
'default');"> 
<div id="goglobal-application" /> 
<div id="params" name="/maximized /alwaysmaximized /noopen /noresize /zoomtobestfit /nomenutitle 
/noPointTargets /noSetPoints /project cimpdemo /setvar &quot;Va1f&quot; &quot;Value1&quot; 
/setvar &quot;Var2&quot; &quot;Value2&quot; /MinUpdate 5000 /WaitUpdate 60000 /MaxUpdate 0 
&quot;C:\Program Files\Proficy\Proficy CIMPLICITY\projects\cimpdemo\Screens\Applied.cim&quot;" 
style="display:none"/> 
</BODY> 
</HTML> 

HTML File Sections 

When Proficy WebSpace creates an .html file for CIMPLICITY, it defaults to the selected values in the 
following sections. The order in which the values are entered corresponds to what parameters they relate 
to in the .js file. 

Margin Dimensions 

<BODY BOTTOMMARGIN="0" LEFTMARGIN="0" RIGHTMARGIN="0" TOPMARGIN="0" 

The margin dimensions define the space between the CimView screen and the edge of the ActiveX control 
or Plugin. The default for each margin is zero ("0"), as shown in the example. 

General Parameters 

onload="loadGoGlobalApplication('', '', '', 'CimView', '/noexit ' + 
document.getElementById('params').getAttribute('name'), 



Proficy* WebSpace 4.8 

109 

'true', 'true', '', 'false', 'true', 'default');"> 

<div id="globalview-application" /> 

Default values for parameters that are not defined in the Create a Web Page dialog box are as follows: 

onload="loadGlobalViewApplication('', '', '', 'CimView', '/noexit ' + 
document.getElementById('params').getAttribute('name'), 'true', 'false', '', 
'false', 'true', 'default');"> 

The associated parameters are described in the following table (in order that they appear). 

Parameter Syntax Description 

user 'username' Client's network user name. 

Default '' 

IMPORTANT: If you enter a user name 
and include a domain include two 
backslashes in the value. 

Example 

'domain\\username' 

password 'password' Client's network password 

Default '' 

host 'Servername' The name of the machine the 
Application Publishing Service is 
running on. 

Default '' 

application 'CimView' Proficy WebSpace supports the 
CimView application. 

IMPORTANT: Do not change the 
CimView entry. 
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Parameter Syntax Description 

args '/noexit' Passes on specific application 
parameters for the application 
about to be launched. 

NOTES: 
• Selections made in the Create a 

Web Page dialog box are not 
included in the args parameter. 

• /noexit , which disables exiting 
the CimView screens, is 
included as the default. 

Default '/noexit' 

isembeddedwin ' true | false' Determines if CimView windows will 
be embedded in the browser or 
loose. 

Embedded options are: 

• 'true' Embedded screens. 

• 'false' Screens in loose 
windows. 

Default 'true' 

compression ' true | false' Compresses data that is 
transmitted over the network. 

Compression options are: 

• 'true' Enabled. 

• 'false' Disabled 

Default true 

NOTE: Activate compression is 
enabled for the Proficy WebSpace 
client whenever there is low 
bandwidth. 
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Parameter Syntax Description 

hostport '' (no host specified) 

' ? | serveraddress' 

Modifies the host port setting for the 
Application Publishing Service. 

The following occurs based on what is 
entered in the .html Logon file. 

Options are: 

• No host is specified. The Plug-in 
detects the machine from 
where the logon file was 
downloaded. It makes the 
connection to that server. The 
user bypasses the Connection 
dialog box and is presented 
with the Logon dialog box only. 

• '?:  The Connection dialog 
opens. . Clients must type in a 
server address. 

• 'serveraddress': The user 
bypasses the Connection dialog 
box and connects to the 
specified server. 

Default ''  (no host specified) 

autoclosebrowser ' true | false' 
Determines when the browser will 
close. 

Options are: 

• 'true' - Closing the Program 
Window:  closes the browser, 
and ends the user’s Proficy 
WebSpace session. 

• 'false'-  Closing the Program 
Window does not close the 
browser window, or end the 
user's Proficy WebSpace 
session. 

Default 'false' 
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Parameter Syntax Description 

inbrowserprocess ' true | false' 
Only applies when the Plug-in is run in 
loose windows mode. 

Options are: 

• 'true' - Users will be 
disconnected from their Proficy 
WebSpace sessions when they 
close the browser or browse to 
another page. 

NOTE: When the session will 
terminate on the server is based 
on the server's timeout settings 
for disconnected sessions. 

• 'false' - Users will not be 
disconnected from their 
sessions when they close the 
browser or browse to another 
page. 

The Proficy WebSpace client will run in 
a separate process. 

Default 'true' 

autoconfigprinters ' all | none | default' 
Determines how printers are initialized 
at startup. 

• 'all' - All client printers are 
automatically configured. 

• 'none' - Client printers are not 
automatically configured 

• 'default' - The default printer is 
configured automatically 

Default 'default' 

Screen Options 

<div id="params" name="/maximized /alwaysmaximized /noopen /noresize 
/zoomtobestfit 

/nomenutitle /noPointTargets /noSetPoints /project projectname 

Parameters that are checked in the Screen Options box in the Create a Web Page dialog box are entered in 
this section of the .html file. 

When all of the parameters are checked and a project name for unqualified points is entered, the file 
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includes everything from the example. 

Variables 

/setvar &quot;Var1&quot; &quot;VarValue1&quot; /setvar &quot;Var2&quot; 
&quot;VarValue2&quot; 

Variables entered in the create Web Page dialog box are listed in the /setvar parameter in the .html file. 

Variables can be added, edited or deleted. 

IMPORTANT: The .html code requires $quot; to replace quotation marks. 

Screen Update Rates 

/MinUpdate 5000 /WaitUpdate 60000 /MaxUpdate 0 

Screen update rates entered in the Create Web Page dialog box use the update parameters in the .html 
file. 

The rates can be changed. 

CimView Screen Path and Style 

&quot;C:\Program Files\Proficy\Proficy 
CIMPLICITY\projects\cimpdemo\Screens\Applied.cim&quot;" style="display:none"/> 

</BODY> 

</HTML> 

The path to the logon CimView screen can be changed. 

IMPORTANT: The .html code requires $quot; to replace quotation marks. 

TIP: If users experience slow scrolling with GlobalView, try disabling the smooth scrolling option on  the 
server. 

In Internet Explorer: 

• Click Tools>Internet Options on the Internet Explorer menu bar. 

The Internet Options dialog box opens. 

1. Select the Advanced tab. 

2. Clear Use Smooth Scrolling in the browsing tree. 

Advanced Topics 
The following sections provide information on advanced topics that may be not be referenced frequently: 
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• Session Balancing 

• Terminal Services and Proficy WebSpace 

• Tips on Administrating User Accounts 

• Windows Configuration for Network and Client Printers 

• Working with the IIS Web Server 

Session Balancing 

Session balancing is a technique used by the Relay Server to spread the work for the Proficy WebSpace 
Server across two or more dependent application servers. The Relay Server maintains and distributes the 
client connections across each of the dependent application servers.                  

Session balancing: 

• Allows Proficy WebSpace sessions to be distributed across multiple dependent application servers. 

• Is needed when the server resource requirements for a deployment exceed the capacity of a 
single server computer. 

• Is done automatically and is transparent to the user. 

The goals of session balancing include: 

• Optimal resource utilization. 

• Maximized throughput. 

• Minimized response time. 

Session Balancing Requirements 

• The Proficy WebSpace Server must be installed on each of the servers in the configuration (on the 
Relay Server and each dependent application server), along with IIS or Apache HTTP Server. 

• Each dependent application server should be configured the same, with the same installed 
software, settings, and install locations. In other words, all software, pictures, and network access 
must be the same on each dependent application server in your configuration. 

IMPORTANT: The command-line parameters on the relay server must always match the command-
line parameters on the dependent servers. If using a standalone Proficy WebSpace relay server (no 
iFIX, CIMPLICITY, or Plant Applications installed on the server), the command-line parameters need 
to be modified in the Proficy WebSpace Administration tool to include the full path of the iFIX, 
CIMPLICITY, or Plant Applications product.  For example, for iFIX, in the WebSpace Administrator, you 
would change the command-line from iFIX /s”WEB.SCU” to iFIX /s”C:\Programs Files 
(x86)\Proficy\Proficy iFIX\LOCAL\WEB.SCU” (where the path for the WEB.SCU points to where iFIX is 
installed on all dependent Proficy WebSpace servers - it should be the same location on all 
dependent servers). 

• Dependent application servers must be located on the same network as their associated Relay 
Server. 

• Users are authenticated on dependent application servers, and on the Relay Server. 

• iFIX View nodes cannot connect directly to dependent application servers. 
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Host Selection 

When a client connects to a Relay Server, the Relay Server attempts to start a session on the dependent 
application server (host) that has the lowest number of running sessions as a percentage of the maximum 
number of sessions allowed for the host. 

If the session fails to start on the selected host, the Relay Server successively attempts to start the session 
on other available hosts until it finds one that can support the session. 

If there are no available hosts (for instance, if the number of running sessions on All Hosts equals the 
maximum number allowed), the following message is displayed to the user: You are already running as 
many sessions as you are allowed. 

Otherwise, if the session cannot be started on any of the available dependent application servers, the 
following message is displayed to the user: Proficy WebSpace failed to launch the Program Window for 
your session. The problem is explained in your System Administrator's log file. 

In a Relay Server configuration, the Proficy WebSpace checks the maximum sessions settings on the Relay 
Server and its dependent servers. The maximum sessions value on the Relay Server is the maximum 
number of sessions that can be run concurrently on all dependent hosts assigned to that Relay Server. To 
modify the Maximum sessions on this host setting, open the Proficy WebSpace Administrator on the 
Dependent Application Server, and on the Host Options dialog box, select the Session Startup tab. 

Relay Server Failure Recovery 

On Windows hosts, the Application Publishing Service can be configured to automatically restart if the 
service fails. If a Relay Server fails, clients are disconnected but sessions continue to run on the dependent 
servers that were connected to the Relay Server. These dependent servers will attempt to reconnect to the 
Relay Server every 15 seconds. When a dependent server reconnects to the Relay Server, it re-adds its 
sessions to the Relay Server and restores any state information associated with the disconnected sessions. 
Clients are then able to sign back in and resume their sessions. Clients do not automatically attempt to 
reconnect to the Relay Server. 

In order to provide higher service availability, a separate failover server can be configured for the Proficy 
WebSpace Relay Server using the Microsoft Cluster Service. The Proficy WebSpace Relay Server was tested 
with the Microsoft Cluster Service (MSCS) on Windows Server 2003. Windows Server 2008 also supports 
MSCS as Windows Server Failover Clustering. In an MSCS configuration, if the Relay Server fails for any 
reason, the failover server immediately takes the place of the failed server. Application hosts automatically 
reconnect to the failover server, and users will generally be able to log on and reconnect to their 
disconnected sessions within 1-2 minutes of the Relay Server failure. 

Standalone Relay Server Configuration 

When using a WebSpace relay server in a standalone configuration (for example, when iFIX is not installed), 
you must modify the command line (for iFIX) using the WebSpace Administration tool. This modification is 
necessary because when the relay server is standalone, it cannot determine the default SCU path 
necessary to get the WebSpace client to start correctly. 

To start the WebSpace client in a standalone configuration: 

1. From the WebSpace Administrator main window, click the Applications tab. 

2. From the list of applications that appear, select iFIX. 
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3. Click Properties. The Application Properties dialog box appears. 

4. In the Command Line Options box, change the startup parameter. 

NOTE: This path should be the same path as the path that was configured on the dependent 
servers. For example, from iFIX, /s”C:\Program Files (x86)\Proficy\Proficy iFIX\LOCAL\WEB.SCU” 
shows the defaults that were chosen while installing a 64-bit operating system. Thus, when 
dependent servers are added, their Command Line Options change to iFIX /s”C:\Program Files 
(x86)\Proficy\Proficy iFIX\LOCAL\WEB.SCU” (passed from relay server). 

If you do not change the relay server’s Command Line Options from the default of iFIX /s”WEB.SCU", 
when dependent servers are added, their Command Line Options would change to iFIX /s”WEB.SCU” 
and the WebSpace client will not start correctly. 

IMPORTANT: In a  standalone relay server configuration, the command line parameters for iFIX 
must always match the command line on the dependent servers for the relay server to use the 
correct SCU path. 

Terminal Services and Proficy WebSpace 

When using Terminal Services and the Proficy WebSpace Server: 

• The Terminal Server cannot run on the same machine as the Proficy WebSpace Server. 

• The Terminal Services remote desktop is supported to remotely configure and administer a server. 

• Terminal Services must run in administrative mode; do not use remote desktop for applications. 

• On Windows 2008 and Windows 2012, remote desktop provides you with two remote desktop 
connections as well as the console.                               

Tips on Administrating User Accounts 

How Logins Work 

To access applications on a Proficy WebSpace Server, clients must sign in to the server machine. When a 
user starts a Proficy WebSpace client, a prompt appears for a user name and password. This information is 
optionally encrypted (by default) and passed to the Proficy WebSpace Application Publishing Service 
running on the Proficy WebSpace Server. The Proficy WebSpace Application Publishing Service then 
performs the logon operation on the Proficy WebSpace Server using standard multi-user features of 
Windows. Next, the iFIX Security Login dialog box appears for the iFIX login. The user names and 
passwords should be the same for Windows and iFIX Security. (Optionally, you can configure password 
caching on the client for subsequent logins. For more information, refer to the Client-Side Password 
Caching section.) 

When a user signs in to a Proficy WebSpace Server and a domain is not specified, the Proficy WebSpace 
Server first attempts to authenticate the account on the local machine, followed by the machine's domain, 
and lastly the trusted domains. Users can override this default behavior and specify a domain by typing the 
domain name followed by a backslash (\) and their network user name in the User name box of the Sign In 
dialog box (for example, NORTH\johng). 

When a local user name on the Proficy WebSpace Server is the same user name as a domain account, 
each with a different password, Proficy WebSpace treats them as two separate accounts. Consider, for 
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example, the following scenario: 

• A local account on the Proficy WebSpace Server, johng, with a password of local. 

• A domain account, johng, with a password of domain. 

When typing the user name johng with the password local in the Sign In dialog, the account will 
authenticate on the local Proficy WebSpace Server. When typing johng with the password domain in the 
Sign In dialog, the Proficy WebSpace does not attempt to authenticate on the domain, but fails with an 
invalid user name or password. You must specify the domain name in the User name field in the Sign In 
dialog box (for example, NORTH\johng). 

After a user is signed in, the Proficy WebSpace relies on the server's operating system to provide the 
security necessary to run applications safely in a multi-user environment. Applications run in the security 
context of the client user; this ensures private sessions. Access to all machines and network resources is 
governed by the operating system and the rights that have been granted to individual user's sessions. 

Users must be able to log on interactively (locally) on the Proficy WebSpace Server. Assign local logon rights 
to users in Local Security Policy, Domain Security Policy, and Domain Controller Security Policy. 

User Account Guidelines 

• The same user name and password combination must be added to your user accounts in 
Windows and in iFIX to become a valid Proficy WebSpace user. 

• When adding user accounts in Windows, you can add them to the Workgroup or a Domain. 
However, it is preferable to use a Domain. Otherwise, you will need to map network drives, and use 
logon scripts. 

• iFIX Windows Security must be enabled for each user you add on your Proficy WebSpace Server in 
the iFIX Security Configuration program. 

• When adding users through the Security Configuration application in iFIX, be sure to select the 
Windows Security option for the user. 

• If you want to use Proficy WebSpace with FIX Desktop, be aware that because iFIX security is 
enabled, logged in users must be authorized with the "FIX32 - Run a Task From View" rights in the 
iFIX Security Configuration application. 

• When assigning security privileges in iFIX, use care when allowing application features that could 
allow write access, such as the "Database Save/Reload" and "Runtime Visual Basic Editor" 
features, as well as creating pictures with Datalinks, or any other means to write values into tags. 
Use Security Areas and Security Groups to further restrict access. Also, use care when creating 
and sharing schedules in iFIX, so that unintended VBA code is not activated inadvertently by web 
sessions. For more information on iFIX Security, refer to the Configuring Security Features e-book. 

• The Proficy WebSpace Server and the SCADA Server should reside on the same network. 

• The Proficy WebSpace Relay Server and dependent application servers with the Proficy WebSpace 
installed, should all reside on the same network. 

Windows Configuration for Network and Client Printers 

Your system may require the following Windows configuration to insure successful Proficy WebSpace 
client printing.                      
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• Custom names for client printers. 

• Network printer setup. 

• Client printers in a multi-server environment. 

Custom Names for Client Printers 

The Proficy WebSpace installs a printer on the server for each printer that is configured on the client 
machine. These printers are called proxy printers and are the printers that are seen by users when printing 
via the Proficy WebSpace session. 

NOTE: By default, the name for the client's proxy printer installed on the Proficy WebSpace Server is 
“<client printer name> (from <client machine name>).” So, for instance, if the client machine is named 
HRWorkstation and has a printer named “Xerox Phaser 6180MFP” attached to it, then the client's proxy 
printer on the Proficy WebSpace Server will be named “Xerox Phaser 6180MFP (from HRWorkstation).” 

Since multiple users connect to a Proficy WebSpace Server, these printers must be filtered so that users 
see only their own printers. This requires that each printer be assigned a unique identifier. A system 
administrator can specify the proxy printer format to insure that each printer has a unique identifier. In 
addition, information can include the: 

• User's name. 

• Client computer's IP address. 

• Client machine name. 

To customize the printer name: 

1. Open the Windows Registry Editor. 

2. Expand the HKEY_LOCAL_MACHINE key. 

3. Locate the PrinterNameFormat key: 

[SOFTWARE\Proficy\Proficy WebSpace\AppServer\PrinterNameFormat] 

4. Right-click PrinterNameFormat; select Modify on the Popup menu. (The default is “(from %C)”.) 

5. Enter one or more of the client printer customization tokens in the Value field. The available values 
are: 

Argument Description Example 

%U User name Wilson 

%I Client IP address 192.168.100.14 

%M Client MAC address 001122334455 

%C Client machine name HRWorkstation 
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Argument Description Example 

%S Server machine 
name 

Server1 

6. Save and close the Registry Editor. 

7. Restart the Proficy WebSpace Server. 

PrinterNameFormat Guidelines 

The following 2 characters are taken literally in the  PrinterNameFormat string; they are not tokens: 

-  @ 

12 characters that are not allowed are: 

! , \  = / : * ? " < > | 

If any of these characters are used in the string, they are replaced with a hyphen. 

Network Printer Setup 

As the administrator, you can set up network printers for use by Proficy WebSpace clients. You must first 
create a port on the Proficy WebSpace Server that connects directly to the server and then install the 
printer locally. This provides direct access to the printer. 

IMPORTANT: Network printers are set up using the Windows Add Printer Wizard, and not the Client Printer 
Wizard, which is accessible through the Program Window. 

To add a port to the Proficy WebSpace Server: 

1. On the Start menu, point to Settings and then click Printers. A new window opens. 

2. Double-click the Add Printer icon. 

3. Select local printer. 

4. Click Next. 

5. Click Create a new port; select Local Port as the type. 

6. Click Next. 

7. Type the UNC path to the printer in the Port Name dialog box. For example: you could enter 
\\PRINTSERVER\LASERPRINTER or the printer's IP address. 

8. Do one of the following: 

Select the printer manufacturer on the left and the printer model on the right. 

-Or- 

Click Have Disk. 

9. Follow the directions provided by the Add Printer Wizard to install the proper printer driver. 
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Client Printers in a Multi-Server Environment 

In a multi-server environment, a single Driver server can be a central location for printer drivers. The Driver 
server acts as a repository for all printer drivers that are available to Proficy WebSpace clients. Printer 
drivers that are installed on the Driver server are replicated on each application server when a user 
requiring them logs onto the Proficy WebSpace Server. 

When a user configures a printer with a driver that is not already available on the Driver server, that driver 
is replicated on the Driver server and is available to all application servers with access to that Driver server. 

If the Driver server and the Relay Server are: 

• The same machine, no additional setup is required. 

• Separate machines, the Driver server must: 

• Be accessible from the application servers. 

• Have a print$ share that points to the printer driver directory. 

Users need: 

• Read access to this share in order to install drivers from the Driver server. 

• Write access to this share in order to install drivers to the Driver server. 

Working with the IIS Web Server 

IIS Installed Folder Location 

If the Proficy WebSpace is installed on a computer with IIS, the installer will: 

• Locate the root IIS Web directory that is identified in the Windows Registry. 

• Install the client files (Proficy WebSpace folder) under that directory. 

Proficy WebSpace Server Installed Folder Location 

The Proficy WebSpace Server installs the client files in the Proficy WebSpace\Web\Clients folder. The 
default location is: 

• C:\Program Files\Proficy\Proficy WebSpace\Web\Clients 

Reference Information 
For additional information on working with the Proficy WebSpace product, refer to the following 
supplementary sections: 
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• How Do I... 

• Keyboard Shortcuts for the Proficy WebSpace Administration 

• Editing Application Startup Properties 

• Use the Dell Wyse T50 ARM Thin Client 

How Do I... 

Click any of the following links for step-by-step procedures: 

• Access the Proficy WebSpace Administration 

• Add Proficy WebSpace Server performance counters to the Performance Monitor 

• Apply Group Policy on a Proficy WebSpace Server 

• Configure hidden drives 

• Configure multiple input locales 

• Designate access to printer drivers 

• Disable printing from clients 

• Display session startup progress messages to user 

• Edit application startup properties 

• Enable client sounds 

• Enable client time zone redirection 

• Enable clipboard access 

• Enable encryption 

• Enable file usage restrictions 

• Enable support for client drives 

• End a user's processes 

• Enable the Status bar in the Administration application 

• Hide one or more client drives 

• Hide server drives 

• Increment client drive letters by a fixed value 

• Limit the number of sessions per user 

• Limit the number of sessions per Proficy WebSpace Server 

• List client drives sequentially starting at a given drive letter 

• Modify the server port setting 

• Refresh the Proficy WebSpace Administration 

• Run a user-specific logon script 

• Run a global logon script 
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• Run the Proficy WebSpace ActiveX Control 

• Run the Proficy WebSpace Plug-in 

• Run the Windows Desktop Client 

• Shadow a session 

• Select a new location for the Log files 

• Set output level for the logging 

• Set permissions and restrictions for a file or an application 

• Set the Refresh Rate on the Proficy WebSpace Administration 

• Set up a network printer 

• Specify the minimum available physical memory necessary for this server to start a session 

• Specify the minimum percentage of virtual memory necessary for this server to start a session 

• Terminate a user's session 

• Use the Dell Wyse T50 ARM Thin Client 

• View process information on the Proficy WebSpace Administration 

• View session information on the Proficy WebSpace Administration 

•   

Use the Dell Wyse T50 ARM Thin Client 

The Dell Wyse T50 ARM Thin Client provides an Advanced RISC Machine (ARM) processor that uses the 
Linux Embedded Ubuntu operating system and the Mozilla Firefox browser. The Dell® Wyse® T50 ARM 
Thin Client supports the following:               

• Operating System: Wyse-Enhanced Ubuntu operating system, version 10.04.1 LTS 

• Browser: Mozilla Firefox v12 

• Client Session: For performance reasons, only one WebSpace client session should be opened on 
each physical machine. 

• Platform Products: iFIX only 
NOTE: CIMPLICITY and Plant Applications do not support the Dell Wyse T50 ARM Thin Client. 

Before you can use the Dell Wyse T50 ARM Thin Client you must:  

• Configure the Proficy WebSpace Server to use IIS. (Apache is not supported.) 

• Modify three registry keys on the Proficy WebSpace Server for the Linux ARM client to work 
correctly on the Dell Wyse T50 ARM Thin Client. 

• Install the latest version of the Wyse-Enhanced Linux Ubuntu operating system. 

• Upgrade the Mozilla Firefox browser on the Dell Wyse T50 ARM Thin Client to version 12.   

Support for the Dell Wyse T50 ARM Thin Client can be found at: 
https://appservices.wyse.com/pages/serviceandsupport/support/dlOraFW.asp?which=158&model=T50%2

https://appservices.wyse.com/pages/serviceandsupport/support/dlOraFW.asp?which=158&model=T50%20MR(Wyse
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0MR 

To modify the iFIX.html file: 

1. On your Proficy WebSpace Server, locate the IFIX.html file in C:\Program Files\Proficy\Proficy 
WebSpace\Web. 

2. Open the file in Notepad or another editor so you can edit the file. 

3. Set the embed variable to "false";  This runs the client in Loose mode. 

  embed = "false"; 

4. Set the zorderfocus parameter to "true".  This allows the plug-in to operate properly. 

<EMBED TYPE="application/x-proficy-plugin" alt="Proficy WebSpace 
Browser Plug-in" id="Proficy_WebSpaceControl" zorderfocus="true" /> 

5. Save the file. 

To modify the HostProperties.xml file: 

1. On your Proficy WebSpace Server, locate the HostProperties.xml file in C:\ProgramData\Proficy. 

NOTE: This directory is hidden by default and you need to use the Folders Options to make it visible. 

2. Open the file in Notepad or another editor so you can edit the file. 

3. Set the ClientProcessingBatch property to 1. 

  ClientProcessingBatch=1 

4. Enter and set the ClientProcessingTrottleV2 property to 1. 

  ClientProcessingTrottleV2=1 

NOTE: In WebSpace 4.7, the ClientProcessingThrottleV2 property was not included and the 
ClientProcessingThrottle property was set to 1. 

5. Save the file. 

To modify the Microsoft Windows registry keys: 

1. From the Windows Start icon, in the Open box, type regedit. 

2. When prompted for access to this program, click OK. 

3. Click on the subkey that holds the following registry items and change the items as follows: 

 HKEY_LOCAL_MACHINE\SOFTWARE\Proficy\ProficyWebSpace\AppServer\Displa
yBufferMinDrainRate = 500 (decimal) 

 HKEY_LOCAL_MACHINE\SOFTWARE\Proficy\ProficyWebSpace\AppServer\Displa
yBufferThreshold = 0x00010000 

 DWORD registry value set to 0 

 HKEY_LOCAL_MACHINE\SOFTWARE\Proficy\ProficyWebSpace\AppServer\Client
OffscreenSurfaces = 0x00000000 

4. Click OK to save each new setting. 

https://appservices.wyse.com/pages/serviceandsupport/support/dlOraFW.asp?which=158&model=T50%20MR(Wyse


Reference Information 

124 

To install the latest version of the Wyse Enhanced Linux Ubuntu operating system: 

1. Copy the file, wyse-ubnt-img-upgrade_1.0.0-1.037_armel.zip, from: 
 https://appservices.wyse.com/supportdownload/5series/addons/wyse-ubnt-img-upgrade_1.0.0-
1.037_armel.zip 

2. Unzip the wyse-ubnt-img-upgrade_1.0.0-1.037_armel.zip file. 

3. Copy the .deb file onto a USB flash drive. 

4. Remove the USB flash drive from that machine and insert the USB flash drive into the Dell Wyse 
T50 Thin Client USB port. 

5. Open a command prompt and enter the following: 

> cd /media 

> ls    (to see the name of your USB flash drive) 

> sudo dpkg -i /media/<name of your thumbdrive>/wyse-ubnt-img-
upgrade_1.0.0-1.037_armel.deb 

The Wyse Enhanced Linux Ubuntu operating system updates and, then, this machine reboots. This 
can take approximately 4-6 minutes. 

To remove the Chromium browser and to upgrade to Mozilla Firefox v12: 

1. Copy the file, Addons-1.028-t50.zip, from: 
https://appservices.wyse.com/supportdownload/5series/addons/Addons-1.028-t50.zip 

2. Unzip the Addons-1_028-t50.zip file. 

3. Copy the file, firefox-addon_12.0+build1-0ubuntu0.10.04.1_armel.deb, to a USB flash drive on your 
machine. 

4. Remove the USB flash drive from your machine and insert the USB flash drive into the Dell Wyse 
T50 Thin Client USB port. 

5. Open a command prompt and enter the following: 

> sudo apt-get remove chromium-browser 

> sudo dpkg -i /media/<name_of_your_USB_drive>/firefox-
addon_12.0+build1-0ubuntu0.10.04.1_armel.deb 

where <name_of_your_USB_drive> is the name of your USB flash drive. 

A pop-up message appears to inform you that the Chromium browser is installed. 

6. Click the Remove button. 

7. Log out and then log in again. 

The Mozilla Firefox v12 browser is installed and the shortcut appears on your desktop. 

https://appservices.wyse.com/supportdownload/5series/addons/wyse-ubnt-img-upgrade_1.0.0-1.037_armel.zip
https://appservices.wyse.com/supportdownload/5series/addons/wyse-ubnt-img-upgrade_1.0.0-1.037_armel.zip
https://appservices.wyse.com/supportdownload/5series/addons/wyse-ubnt-img-upgrade_1.0.0-1.037_armel.zip
https://appservices.wyse.com/supportdownload/5series/addons/wyse-ubnt-img-upgrade_1.0.0-1.037_armel.zip
https://appservices.wyse.com/supportdownload/5series/addons/Addons-1.028-t50.zip
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Keyboard Shortcuts for the Proficy WebSpace Administration 

Keyboard 
Combination 

Action/Result 

Application Tab 

Double-click 
application 

Displays Application Properties dialog box 

CTRL+A Displays Application Properties dialog box.  An installed application must be 
selected (on the Applications tab)  in order for this keyboard shortcuts to work. 

Sessions Tab 

DELETE Terminates selected session 

Processes Tab 

DELETE Terminates selected process 

General 

CTRL+TAB Cycles through tabs 

CTRL+SHIFT+TAB Reverse cycles through tabs 

CTRL+P Displays Options dialog box 

CTRL+B Turns Status Bar on or off. 

F1  Displays Help for the Proficy WebSpace Administration 

F5 Refreshes the Sessions, Processes, and Applications tabs 

ALT+F4 Exits the Proficy WebSpace Administration 
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Editing Application Startup Properties 

When you first configure the Proficy WebSpace Server, you add the applications you want to run on the 
Applications tab. If you want to edit it later, you will need to restart the Proficy WebSpace Application 
Publishing Service after you make the change. 

To edit an application's startup properties: 

1. From the Proficy WebSpace Administration, in the main window, click the Applications tab. 

2. From the list of applications, select an application from the list of applications. 

3. Click Properties. The Application Properties dialog box appears. 

4. Do any of the following: 

• In the Executable Path box, type a new path name. For example: C:\Program 
Files\Proficy\Proficy WebSpace\Programs\ProficyWeb.exe. 

• In the Start Directory box, type the full path name of the directory in which you want the 
application to start. For example: C:\Program Files\Proficy\Proficy WebSpace\Programs. 

• In the Command-Line Options box, type the startup parameters for the application. For 
example: 

Application Command-Line Options 

iFIX IFIX /s"C:\Program Files (x86)\Proficy\Proficy iFIX\LOCAL\WEB.SCU" 

CIMPLICITY CIMLAYOUT or CIMVIEW (depends on the CIMPLICITY application you want to 
configure) 

Plant 
Applications 

PLANTAPPS 

• In the Display Name box, type a new display name for the application. 

• In the Startup State section, select whether the application starts maximized, minimized, 
or in normal mode. 

• Click the Change Icon button to browse for a new application icon. 

5. Restart the Proficy WebSpace Application Publishing Service. For steps, refer to the Restarting the 
Proficy WebSpace Application Publishing Service section. 

If you want to set up applications that use ODBC data sources, you must set up the ODBC drivers as 
system DSNs (data source names) for Proficy WebSpace clients to be able to access the data sources. For 
more information about data sources, consult Microsoft's online help for the Windows ODBC Data Source 
Administrator. 
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Due to access restrictions, the Proficy WebSpace Administration cannot verify the validity of paths 
specified in UNC format (for example: \\Machine Name\Folder Name\...) or that reside on a mapped 
network drive. If the Executable Path or Start Directory of a published application or item involves a 
mapped drive or is specified with a UNC path, the Proficy WebSpace Administration will accept the 
specified path regardless of whether or not it is valid. 

If the path is invalid, or if the client user does not have rights to access the specified executable file or 
folder, the published item will not appear in the Program Window. Select the item and click the Properties 
button. Try updating the item Executable Path or its Start Directory. If the item has been uninstalled or 
moved to a new location, it will not be displayed in the Proficy WebSpace Administration once the 
Application Publishing Service has been restarted. 

The Proficy WebSpace Administration is unable to establish group and user settings for any item's path 
specified in UNC format or that resides on a mapped drive. The following message is displayed in the 
Proficy WebSpace Administration's Application Users/Groups window for any application or file where this 
applies: "User/Group settings not available."
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A 

ActiveX 

A set of technologies and tools developed by Microsoft® Corporation that enable software components to 
interact with one another in a networked environment, regardless of the language in which the 
components were created. 

B 

Bandwidth 

A measure of the volume of information that can be transmitted over a communications link. Technically, 
bandwidth refers to the width of the frequency spectrum available on a certain technology. 

Batch file 

An ASCII text file containing a sequence of operating-system commands, possibly including parameters 
and operators supported by the batch command language. When the user types a batch filename at the 
command prompt, the commands are processed sequentially. Also called batch program. 

Binary file 

A file consisting of a sequence of 8-bit data or executable code, as distinguished from files consisting of 
human-readable ASCII text. Binary files are usually in a form readable only by a program, often 
compressed or structured in a way that is easy for a particular program to read. 

Bridge 

A device that connects networks using the same communications protocols so that information can be 
passed from one to the other. A device that connects two local area networks, whether or not they use the 
same protocols 

C 

Client/Server Model 

A model of computing whereby client applications running on desktops or personal computers access 
information on remote servers or host computers. 
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D-E 

Dependent Application Server 

A dependent application server is a Proficy WebSpace Server that is connected to a Relay Server, and shares 
the Proficy WebSpace sessions as directed by the Relay Server. A dependent application server also has the 
Proficy WebSpace Server installed, along with IIS or Apache HTTP Server. However, unlike the Relay Server, 
only a few configuration items are entered in the Proficy WebSpace Administration application on each 
dependent application server. These items include the Relay Server name, the Maximum Number of Sessions 
setting, the Minimum Available Physical Memory setting, the Minimum Available Virtual Memory setting, and 
the Client Access printer driver settings. 
Each dependent application server (installed software and settings) should be a clone of the Relay Server. In 
other words, all software, pictures, and network access must be the same. 

Domain 

A group of computers and devices on a network that are administered as a unit with common rules and 
procedures. 

F 

File Allocation Table 

A list or table maintained to keep track of all the parts of a file so they can be linked together when the file 
is used again. Also referred to as the FAT file system. 

G 

Gateway 

A computer that forwards and routes data between two or more networks of any size. 

 

Group 

An account containing other accounts called members. The rights and permissions assigned to a group 
are also provided to its members. 

H 

Host 

Any computer that provides services to remote users. 
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HTTP 

The communication protocol used to connect servers on the World Wide Web. 

I 

Proficy WebSpace Server 

A computer that has the Proficy WebSpace Server software installed on it. 

Proficy WebSpace Administration 

A 32-bit Windows application that is installed on a Proficy WebSpace Server. The Proficy WebSpace 
Administration is used by Proficy WebSpace Administrators to manage Proficy WebSpace user access. 

Proficy WebSpace Application Publishing Service 

A service that receives client connection requests, authenticates users on the Proficy WebSpace Server, 
and launches the Proficy WebSpace sessions. 

J 

JavaScript 

A scripting language developed by Netscape to help Web authors create and customize applications. 
Although JavaScript is commonly confused with Java, it was developed independently. 

L 

LAN 

A group of computer systems in close proximity that can communicate with one another via some 
connecting hardware and software. 

M 

Menu Bar 

The horizontal bar below the title bar that contains the names of all the application's menus. 
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N 

Network 

A communications system that links two or more computers. 

Network Computer 

Computers or terminals with little or no memory or disk storage, network computers (NCs) are designed to 
connect to a network. NCs are more affordable than PCs and can be administered from a central network 
server. 

Network Drive 

On a local area network, a disk drive whose disk is available to other computers on the network. Access to 
a network drive might not be allowed to all users of the network; many operating systems contain security 
provisions that enable a network administrator to grant or deny access to part or all of a network drive. 

O-P 

Port 

A connection point on your computer where you can connect devices that pass data into and out of a 
computer, such as a printer. 

Q-R 

Relay Server 

The Relay Server is a Web server that provides centralized control over the Proficy WebSpace Server, 
providing the session balancing across a number of dependent application servers. The Relay Server 
maintains and distributes the client connections across each of the dependent application servers. 

Remote Access 

The hookup of a remote computing device via communication lines such as phone lines or wide area 
networks to access network applications and information. 

S 

Server 

Networked computer that provides resources or services to remote clients. 
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SMTP 

The Internet standard protocol for transferring electronic mail messages from one computer to another. 
SMTP specifies how two mail systems interface and the format of control messages they exchange to 
transfer mail. 

Status Bar 

Usually located at the bottom of a window, the status bar provides information relating to the application. 

T 

TCP/IP 

A combined set of protocols that performs the transfer of data between two computers. TCP monitors and 
ensures correct transfer of data. IP receives the data from TCP, breaks it up into packets, and ships it off to 
a network within the Internet. 

Title bar 

The horizontal bar that contains the title of the window. The title bar is located at the top of the window. 

U-V 

URL 

The name that uniquely identifies a page of a hypertext document accessible via the World Wide Web. For 
example: http://www.ge-ip.com/support 

 

User Profile 

A user profile includes all the per-user settings of the user's desktop environment, such as screen colors, 
screen savers, printer connections, window size and position, desktop arrangement, and so on. 

W-Z 

WAN 

A set of computers located in geographically diverse locations and connected for the purpose of sharing 
applications and data.

http://www.ge-ip.com/support
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Legal Notices 
Proficy* WebSpace 4.8 

Proprietary Notice 

No part of this publication may be reproduced in any form, or stored in a database or retrieval system, or transmitted or distributed in any 
form by any means, electronic, mechanical photocopying, recording or otherwise, without the prior written permission of GE Intelligent 
Platforms. Information contained herein is subject to change without notice. 

© 2015, General Electric Company. ALL RIGHTS RESERVED. 

Trademarks 

Proficy is a trademark of GE Intelligent Platforms, Inc., a wholly-owned subsidiary of General Electric Company. 

* Indicates a trademark of General Electric Company and/or its subsidiaries. 

Microsoft® is a registered trademark of Microsoft Corporation, in the United States and/or other countries. 

All other brands or names are property of their respective holders. 

Licensed Components 

Portions licensed by GraphOn Corporation. Copyright® 1999-2015 GraphOn Corporation. All rights 
reserved. 
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drives ............................................................................................. 73 
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Linux Ubuntu .......................................................................... 123 

locales ........................................................................................... 20 

log file .................................................................................... 68, 70 

log file location ......................................................................... 69 

Logon scripts ............................................................................. 48 

mapped drives ......................................................................... 19 

Microsoft's Group Policy ...................................................... 47 

minimum available physical memory ......................... 50 

minimum percentage of virtual memory 
necessary ............................................................................... 50 

Mozilla Firefox ........................................................................... 90 

connecting to Proficy WebSpace .............................. 90 
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Multiple Input Locales .......................................................... 20 

Network Printer ................................................................ 46, 81 

network user ............................................................................. 19 
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